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ГЛАВА 19 
 

 
РЕДАКТИРОВАНИЕ СТЕЖКОВ 

------------------------------------------- 

 
 

BERNINA Embroidery Software автоматически 
генерирует стежки в соответствии с контуром 
проекта и его свойствами. Это означает, что вы 
можете преобразовывать проекты BERNINA 
Embroidery Software и изменять их формы без 
изменения плотности или качества стежков. 
Но BERNINA Embroidery Software позволяет также 
редактировать индивидуальные стежки. Вам просто 
нужно выбрать стежок, как и любой другой объект, и 
переместить по своему желанию точку укола иглой. 
Например, вы можете вставлять стежки в объект, 
чтобы заполнить пробелы. Вы можете переместить или удалить индивидуальные 
стежки или группы выбранных стежков. 
В частности, это может потребоваться при работе с файлами стежков, которые не 
содержат данных о контуре проекта. Однако, если это возможно, редактируйте 
свойства объекта раньше, чем индивидуальные стежки. См. также Форматы 
проектов вышивки. 
В этом разделе объясняется, как выбирать и редактировать стежки. 

 

 

 

Выбор стежков 
 
Функция Stitch Edit (Редактирование стежков) 
позволяет выбирать отдельные стежки или 
диапазон стежков путем выбора их точек укола 
иглой или оконтуривающим прямоугольником. 
Выбранные стежки выделяются другим цветом. 
 
Выбор стежков по точке укола иглой 
 
Используйте команду Stitch Edit (меню Edit), 
чтобы выбрать индивидуальные стежки для 
редактирования. 
 
Вы можете выбрать индивидуальные стежки в 
режиме Stitch Edit (Редактирование стежка) 
путем выбора их точек укола иглой. 
 
Совет: Увеличьте масштаб изображения, чтобы 
можно было легче выбирать точки укола иглой. 

 
 
 
 
 
Как выбирать стежки по точке укола 
иглой 
1 Выберите Edit > Stitch Edit. 

Совет: Нажмите E на клавиатуре, чтобы 
перейти в режим Stitch Edit. 

2 Щелкните по точке укола иглой. 
Цвет точки укола иглой изменится, а маркер 
положения иглы переместится на выбранный 
стежок.  
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Все стежки за маркером положения иглы в 
последовательности вышивания будут 
отображены черным цветом. 
 
выбранный стежок  Удерживайте клавишу Shift,  

чтобы выбрать диапазон стежков 

 
◄ Для выбора диапазона стежков 

удерживайте нажатой клавишу Shift. 
◄ Для выбора нескольких стежков 

удерживайте нажатой клавишу Ctrl. 
 
Выбор стежков ограничивающим 
прямоугольником 
 
Используйте команду Stitch Edit (меню Edit), 
чтобы выбрать стежки ограничивающим 
прямоугольником. 
 
Вы можете быстро выбрать все стежки в группе, 
обведя вокруг него ограничивающий 
прямоугольник. 
 
Как выбирать стежки ограничивающим 
прямоугольником 
1 Выберите Edit > Stitch Edit. 

Совет: Нажмите E на клавиатуре, чтобы 
перейти в режим Stitch Edit. 

 
2 Очертите указателем мыши ограничивающий 
прямоугольник вокруг выделяемых стежков. 

 
 

 
Стежки будут выделены, как только вы 
отпустите кнопку мыши. 

               

 
ограничивающий прямоугольник  стежки выделены 

Вставка стежков 
Используйте команду Stitch Edit (меню Edit), 
чтобы вставить стежки в объект. 
 
Вы можете вставлять стежки в объект, чтобы 
заполнить пробелы. Вставленные стежки 
являются обоснованной частью объекта (в 
большей мере, чем независимые объекты). 
Однако они могут быть удалены, если 
происходит регенерация стежков. Если это 
возможно, лучше редактируйте свойства 
объекта, чем индивидуальные стежки. 
Например, чтобы увеличить плотность стежков, 
лучше уменьшить интервал между стежками. 
чем вставлять стежки. 
 
Как вставлять стежки 
1 Выберите Edit > Stitch Edit. 

Совет: Нажмите E на клавиатуре, чтобы 
перейти в режим Stitch Edit. 

 
 Увеличьте масштаб изображения той зоны, 
которую вы хотите редактировать. 
2 Выберите точку укола иглой. 
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Цвет стежка изменится, а маркер положения 
иглы переместится на выбранный стежок. 
Все стежки за маркером положения иглы в 
последовательности вышивания будут 
отображены черным цветом. 

 
3 Переместите указатель мыши в то место, 

куда вы хотите вставить стежок, и щелкните 
правой кнопкой мыши. 

             
Щелкните правой кнопкой мыши,  

        чтобы вставить новый стежок 
 
4  Переместите мышь в то место, куда вы 

хотите вставить стежок, и щелкните правой 
кнопкой мыши. 

          
Щелкните правой кнопкой мыши,  
чтобы вставить новый стежок 

 
5  Продолжайте щелкать правой кнопкой мыши 
по мере необходимости. 
 

Перемещение стежков 
 
Используйте команду Stitch Edit (меню Edit), 
чтобы выбрать индивидуальные стежки для 
перемещения. 
 
Вы можете перемещать индивидуальные стежки 
или группы стежков. 

 
Внимание: Если стежки объекта по любой 
причине регенерируются, все функции 
редактирования стежков теряются. Если это 
возможно, лучше изменять форму объекта, чем 
перемещать индивидуальные стежки. Подробнее 
см. в разделе Изменение формы и правка 
объектов. 
 
Как перемещать стежки 
1 Выберите Edit > Stitch Edit. 

Совет: Нажмите E на клавиатуре, чтобы 
перейти в режим Stitch Edit. 

 
 Увеличьте масштаб изображения той зоны, 
которую вы хотите редактировать. 
 
2 Выберите стежки и перетащите их мышью в 
новое положение. 

Новое положение будет отображено теневым 
контуром. 

 
Перетащите стежок  
в новое положение 

 
выбранные стежки 

теневой контур 
 
 
 
3 Нажмите Enter. 

Удаление стежков 
 
Используйте команду Stitch Edit (меню Edit), 
чтобы выбрать индивидуальные стежки для 
удаления. 
 
Вы можете удалять индивидуальные стежки или 
группы стежков. 
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Внимание: Если стежки объекта по любой 
причине регенерируются, все функции 
редактирования стежков теряются. Если это 
возможно, лучше редактируйте свойства 
объекта, чем индивидуальные стежки. 
Подробнее см. в разделах Регулировка шага 
гладьевого заполняющего стежка и 
Сохранение длинных стежков функцией 
Auto Jump. 
 
Как удалять стежки 
1 Выберите Edit > Stitch Edit. 

Совет: Нажмите E на клавиатуре, чтобы 
перейти в режим Stitch Edit. 

  
Увеличьте масштаб изображения той зоны, 
которую вы хотите редактировать. 
 
2 Выберите стежок или стежки 
3 Нажмите клавишу Delete. 
              

 
 

 
 
 
 
 
 
 
 
 
 
 

 
стежки выделены         стежки удалены 
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ЧАСТЬ V 
 

УКАЗАНИЯ ДЛЯ ОПЫТНЫХ 

ПОЛЬЗОВАТЕЛЕЙ 
------------------------------------------ 

 
 
Вы можете быстро дополнять проекты путем дублирования и копирования 
существующих объектов. Также имеется возможность комбинировать проекты, 
вставляя содержимое одного файла в другой. 

Специальная техника оцифровывания 
В этом разделе рассматривается возможности упрочнения контуров в технике Double 
Run и Blackwork Run. Кроме того, описывается техника вырезания отверстий и 
удаления перекрывающих стежков, а также заполнения отверстий в объектах. 
Описаны также простые и быстрые способы выметывания пуговичных петель. 
Подробнее см. в главе Специальная техника оцифровывания. 
 
Эффекты художественного вышивания 
 
В этом разделе описывается, как применять эти типы художественных стежков и 
эффекты к проектам вышивания и как настраивать эти функции для получения 
желаемых результатов. 
Подробнее см. в главе Эффекты художественного вышивания. 

Узорные штампы, оконтуривание и заполнение узорами 
В этом разделе описывается, как вставлять узоры в проект и как подгонять их 
настройки, чтобы получать наилучшие результаты. Также объясняется, как создавать 
собственные узоры и комплекты узоров. 
Подробнее см. в главе  Узорные штампы, оконтуривание и заполнение узорами. 
 

Оконтуривание и заполнение рукодельными стежками 
 
В этом разделе поясняется, как выбирать типы рукодельных стежков, а также изменять 
настройки стежков для получения наилучших результатов. 

Подробнее см. в главе Оконтуривание и заполнение рукодельными стежками. 
 
Оцифровывание для аппликаций 
 
В этом разделе рассматривается создание замкнутого объекта аппликации, а также 
частичного покрытия объектов аппликации. Рассматривается также создание объекта 
открытой аппликации. 
Подробнее см. в главе Оцифровывание для аппликаций. 
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ГЛАВА 20 
 

 
СПЕЦИАЛЬНАЯ ТЕХНИКА 

ОЦИФРОВЫВАНИЯ 
------------------------------------------- 

 
 
BERNINA Embroidery Software предлагает специальные 
способы оцифровывания для получения специальных 
эффектов при вышивании, а также для экономии времени 
при подготовке проектов. Существуют инструменты для 
создания вышивок, выглядящих так, как-будто они сделаны 
вручную.  При обычных методах оцифровки рисунка добиться 
такого эффекта не просто.  
Имеются инструменты для упрочнения контуров, вырезки 
отверстий в объектах, удаления подстилающих стежков, а также заполнения отверстий. Можно 
быстро прострочить контуры вокруг выбранных объектов или вокруг всего рисунка, с помощью простых, 
тройных или гладьевых линий. Имеются также специальные инструменты для простого и быстрого 
создания пуговичных петель. 
В этом разделе рассматривается создание „ручных“ вышивок и возможности упрочнения контуров 
в технике Double Run и Blackwork Run. Кроме того, описывается техника вырезания отверстий и 
удаления перекрывающих стежков, а также заполнения отверстий в объектах. Описаны также 
простые и быстрые способы выметывания пуговичных петель. 
 
Создание “ручных”вышивок 
Функция Freehand Draw Embroidery 
(создание “ручных” вышивок) работает 
аналогично тому, как работают функции 
Freehand и Polyline в программе 
CorelDRAW®. Функция Freehand Draw 
Embroidery предоставляет множество 
преимуществ. Она позволяет легко и 
быстро создавать рисунки, выглядящие так, 
как-будто они сделаны вручную, При 
обычных методах оцифровки рисунка добиться 
такого эффекта не просто.  Цель состоит в 
иммитации движений ручной вышивки на 
вышивальной машине, когда ткань 
зафиксирована в пяльцах. Для этого игла 
как-бы “рисует” на поверхности ткани.  
Другие техники позволяют вышивать поверх 
фотографических изображений или 
детально прорисовывать линии.  
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Например, можно использовать этот 
инструмент, чтобы вручную набросать 
цветной рисунок фото-вышивки. Эта 
техника требует аккуратности, особенно в 
прорисовке углов, подобно функции 
CorelDRAW® Polyline. 
 

 
В других случаях, рисунки, похожие на 
наброски карандашом или углем, могут 
быть оцифрованы очень быстро. Эту 
функцию можно использовать для создания 
эффектов типа ‘doodle’ (“каракули”) без 
подробной проработки деталей. Например, 
можно добавить к  основному рисунку 
графический фрагмент, декоративный текст 
и т.п.. 
 

 
 
Создание линий “ручных” стежков  

 
Чтобы наметить контуры 
(набросок) вышивки 
непосредственно на экране, 
используйте пункт меню Digitize > 

Freehand Draw Embroidery ->Open Object . 
Можно смотреть, как это будет выглядеть в 
стежках, непосредственно в процессе 
рисования. 

Для прорисовки на экране 
объектов вышивки с 
заполняющими “ручными” 
стежками, используйте функцию 

Use Digitize > Freehand Draw Embroidery - 
Closed Object. 
 
Функция “ручной” вышивки представлена на 
панели инструментов оцифровки (Digitize 
toolbar) в двух вариантах: Freehand Open 
Object (“ручная” вышивка незамкнутых 
объектов) и Freehand Closed Object 
(“ручная” вышивка замкнутых объектов). 
Подобно другим инструментам оцифровки, 
эти функции можно использовать в 
сочетании с любыми имеющимися на 
данный момент типами стежков. С 
помощью этих функций можно рисовать 
объекты непосредственно на экране. При 
рисовании наброска вышивки, можно 
смотреть, как это будет выглядеть в 
стежках, непосредственно в процессе 
рисования. Таким образом достигается 
возможность создания художественных 
эффектов, подобных машинным вышивкам 
в режиме свободного движения или 
«рисования нитками».  Эту функцию можно 
использовать и для того, чтобы 
просмотреть, как будет выглядеть реальная 
ручная вышивки, перед тем, как начинать ее 
вышивать. В конце концов, создав рисунок 
на экране, его можно вышить и 
автоматически.  
 
Примечание. С функциями “ручной” 
вышивки Freehand Draw Embroidery можно 
работать как с помощью компьютерной 
мыши, так и компьютерного пера WACOM  
 
Как создать линии “ручных”  стежков 
• Для создания незамкнутых объектов 

используется функция Freehand Draw 
Embroidery - Open Object . Выбирается 
текущий вид набросочного стежка. 
Программа BERNINA Embroidery 
Software предлагает следующую  
последовательность действий: 
• Щелкните клавишей мыши, 

переместите пойнтер мыши, затем 
щелкните еще раз для создания 
прямых отрезков. 

• Для кривых отрезков: нажмите 
клавишу и перемещайте пойнтер 
мыши по нужной траектории. 
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Программа BERNINA Embroidery Software 
отображает стежки после каждого щелчка 
или при перетаскивании пойнтера мыши.   

 
• Для создания замкнутых объектов 

используется функция Freehand Draw 
Embroidery – Closed Object . 
• Если на панели стежков и цветов 
ниток the Stitch and Color Bar выбран 
режим Outline (набросок) Программа 
BERNINA Embroidery Software 
отображает стежки после каждого 
щелчка или при перетаскивании 
пойнтера мыши. 

 
 
 

• Если выбран режим заполнения 
стежками (Fill), после каждого 
щелчка или при перетаскивании 
пойнтера мыши отображается 
каркасный набросок.  

 
• Отпустите кнопку мыши. Последняя 
точка кривой соответствует положению 
пойнтера. Программа BERNINA 
Embroidery Software сама замыкает и 
сглаживает контур объекта и, в случае 
работы в режиме заполнения стежками, 
немедленно отображает заполняющие 
стежки. 

Сглаживание линий “ручных” 
стежков  
 

Чтобы наметить контуры 
(набросок) вышивки 
непосредственно на экране, 
используйте пункт меню Digitize > 
Freehand Draw Embroidery ->Open 
Object . Можно смотреть, как это 
будет выглядеть в стежках, 
непосредственно в процессе 
рисования.. 
 
Для прорисовки на экране 
объектов вышивки с 
заполняющими “ручными” 
стежками, используйте 
функцию Use Digitize >  

                     Freehand Draw Embroidery - 
                     Closed Object. 
 
Функции Freehand Draw Embroidery имеют 
специальный курсор. Он разработан для 
того, чтобы  контролировать зазоры и 
промежутки. Число кругов и промежутки 
между концентрическими кругами 
управляется с помощью панели 
инструментов сглаживания “ручных” линий 
Freehand Embroidery Smoothing. Эту 
панель инструментов можно расположить 
на экране фиксировано, или сделать ее 
“плавующей”. 
 
Как настроить сглаживание линий 
“ручных” стежков. 
• Создайте образец “ручного” рисунка с 

использованием контурных 
(набросочных) объектов и/или  
замкнутых заполненных объектов. 
Подробнее см. раздел Создание линий 
“ручных” стежков. 

 
Можно настроить степень “сглаживания” 
линий “ручных” стежков с помощью 
регулятора Smoothing.Регулятор 
Smoothing располагается на панели 
инструментов и позволяет указать в 
процентах насколько точно сглаженная 
линия должна соответствовать оригиналу. 
Изменяя степень сглаживания вы меняете 
количество контрольных точек, которые 
программа BERNINA Embroidery Software 
использует при вычислении контура 
вышивки. 
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• Можно просматривать и перемещать 

контрольные точки, созданные 
функциями Freehand Draw Embroidery 
в режиме перерисовки Reshape. 
 

 
• Если нужно удалить часть линии, 

нажмите и удерживайте клавишу Shift, а 
пойнтер мыши, нажав левую кнопку, 
перетащите назад вдоль линии, после 
чего отпустите клавишу мыши. Если 
отпустить клавишу Shif, измененная 
часть линии соединяется с положением 
курсора мыши прямой линией.  

 

 
• Можно просто нажать клавишу 

Backspace. Последняя оцифрованна 
точка на линии будет удалена.  
 

• Для завершения работы над наброском 
на последней оцифрованной точке 
нажмите Enter. Чтобы удалить объект 
нажмите Esc.  

 
Примечание: объекты, созданные с 
помощью функции Freehand Draw 
Embroidery можно редактировать и 
перерисовывать тем же способом, что и 
объекты созданные обычным образом. 
Надо выбрать объект и нажать на кнопку 
Reshape Object на панели редактирования 
Edit.  

Упрочнение контуров 
 
Используйте инструмент Double Run (панель 
Design) для упрочнения контура. 
Используйте инструмент Blackwork Run для 
соединения выделенных контуров, чтобы 
образовать единый сгруппированный контур с 
оптимальной последовательностью вышивания. 
 
Упрочнение контуров функцией 
Double Run 
 

 Используйте инструмент Double 
Run (панель Edit) для упрочнения 
контура  
путем обшивания его в обратном 
направлении. 
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Используйте 
функцию Double 
Run (Двойной обход) 
для упрочнения 
контура. При этом 
контур обшивается в 
противоположном 
направлении. 
Обычно это 
свойство 
используется для 
утолщения строчки контура без образования 
нежелательных соединительных стежков. 
 
Как упрочнять контуры инструментом 
Double Run 
1 Выберите объекты, контуры которых требуют 
упрочнения. 
2 Щелкните по значку Double Run или нажмите  
Ctrl + В. 
 Объект будет дублирован реверсными 

стежками и помещен сверху оригинала. Цвет 
остается тем же, что и у оригинала, и 
помещен после него в последовательности 
вышивания. 

 
 Совет: Нажмите Ctrl + B, чтобы укрепить  
      объект.  
3 Проверьте, дублирован ли объект, используя 
один из следующих способов: 

◄ Проверьте количество стежков в 
статусной строке 

◄ Используйте команду Slow Redraw 
(Медленное перерисовывание). 
Подробнее см. в разделе Замедленный 
просмотр последовательности 
вышивания. 

◄ Обойдите объект по стежкам. Подробнее 
см. в разделе Просмотр 
последовательности вышивания. 
 
 

Упрочнение контуров 
инструментом Blackwork Run 
 

 Используйте инструмент Blackwork 
Run (панель Craft Stitch) для 
автоматического назначения 
последовательности выделенных  

                  объектов вышивки. 
 

Используйте инструмент Blackwork Run для 
соединения выделенных контуров, чтобы 
образовать единый сгруппированный контур с 
оптимальной последовательностью вышивания. 
Образующийся объект Blackwork Run всегда  
 

 
следует цвету первого объекта в последова-
тельности вышивания. См. также раздел 
Создание контуров стежками "назад в 
иголку" ("бэкстич")       

 

 
 
Функция Blackwork Run работает с 
вышивальными контурами, состоящими из 
одного объекта или из комбинации объектов 
типа открытого объекта, замкнутого объекта, 
окружность/овал или прямоугольник. Могут быть 
использованы все оконтуривающие стежки, 
кроме Pattern Run, Blackwork Border или 
Candlewicking Border.  

 
 
 
Примечание: Команда Ungroup 
(Разгруппировать) не действует, если выбран 
объект Blackwork Run. Если вы хотите получить 
доступ к компонентам объекта, используйте 
инструмент Break Apart. Подробнее см. в 
разделе Разбивка объектов на компоненты. 
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Как упрочнять контуры функцией Blackwork 
Run 
 
1 Выделите объекты. 

 

 
Длинные соединительные стежки  

между отдельными объектами 
 
Примечание: Эта функция применима только в 
том случае, если выбрано больше одного 
объекта подходящего типа. 
Любой объект, для которого не может быть 
установлена  
автоматическая последовательность, 
исключается из операции. 
  
2 Нажмите на значок Blackwork Run. 
3 Оцифруйте точку входа или нажмите Enter, 

чтобы принять стандартные настройки.  
Стежки будут воспроизведены. Объекты 
объединены в группу и принимают цвет 
стежка первого объекта. 

 
       

Последовательность объектов изменена,  
количество соединительных стежков уменьшилось 

 
  
Совет:  Обойдите объект автоматической 

последовательности для проверки. 
Подробнее см. в разделе Просмотр 
последовательности вышивания. 

 
4  Измените при необходимости цвет нитки 

всего объекта в последовательности. 
Подробнее см. в разделе Изменение цвета 
ниток. 

5  Измените при необходимости форму объекта 
в последовательности. 
Объекты в последовательности могут 
изменены по форме в целом. Имеется только 
одна точка входа и одна точка выхода, но все 
компоненты объектов имеют 
индивидуальные точки изменения формы. 
Подробнее см. в разделе Изменение формы 
объектов с использованием узлов 
изменения формы. 

 
Примечание: Вы можете не заметить на экране 
большого различия после применения 
Blackwork Run, если укрепленные контуры 
перекрывают друг друга. Для проверки 
оконтуривания объекта функцией Blackwork Run 
обойдите объект по стежкам. Подробнее см. в 
разделе Обход по стежкам. 
 

Вырезание отверстий и 
удаление перекрывающих 
стежков 
 
Если два объекта накладываются друг на друга, 
то два слоя стежков будут назначены одному и 
тому же участку. Функция Remove Overlay 
Stitching (Удаление перекрывающих стежков) 
позволяет сохранять формы при удалении 
одного слоя стежков. Альтернативно вы можете 
использовать объекты с заполнением или 
текстовые объекты для вырезания отверстий. 
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Вырезание отверстий в объектах 
 

Используйте инструмент Add Holes 
(панель Edit) для вырезания отверстий в 
объектах. 

 
BERNINA Embroidery Software позволяет 
вырезать отверстия в выбранных объектах 
замкнутой кривой с единообразным углом 
наклона стежков, используя инструмент Add 
Holes (Добавить отверстия).  
 
Примечание: Функция удаления 
перекрывающих стежков не предназначена для 
работы с функцией оцифровывания блока или 
инструментом Stitch Angle (Угол наклона 
стежка). Она должна использоваться с 
объектами, созданными инструментом Closed 
Object (Замкнутый объект). 
 
Как вырезать отверстия в объектах 
1 Выберите объект Замкнутый объект или 
Прямоугольник.  

 
2

 Щелкните по значку Add Holes (Добавить  
      отверстие). 
 Вокруг контура объекта появятся базисные  
     точки. 
 
 Совет: Следуйте указаниям в строке 

подсказки при оцифровывании 
дополнительных контуров.  
 

3 Оцифруйте дополнительные контуры для 
объекта.  
 Нажимайте Enter после каждого контура.  

   
 
 
 
 
 
 
 
 

 
4 Нажмите Enter. 
 

   
   
 
 Примечание: Для удаления контуров из 

замкнутого объекта щелкните по значку 
Reshape Object (Изменение формы 
объекта), чтобы отобразить контрольные 
точки объекта.  Выберите контрольные точки 
на нежелательном контуре и нажмите 
Delete. 

 
 
Удаление подстилающих стежков  

 
Используйте инструмент Remove 
Overlaps (панель Edit) для удаления  
слоев подстилающих стежков в  

                перекрывающихся объектах. 
 
Используйте инструмент Remove Overlaps для 
удаления подстилающих слоев вышивки. 
Благодаря этому сокращается количество 
стежков и предотвращается скопление ненужных 
стежков.  Вырезание перекрытий сохраняется 
между "вырезкой" объектов и "вырезанными 
объектами", чтобы избежать пробелов. Это 
можно подгонять для различных типов ткани. 
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Удаление
перекрытий

Объекты, которые можно вырезать 
В качестве вырезаемых можно использовать 
различные вышивальные объекты, если они не 
слишком малы или если шаг стежков 1,00 мм 
или меньше. В качестве примера можно назвать: 
◄ Объекты с заполнением стежками Satin, Step 

или Fancy Fill 
◄ Контуры, выполненные гладьевым валиком 
◄ Объекты автоаппликации с покрытием 

гладьевыми стежками 
◄ Текстовые объекты 
 
"Вырезаемые" объекты 
К "вырезаемым" объектам относятся: 
◄ Заполненные объекты 
◄ Объекты автоаппликации 
◄ Оконтуренные объекты 
Объекты "текст" и "пуговичная петля" не могут 
быть вырезаны операцией Remove Overlaps, но 
они могут быть использованы как вырезки.  См. 
также раздел Создание пуговичных петель. 
Подстилающие стежки, просвечивающие через 
заполнение, не удаляются. Это относится к 
заполнениям такими стежками, как Pattern Fill, 
Blackwork Fill, Candlewicking Fill, Lacework Fill, 
Gradient Fill, или стежками с шагом 1,00 мм и 
больше. А также не удаляются любые стежки, 
подстилающие узкие фрагменты объектов.  . 

 
Как удалять подстилающие стежки 
1  Выберите один или несколько "резцов". 
 
 

 
2  Щелкните по значку Remove Overlaps или 

выберите Arrange > Remove Overlaps. 
Перекрывающие стежки удаляются согласно 
текущим настройкам. Об изменении настроек 
см. раздел Настройка опций удаления 
перекрытий. 
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Выберите  
величину  
Underlap 

Примечание: Можно одновременно выбрать 
несколько резцов как часть единой операции 
вырезания. 

 
 
В показанном примере заметьте, что: 
◄ Объект "небо" разделен на две части. 
◄ Для "двери" и "дорожки" были удалены 

стежки дома и холма. 
◄ Ствол дерева и небо, подстилающее листья, 

оставлены, поскольку под объектами 
узорного заполнения (Pattern Fill) 
подстилающие стежки не вырезаются 

◄ Участок неба, перекрываемый оранжевой 
луной, остается без изменений, поскольку 
луна не была выбрана в начале операции. 

 
Заполнение отверстий в 
объектах 

 
Используйте инструмент Fill Holes 
(панель Edit) для заполнения 
отверстий в одиночных объектах. 

 
Инструмент Fill Holes заполняет отверстия в 
одиночных замкнутых объектах или 
прямоугольниках, содержащих отверстия. 
Они могут быть полностью удалены или 
заполнены новыми объектами. 

 
 
 
 
 
 
 
 

 
Как заполнять отверстия в объектах 
1  Выберите исходный объект  

 
 
 
 
 
 
 
 
 
 
 
 

2  Для использования стандартных настроек 
щелкните по значку Fill Holes. 

 
3  Для выбора перекрытия или полного 

удаления отверстий выберите Arrange > Fill 
Holes. 

 
Откроется диалоговое окно Fill Holes. 
 

 
 
 
4  Выберите, требуется ли полностью удалить 

отверстия или создать новые объекты. 
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5 Если вы выбираете создание новых 

объектов, выберите величину Underlap 
(Недокрытие). 

 
 
 
 
 
 

◄ Для точного перекрытия отверстий примите 
стандартное значение 0.00. 

◄ Для перекрытия с нахлестом отверстий и 
оригинального объекта выберите 
положительное смещение, например 1.00. 
Перекрытие с нахлестом позволяет 
избежать пробелов. 

◄ Для перекрытия с пробелом отверстий и 
оригинального объекта выберите 
отрицательное смещение, например -1,00. 

 
6  Щелкните по ОК. 
 

 
 
 
Все вновь создаваемые объекты заполняются с 
текущими настройками заполняющих стежков, 
углом наклона стежков и цвета нитки.  Каждый 
новый объект является независимым объектом и 
размещается непосредственно перед исходным 
объектом в последовательности вышивания. 
 

Создание контуров и границ 
 

Для вышивки контуров объектов  
одинарными, тройными или 
гладьевыми линиями, используется 

функция  Digitize > Outline Design. 
 
Функция Outline Design позволяет быстро  
Создавать контуры отдельных объектов или 
всего рисунка с помощью  одинарных, тройных 
или гладьевых линий. См. также раздел 
Автоматическое создание контуров и 
границ. 
 

 
Как создавать контуры и границы 
 
1 Выберите объект(ы) или весь рисунок. 

 
2 Нажмите кнопку Outline Design. 
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Откроется диалоговое окно функции Outline 
Design. 
 

 
 
3 Выберите нужные настройки: 
 
Поле Описание 

 
Offset  
Отступ 

Устанавливает отступ контура в 
мм. Значение отступа может быть 
и отрицательным. При этом контур 
Несколько перекроет объект, 
например, для создания 
художественного эффекта или в 
других целях 

Outline 
Count 
 
Число 
контуров 

Можно указать число линий 
контура – до 99 – для создания 
художественного эффекта. Общее 
число контуров (объектов) будет 
равно указанному параметру,  
умноженному на число границ, как 
внешних, так и вокруг внутренних 
“отверстий” в рисунке, если такие 
границы могут быть созданы.  

Outline 
Holes 
Контур 
отверстия 

Эта функция позволяет включать 
или исключать “отверстия” из 
обработки 
 

Outline 
Type 
Тип контура 
 

Можно выбрать тип линии контура: 
Одинарная, тройная, гладьевая. 
 

 
4 Чтобы применить выбранные настройки, 
нажмите OK. Контуры рисунка будут 
вышиты нитками текущего цвета с 
текущими настройками. Контур будет вышит 
в последнюю очередь, если для обработки 
выбран весь рисунок. В случае, если 
выбранная часть рисунка отделена от 
остальной его части “пробелом”, контур 
вышивается после выбранной части.  
 

 
 

Создание пуговичных петель 
 
Выберите команду Add Buttonhole (меню 
Arrange), чтобы добавить петлю к проекту. 
 
BERNINA Embroidery Software позволит вам 
вставлять заданные заранее пуговичные петли, 
назначать размеры петель и соединять петлю с 
проектом. Пуговичные петли выполняются 
обычно стежками гладьевого валика, 
обрамляющего прорезь, длина которой 
примерно соответствует диаметру пуговицы. 
Стежки гладьевого валика защищают прорезь от 
осыпания. Пуговичная петля состоит из двух 
гладьевых валиков с закрепками на концах. 
 
  

верхняя 
закрепка 

 
 

 
         бок петли 

   прорезь 
 
    
 
 
 

нижняя 
закрепка 
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Подстилающие 
стежки удалены 

 
Добавление пуговичных петель 
Добавьте пуговичные петли к проекту. 
 
  

 
 
Как добавлять пуговичные петли 
1 Откройте или создайте петлю, 
требуемую для вашего проекта 
 
2 Выберите команду Arrange (Расположение) > 
Add Buttonhole (Добавить петлю). 
 Текущий контур петли появляется в привязке 
с указателем мыши. 

    
3 Щелкните в том месте, куда вы хотите 
поместить петлю. 
4 Повторяйте эту операцию, если нужно 
добавить несколько петель. 
5 Нажмите Esc для завершения. 

Рекомендуется удалять зону вышивания, 
которая подстилает объект петли. Подробнее 
см. в разделе Удаление подстилающих 
стежков. 

 
 
 
 
 
 
 
 

 

Совет: Если петля помещена сверху другого 
объекта, некоторые из расположенных ниже 
стежков могут распуститься после прорезания 
петли. Чтобы предотвратить это, находящийся 
под петлей объект может быть изменен по 
форме, так что оконтуривающая линия будет 
проходить вдоль прорези петли. Подробнее см. 
в разделе Изменение формы и правка 
объектов. 
 
Создание линии петель 
С помощью команды Add Buttonholes 
(добавить петли) можно добавить к 
вашему проекту цепочку равномерно 
расположенных пуговичных петель. 

 
 
Для создания линии петель 
1 Откройте или создайте петлю, требуемую 
для вашего проекта. 
2 Выберите функцию Arrange > Add 
Buttonholes. 
Откроется диалог настройки параметров 
петель Buttonholes Settings. 
 

 
3 Введите число петель, необходимых для 
вашего проекта, и нажмите OK. 
4 Щелкните мышью в той точке проекта, где 
должна  располагаться первая петля. 
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5 Протяните линию до точки, где должна 
располагаться последняя петля. 

 
6 Используйте окно измерительного 
указателя. Для завершения работы 
щелкните клавишей мыши. 
 
Выбор типов петель 

 
Используйте функцию Object Properties 
(панель General)  
для изменения типа петли 

 
Выбирайте тип петли до или после 
оцифровывания. Если вы используете петли без 
выбора типа петли, то будет применена 
стандартная петля. 
 
Как выбрать тип петли 
1 Выберите Object Properties (Свойства 
объекта) и щелкните по закладке Buttonhole 
(Петля).  
Откроется закладка Buttonhole диалогового окна 
Object Properties. 
 
 

 
Выберите 
тип  
петли 

 
 
 
 
 
 
 
2
 Выберите тип петли 
3 Нажмите кнопку Apply. 

 
 Совет: Дважды щелкните или щелкните 

правой кнопкой мышки по объекту, чтобы 
изменить тип петли только для этого объекта. 

 
Настройка длины и плотности петли 
 

Используйте функцию Object 
Properties (панель General)  
для изменения типа петли 
 

Для изменения длины петли измените длину 
прорези. Используйте диалоговое окно Object 
Properties для ввода точной длины или 
используйте инструмент Reshape Object. 
 
Совет: Вы можете также отрегулировать длину 
петли, используйте инструмент Reshape Object 
(Изменение формы объекта). 
Увеличивайте или уменьшайте плотность 
гладьевых или краеобметочных стежков боков 
петли путем уменьшения или увеличения Bead 
Stitch Spacing (Шаг стежка бока петли). 
 
Как настроить длину и плотность петли 
1 Выберите Object Properties (Свойства 
объекта) и щелкните по закладке Buttonhole 
(Петля).  
 
 Совет: Дважды щелкните или щелкните 

правой кнопкой мышки по объекту, чтобы 
изменить характеристики стежка только для 
этого объекта. 

 

 
 
Введите характеристики  
петли 
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Повернуто 
несколько 
петель 

Петля повернута  
с изменением 
размера 

 
2 В поле Slit Length (Длина прорези)  введите 
новую длину прорези. 

     
Длина прорези:  Длина прорези:  Длина прорези: 
20 мм      15 мм    10 мм 

 
3 В поле Bead Stitch Spacing (Шаг стежка бока 
петли) введите новое значение. 

      
Шаг стежка:  Шаг стежка:  Шаг стежка:  
бока петли:  бока петли:  бока петли:  
0,3 мм    0,4 мм   1,0 мм 
  
5 Нажмите кнопку Apply. 
 
 
Настройка ориентации петли 
Вы можете поворачивать объекты петли, как и 
любые другие вышивальные объекты, путем 
манипулирования контрольными точками на 
экране или через свойства объекта. Применим 
любой из перечисленных ниже способов. 
 
 
 
◄ Инструментом Select Object для вращения 

одной или нескольких петель.  Подробнее 
см. в разделе Вращение объектов. 

 
 
 
 
 
 
◄ Инструментом Reshape Object для вращения 

одиночных петель. Подробнее см. в разделе  
Изменение формы объектов. 

 
 

 
 
◄ Инструментом Rotate 45° CCW/CW для 

вращения одной или нескольких петель.  
Подробнее см. в разделе Вращение 
объектов инструментом Rotate 
CCW/CW. 

 
◄ Инструментами Mirror Vertical и Mirror 

Horizontal. Подробнее см. в разделе  
Перевод объектов в зеркальное 
отображение. 

 
◄ Через диалоговое окно Object Properties для 

индивидуального вращения одной или 
нескольких петель. Подробнее см. в разделе 
Вращение объектов с использованием 
свойств объекта. 
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ГЛАВА 21 
 

 
ЭФФЕКТЫ ХУДОЖЕСТВЕННОГО 

ВЫШИВАНИЯ 
------------------------------------------- 

 
 

BERNINA Embroidery Software предлагает большое количество 
художественных эффектов и типов стежков для создания 
текстурированных и узорных форм заполнения объектов.  
Контурные стежки дают возможность шить в любом направлении 
с фиксированным числом линий и переменными зазорами, в 
зависимости от очертаний объекта. 
Орнаментное заполнение Fancy fill подобно заполнению 
простегивающими стежками, но при этом стежки располагаются в 
виде регулярно повторяющихся узоров.  Заполнение 
перекрестными стежками (Сross fill) напоминает  орнаментное 
заполнение,  но оно формируется иначе и использует 
простегивание под и вдоль перекрестных стежков. Используйте 
функцию Textured Edge (Текстурированный край) для получения 
шероховатых краев, создания теневых эффектов или имитации 
меха или других пушистых текстур в вашем проекте. 
Эффект волнистости (Wave Effect) позволяет направлять строчки заполняющих стежков по 
оцифрованной направляющей линии. Стежки располагаются по линии, но сохраняют 
однородную плотность и порядок проколов иглой материала. Заполнение звездочками (Star 
Fill) представляет из себя стежки, поворачиваемые в радиальном направлении, что можно 
реализовать при разных типах стежков, таких, как гладьевые стежки и стежки типа татами.  
 
Функция Gradient Fill (Заполнение с плавным тоновым переходом) изменяет плотность рядов 
строчек заполнения от весьма плотного до весьма редкого, создавая теневые эффекты, 
которые трудно было бы получить вручную. Используйте эффект Travel on Edges 
(Перемещение по краям), чтобы подстилающие стежки сместились к краям объекта и не 
были заметны через открытую часть вышивки. Эффект Color Blending (Смешивание цветов) 
создает различные теневые, перспективные и трехмерные эффекты путем смешивания двух 
цветных слоев в одном объекте вышивки. Заполнение звездочками (Star Fill) представляет из 
себя стежки, поворачиваемые в радиальном направлении, что можно реализовать при 
разных типах стежков, таких, как гладьевые стежки и стежки типа татами 
 
В этом разделе описывается, как применять эти типы художественных стежков и эффекты к 
проектам вышивания и как настраивать эти функции для получения желаемых результатов. 
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Создание контурного 
заполнения 
 

Перед тем, как начать 
оцифровку, используйте 
функцию Fill (панель стежков и 
цветов ниток), чтобы выбрать  

                       тип заполняющего стежка. 
 
Контурные стежки обеспечивают 
простегиавание вперед и назад с 
фиксированным числом линий, но с 
переменными промежутками междк ними, 
зависящими от контуров объекта.  Этот тип 
стежков можно применять только для 
блокировки оцифровываемых объектов, 
включая круглые (Circle objects). Замкнутые 
объекты, модифицированные с помощью 
инструмента добавления углов шитья 
стежков Add Stitch Angles, с контурными 
стежками использоваться не могут. См. также 
раздел Создание спиральных заполнений 

 
 
Контурные стежки можно выбрать из меню 
панели стежков и цветов ниток (Stitch and 
Color Bar), а также на закладке свойств 
объекта заполнения стежками (Fill Stitch 
object properties tab). 
 
Для создания контурного заполнения 
1 Нажмите на кнопку Fill и выберите функцию 
Contour из выпадающего меню. 

 

Подсказка: Оцифровать объект вы можете 
как до, так и после того, как выбрали способ 
заполнения. 
 
2 Создайте объект оцифровки и выберите его 
См. также Методы оцифровки. 
К объекту будут применены текущие 
установки функции контурных стежков 
Contour. 

Примечание: Угол направления стежка на 
вид образца не влияет. 
 
3 Для изменения параметров, щелкните по 
объекту дважды, либо воспользуйтесь правой 
клавишей мыши. Откроется диалог Object 
Properties > Fill Stitch. 

 
4 Настройте параметры контурных стежков 
как надо (Stitch Values): 
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Настройте длину стежка (Stitch Length), 
чтобы сделать кривые швы более или менее 
резкими. 

 
Укажите зазоры между стежками (Stitch 
Spacing), чтобы сделать кривые швы более 
или менее плотными. 
 

 
5 С помощью кнопки Apply можно 
просмотреть, как будет выглядеть вышивка, а 
с помощью клавиши OK закончить работу. 
Выбранные настройки будут применены к 
объекту. 

 

Создание заполнения 
орнаментными стежками 

 
Используйте функцию Fill (панель 
Stitch and Color) для выбора типа 
заполняющего стежка до или после  

                         оцифровки 
 
Орнаментное заполнение Fancy Fill подобно 
заполнению простегивающими стежками, но при 
этом стежки располагаются в виде регулярно 
повторяющихся узоров. Эффект Fancy Fill 
используется для художественного заполнения 
широких и крупных зон с сохранением внешнего 
вида сплошного заполнения.  

 
Вы можете выбрать узор или изменить компоновку 
как до, так и после оцифровки. См. также раздел  
Применение узоров простегивающих 
стежков. 
 
 
 
 
 
 
 
 
 
 
Примечание: Вы можете также создавать 
художественные эффекты, используя 
"рукодельные" стежки и узоры. См. разделы 
Создание заполнения рукодельными стежками 
и Создание узорного заполнения. 
 
Подсказка: Функция Carving Stamp 
позволяет выбрать степент проникновения 
иглы с помощью шаблона ‘carving stamp’. См. 
раздел Функция “резной штамп”. 
 
Как создать заполнение орнаментным стежком 
1  Щелкните по значку Fill и выберите из 

выпадающего меню Fancy.  
 

 
 
Совет: Вы можете оцифровывать форму до или 
после выбора заполнения. 
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Щелкните  
 для выбора  
 узора 

Панель 
просмотра 

 
2  Создайте и выделите замкнутый объект/ы – 

окружность или квадрат. Подробнее см. в 
разделе Методы оцифровывания. 

 
 Для выделенного объекта будут применены 
текущие настройки Fancy Fill. 
 
 
 
 
 
 
 
 
Примечание: Угол наклона стежка не влияет на 
расположение узоров. 
3  Для изменения настроек дважды щелкните 

левой кнопкой или щелкните правой кнопкой по 
объекту/ам. 
Откроется закладка Fill Stitch (Заполняющий 
стежок) диалогового окна Object Properties 
(Свойства объекта). 

 

  
4  Выберите из выпадающего списка узор. См. 

также раздел Образцы заполнения 
орнаментными стежками. 
 

 
Выбранный узор показывается в панели 
просмотра. 

 
5  Измените компоновки узора изменением 

настроек в диалоговом окне или на экране 
через кнопку Layout. 
 

По умолчанию, выбирается функция Grid. 
Техника настройки компоновки узоров та 
же, что и для орнаментного заполнения. 
Подробнее см. в разделе Компоновка 
узорного заполнения на экране. 
 
Для поворачивающихся образцов 
используйте функцию Sculpture. 

    См. также раздел Создание рельефных  
    заполнений 

 
6  Щелкните по Apply (Применить) 
 
Стежки будут регенерированы с измененными 
настройками. 
Совет: Эффект волнистости (Wave Effect) 
позволяет направлять строчки заполняющих 
стежков по оцифрованной направляющей линии. 
Эффект волнистости может быть применим к 
объектам Fancy Fill.  
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Использовано 
заполнение 

простегивающим 
стежком 

Применен 
эффект 

волнистости 

Выбрано узорное 
заполнение 

 
Однако вам потребуется вначале применить этот 
эффект к заполнению простегивающим стежком, а 
потом преобразовать в Fancy Fill. См. также 
Создание эффекта волнистости. 

 
 
Создание заполнений 
перекрестными стежками 
 

Используйте функцию Fill (панель 
Stitch and Color) для выбора типа 
заполняющего стежка до или после  

                         оцифровки 
 

Заполнение перекрестными стежками (Cross 
Stitch fill ) это особый тип заполняющих 
стежков, который не заменяет приложение  
BERNINA Cross Stitch, имеющееся на панели 
инструментов оцифровки Digitize. Эта 
функция несколько напоминает заполнение 
по образцам Pattern Fill, но она по друолму 
формируется и  использует прошивку под и 
вдоль перекрестных стежков.  Крестики могут 
быть горизонтальными, чтобы 
соответствовать стандартной полной форме 
всей вышивки. См. также раздел Создание 
узорного заполнения. 

 

 
Подсказка Можно создавать художественные 
эффекты с помощью самодельных и 
стандартных заполнений. См. разделы   
Создание заполнения рукодельными 
стежками  и Создание узорного 
заполнения. 
Как создать заполнение перекрестными 
стежками 
1 Нажмите на кнопку Fill и выберите функцию 
Cross Stitch из выпадающего меню. 
 

 
 
 
Подсказка: Оцифровать объект вы можете 
как до, так и после того, как выбрали способ 
заполнения. 
2 Создайте замкнутый объект (прямоугольник 
или круг) и выберите его. Подробнее см. 
раздел  Методы оцифровки. 
К выбранному образцу применяются текущие 
настройки функции Cross Stitch. 
 

 
Примечание: Угол направления стежка на 
вид образца не влияет. 
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3 Для изменения настроек – щелкните на 
объект дважды на объект или правой 
клавишей мышиt. 
Откроется диалог Object Properties > Fill 
Stitch. 

4 Настройте параметры как считаете нужным: 
 
Поле Описание 

 
Fabric 
Count 
 
 

Управляет расстояниями между 
крестиками по размеру куска ткани 
или по реальным размерам. 
 

Нитки Сколько раз – 2, 4 или 6 – нитка 
проходит один и тот же крест, 
чтобы сделать его более 
рельефным. 
 

Стиль 
стежка 

Полный крест (X), диагональный 
или прямой (+). 
 

Направл
ение 
 

Определяет, каким образом 
направлено верхнее перекрестье 
крестика – т.е. полный стежок – 
вперед или назад для полных 
диагональных стежков, а также для  
вертикалей и горизонталей прямых 
стежков. 
 

 

 
5 Нажмите Apply, чтобы просмотреть 
полученный эффект, или нажмите OK, чтобы 
закончить работу. 

 
Совет: Сетка перекрестных стежков не 
отображается на экране, но вы можете 
подстроить формат фоновой сетки под 
размер клеток, чтобы получить более 
наглядное представление, как используется 
сетка для создания вышивки. Используйте 
функцию Snap to Grid,  чтобы контуры 
объекта соответствовали сетке перекрестных 
стежков.  См. раздел Настройка опций 
сетки. 
 

Создание текстурированных 
краев 
 

 Используйте инструмент Textured Edge 
(панель General) для создания 
текстурированных краев или имитации 
пушистых структур.  

 
Используйте функцию 
Textured Edge 
(Текстурированный 
край) для создания 
теневых эффектов или 
для имитации меха или 
других пушистых 
структур в вашем 
проекте. 
Эффект текстурированного края применяется с 
использованием текущих настроек функции 
Textured Edge в диалоговом окне Effects 
(Эффекты). Отрегулируйте настройки для 
изменения степени шероховатости, стороны 
объекта, к которому будет применен эффект и 
предела текстурированного края. 
Изменяйте эти настройки до или после 
применения эффекта. 



Глава 21: Эффекты художественного вышивания 

BERNINA® Вышивальное ПО Версия 6 223

 
Как создать эффект текстурированного 
края 
1 Щелкните по значку Textured Edge  
      (Текстурированный край). 
 Эффект будет применен к новым или 

выбранным объектам на основе текущих 
настроек функции Textured Edge. 

 
Совет: Для изменения текущих настроек щелкните 
правой кнопкой по значку Textured Edge, чтобы 
получить доступ к диалоговому окну Effects. 
Изменяйте настройки описанным ниже способом. 
 
2  Создайте и выделите замкнутый объект/ы – 

окружность или квадрат. Подробнее см. в 
разделе  
Методы оцифровывания. 
Текущие настройки Textured Edge будут 
применены к выделенному объекту. 

 
3  Для изменения настроек щелкните правой 
кнопкой по значку Textured Edge при выделенном 
объекте. 
 
 Откроется закладка Effects > Textured Edge  
 
 
Выберите  
настройки 
 

 
Настройте  
значения 
 
 

 
4 Выберите сторону объекта, к которой вы хотите 
применить этот эффект. 

      
текстурирован   текстурированы  текстурирован  
левый край   оба края         правый край 

 
5 Используйте ползунок поля Texture для 
установки степени рыхлости.  

Перемещайте ползунок для выбора требуемой 
текстуры, влево для рыхлой текстуры, когда  
длина стежков в большей мере произвольна, и 
вправо для гладкой текстуры. 

 
больше вариаций длины  
стежков дает более 
рыхлую  текстуру 

 
 

меньше вариаций длины  
стежков дает более 

гладкую текстуру 
 

 
6 Используйте ползунок поля Span (Диапазон) 

для выбора диапазона отклонения стежков от 
контура.   
Перемещайте движок влево для уменьшения 
этого диапазона и вправо для его увеличения. 

 
 
короткий  
диапазон 
 
 
 

   длинный  
диапазон 

 
 

7 Нажмите кнопку Apply. 
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Стежки будут регенерированы с измененными 
настройками. 
Совет: Чтобы лучше рассмотреть эффект 

Textured Edge , нажмите клавишу  для 
отображения точек укола или используйте режим 
Художественный Просмотр (Artistic View). 

Создание эффекта волнистости 
 
Эффект волнистости (Wave Effect) позволяет 
направлять строчки заполняющих стежков по 
оцифрованной направляющей линии. Стежки 
следуют по линии, но сохраняют однородную 
плотность и порядок проколов иглой материала. 

                 
Эффект волнистости  Эффект волнистости  
не применен     применен 

Эффект волнистости может быть применен к 
объектам замкнутой кривой с использованием 
простегивающих, орнаментных или некоторых 
рукодельных стежков. Для применения этого 
эффекта к новым объектам замкнутой кривой 
выберите функцию Wave Effect перед 
оцифровыванием. Однако его нельзя применить к 
объектам окружности. 
 

Совет: Для получения хороших результатов 
применяйте короткие стежки, т.е. 4,00 мм или 
меньше. 
 
Как создать эффект волнистости 
1 Выберите объект замкнутой кривой и дважды 
щелкните по нему. 
 Откроется диалоговое окно Object Properties 
(Свойства объекта). 
 

 
2 Щелкните по кнопке Effects и выберите 
закладку Star & Wave Fill. 

 
                                                   Выберите Wave Effect 
 
3 Проставьте флажок в окошке Wave Effect. 
      Нажмите кнопку Apply. 

Эффект волнистости будет применен к 
выбранному объекту. 

 
 
 
 
 
  
   
 

4 Для изменения кривой выберите объект и 
затем значок Reshape Object (Изменение 
формы).  

5 Перетаскиванием кривой придайте ей 
требуемую форму и нажмите Enter. См. 
также раздел  Изменение формы  
объектов. 

      
6   Нажмите кнопку ESC для окончания.  
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Волнистый 
эффект с 

заполнением 
Blackwork Fill 

Волнистый 
эффект с 

заполнением 
Canddlewicking Fill 

 
 
Совет: Не забывайте, что эффект волнистости 
можно применять к объектам совместно с Fancy 
Fill, Pattern Fill и некоторыми из рукодельных типов 
стежков. См. также разделы Создание 
заполнения орнаментным стежком, Создание 
узорных заполнений и Создание заполнения 
рукодельными стежками. 
 
 
 
 
 
 
 

 

 
Совет: После применения волнистого 
эффекта Wave Effect не меняйте углов 
стежков , поскольку это может привести к 
смещению образцов заполнения Fancy Fill. 
 
Создание эффекта заполнения 
звездочками 
Функция Star Fill (заполнение звездочками) 
создает распределенные по радиусам 
стежки, таких типов, как гладьевые или 
татами. Стежки создаются в направлении от 
краев к центру. 
 

 

 
Функцию Star Fill (заполнение звездочками) 
можно применять к разным типам объектов – 
замкнутым, круговым и прямоугольным – с 
дополнительными отверстиями. Эффект при 
оцифровке можно включить или выключить.  
Все трансформации, исключая эффекты 
преобразования, сохраняют радиальный 
стежки функции Star Fill, но формы отверстий 
могут измениться. Операции типа 
зеркального отражения Mirror Merge или 
удаления перехлестов Remove Overlaps 
эффект Star Fill сохраняют. 
 
Советы 
Для заполнения звездочками подходят не все 
образцы, объекты (в зависимости от размера) 
и варианты стежков. В частности, если 
применять этот эффект к объектам большего 
размера, используйте один или несколько из 
предлагаемых ниже приемов, чтобы избежать 
скопления ниток в центре: 

• Увеличьте размер отверстия, сместите 
центр в пределы имеющегося 
отверстия в объекте или переместите 
его за пределы объекта. 

• Добавьте эффект Textured Edge во 
внутреннюю часть. 

• Используйте увеличенные пробелы 
между стежками – увеличьте их 
примерно на 20%. 

• Избегайте использовать образцы, 
предполагающие проникновение ткани 
иглой близко к центру объекта. 

• Используйте эффект Edge Walk с 
объектами меньшего размера, чтобы 
сократить число стежков в центре 
объекта. 

• Используйте острую иглу – то есть 
такую, у которой нет скругленного 
конца и которую обычно используют  
для шерстяных вязаных изделий. 

 
Совет: Используйте эффект Star Fill с 
кольцевыми объектами. Ширина кольца 
должна составлять примерно 20% от 
внешнего диаметра. 
 
Для создания эффекта заполнения 
звездочками 
1 Выберите нужный объект (двойной щелчок 
или с помощью правой клавиши мыши). 
Откроется диалог Object Properties > Fill 
Stitch. 
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2 Нажмите кнопку Effects и выберите 
закладку Star & Wave Fill. 

3 Поставьте галочку в окошке Star Fill и 
нажмите Apply. Эффект будет применен к 
выбранному объекту. 
 

 
4 Чтобы модифицировать эффект, выберите 
объект и нажмите кнопку Reshape Object. В 
режиме Reshape вы можете: 

• Смещать центр, к которому 
направлены радиальные стежки. 

• Указать размер центрального 
отверстия. 

• Изменить форму центрального 
отверстия для объектов 
круговой/эллиптической формы. 

 
Совет: В отличие от стежков типа Ripple, 
центр эффекта заполнения звездочками Star 
Fill можно вынести за пределы объекта или  
поместить его в имеющемся отверстии. Это 
не изменит формы объекта, но даст 
своеобразный эффект заполнения.  Когда вы 
выносите маркер центра объекта за пределы 
фигуры,  центральное отверстие не 
создается, но радиальное направление 
стежков на новое положение центра 
сохраняется. 
 
5 Нажмите Enter, чтобы применить 
настройки, и Esc, чтобы закончить работу. 
Совет: Эффект заполнения звездочками  
Star Fill можно использовать вместе с 
эффектами Satin Fill, Step Fill и Fancy Fill. См. 
раздел Создание заполнений 
орнаментными стежками. 
 

 
 
Совет: Нельзя напрямую изменять углы 
стежков, автоматически задаваемые 
функцией заполнения звездочками 
Star Fill. Тем не менее, можно применить к 
объекту функцию разделения Break Apart 
вместе с эффектом Star Fill и изменить углы 
поворота в получившемся объекте. См. также 
раздел Разбивка объектов на 
компоненты. 
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Создание заполнения с плавным 
тоновым переходом  
 
Функция Gradient Fill 
(Заполнение с 
плавным тоновым 
переходом) изменяет 
плотность рядов 
строчек заполнения от 
весьма плотного до 
весьма редкого, 
создавая теневые и 
цветовые эффекты, 
которые трудно было 
бы получить вручную. 
В вашем распоряжении 
несколько типов 
эффекта Gradient Fill.  
Если вы используете эффект Gradient Fill, текущие 
настройки интервала между строчками 
игнорируются. Однако другие эффекты вышивания 
сохраняются. 
 
Совет: Вы можете использовать функцию Gradient 
Fill with для создания интересных теневых 
эффектов.  
 
Как создавать заполнение с плавным 
тоновым переходом 
1 Выберите объект и дважды щелкните по нему. 
 Откроется закладка Fill Stitch (Заполняющий 
стежок) диалогового окна Object Properties 
(Свойства  
      объекта). 
2 Нажмите кнопку Effects (Эффекты) и 

выберите закладку > Gradient Fill 
 
 
 
Выберите 
Gradient Fill 
 
 
 
 
 
 
3 Проставьте флажок в окошке Gradient Fill и 

выберите тип (Profile).  
 

 
4 Нажмите на Apply для предварительного 

просмотра эффекта.   

 
 

 
 
5 Передвигайте ползунок, чтобы отрегулировать 
значение, или введите новую величину. 
 
 
Установите 
значение  
шага стежков 
 
 
6 Нажмите кнопку Apply для предварительного 
просмотра эффекта или на OK. 
. 

       
 макс. шаг: 1 мм    миним. шаг: 3 мм 

 
Совет: Чтобы стабилизирующие стежки не 
проступали через стежки заполнения, уберите 
флажок из окошка Underlay. См. также 
Стабилизация ткани стабилизирующими 
стежками. 
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Создание открытых заполнений 
 
Используйте эффект Travel on Edges 
(Перемещение по краям), чтобы подстилающие 
стежки сместились к краям объекта и не были 
заметны через открытую часть вышивки. Этот 
прием часто используется для фона. 

 
 
 

Совет: Используйте эту функцию совместно с 
эффектом Заполнения с плавным тоновым 
переходом или Смешивание цветов. чтобы 
избежать выполнения соединительных стежков 
внутри объекта. См. также разделы Создание 
заполнения с плавным тоновым переходом и 
Создание эффекта смешивания цветов. 
 
 
Как создать открытое заполнение 
1 Дважды щелкните левой кнопкой или один раз 

правой кнопкой по заполняемому объекту.  
Откроется закладка Fill Stitch (Заполняющий 
стежок) диалогового окна Object Properties 
(Свойства объекта). 
 

 
2  Нажмите кнопку Effects (Эффекты) и 
выберите закладку > Others 
 
 
Выберите Select  
Travel on Edges 
 
 
 
 
3 Проставьте флажок в окошке Travel on Edges 
(Перемещение по краям). 

 
Перемещения и перекрывающиеся ряды 
будут удалены.  Будут достигнуты 
стабильные зазоры между рядами. 

 
4 Нажмите кнопку Apply для предварительного 
просморта эффекта или на ОК для выхода.  

 
Эффект Travel on Edges будет применен к  
выбранному объекту.  
 

Совет: Щелкните по Save To Template 
(Сохранить в шаблоне) перед закрытием 
диалогового окна, чтобы сохранить настройки. 
Сохраненные настройки будут применены ко всем 
новым проектам, основанным на текущем 
шаблоне. Подробнее см. в разделе Свойства 
объекта и шаблоны. 

Создание эффекта смешивания 
цветов 
 

Используйте инструмент Color Blending 
(панель Edit) для создания эффектов 
тени и перспективы.  

 
Эффект Color Blending (Смешивание цветов) 
автоматически создает различные теневые, 
перспективные и трехмерные эффекты путем 
смешивания двух цветных слоев в одном объекте 
вышивки. Этот эффект создается путем 
дублирования объекта, затем применения 
функций Gradient Fill и Travel on Edges к обоим 
слоям, которые потом объединяются в группу.  
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Имеются два разных эффекта смешивания цветов: 
◄ линейный шаг стежков 
◄ криволинейный шаг стежков 
 
 
Эффект смешения цветов может быть применен к 
объектам, заполненным гладьевыми, 
простегивающими или орнаментными стежками, 
или к объектам, оконтуренным гладьевыми или 
краеобметочными стежками. 
 
Применение эффекта смешивания 
цветов 
 

Щелкните по значку Color Blending 
(панель Edit) для применения этого 
эффекта к новым или выбранным  

                объектам. 
 
Используйте функцию Color Blending для 
смешения цветов, создания эффектов 
перспективы и тени. 
 

    
миним. шаг стежка     макс. шаг стежка 
 
 
Как применять смешивание цветов 
1 Выделите заполненный объект. 
 
2 Щелкните по значку Color Blending 
(Смешивание цветов). 
 

 
Откроется диалоговое окно Color Blending.  
 

 
 
 

Выберите 
эффект  

шага стежка 
 
 

Выберите  
первый цвет 

 
 

Выберите  
второй цвет 

 
 
 

3 На панели Profiles щелкните по одному из 
значков  Spacing Effect (Эффект шага стежка). 

    
Нижний слой: Profile1   Нижний слой: Profile3 
Верхний слой: Profile1  Верхний слой: Profile3 
 
4 На панели Bottom Layer (Нижний слой) 

◄ Выберите цвет первого слоя. 
◄ Введите, если требуется, новые макс. 

значения шага стежка. 
5 На панели Top Layer (Верхний слой) 

◄ Выберите цвет второго слоя. 
◄ Введите, если требуется, новые макс. 

значения шага стежка. 
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6 Нажмите кнопку ОК. 

     
Нижний слой: красный  Нижний слой: желтый 
Верхний слой: желтый  Верхний слой: красный 

 
Совет: Чтобы стабилизирующие стежки не 
проступали через стежки заполнения, уберите 
флажок из окошка Underlay. См. также 
Cтабилизация ткани стабилизирующими 
стежками. 

 
Редактирование объектов со 
смешиванием цветов 
 

Щелкните по значку Ungroup 
(панель Arrange), чтобы 
разгруппировать выделенные 
объекты. 
Щелкните по кнопке Color Film 
(панель General), чтобы 
просмотреть все цветные блоки и  

      объекты в проекте. 
 
 
Редактирование объекта со смешиванием цветов. 
Два объекта должны быть вначале 
разгруппированы, и отдельные объекты 
редактируются в соответствии с настройками 
функции Gradient Fill. Подробнее см. в разделе 
Настройка шага стежков плавного тонового 
перехода. 
 
Примечание: Если вы редактируете 
сгруппированный объект, эффект смешивания 
цветов будет потерян, поскольку оба слоя имеют 
одни и те же настройки. 

 
Как редактировать объекты со 
смешиванием цветов 
1 Выберите объект со смешиванием цветов и 
разгруппируйте его. 
Подробнее см. в разделе Группировка и 
разгруппировка объектов. 
 

  
Совет: Используйте функцию Color Film для 
просмотра цветных блоков и объектов проекта. 
Подробнее см. в разделе Просмотр и 
выделение цветных блоков. 
 
2 Выберите один из объектов и измените цвет, 
если требуется.  
3 Дважды щелкните, чтобы открыть диалоговое 
окно Object Properties (Свойства объекта). 
 Выберите закладку Effects > Gradient Fill  
 
 

 
 
 

Выберите 
Gradient 

Fill 
 
 

Настройте 
шаг 

стежков 
 
 
4 Выберите профиль 
5  Настройте шаг стежков. Подробнее см. в 
разделе Создание эффекта смешивания 
цветов 
  
6  Нажмите кнопку Apply для предварительного 
просмотра или на ОК для выхода.  
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7  Повторите эти операции для второго объекта и 
разгруппируйте объекты. 
 

 
 

ОТКЛЮЧЕН        ВКЛЮЧЕН 
 
 

Создание эффектов плавного 
преобразования 
 

 Для создания наброска 
преобразуемого объекта и его 
стежков используется пункт меню 
General > Morphing. 

 
Функция плавного преобразования Morphing 
позволяет разнообразно и по новому 
трансформировать как форму объекта, так и 
его стежки. Эти преобразования можно 
использовать аддитивно – то есть, применять 
разные эффекты к одному объекту. 
 

 
Совет: функция Morphing это мощный 
инструмент, но не надо им злоупотреблять.  
Имейте в виду следующее: 
 

• Не применяйте слишком сильные 
преобразования. Это может сказаться 
на качестве вышивки. При работе с 
преобразованиями лучше 
использовать их в меру. 

• Используйте увеличенные зазоры 
между стежками – увеличьте их на 
примерно 20%. 

• Избегайте преобразовывать 
гладьевые стежки – они делаются 
слишком длинными на некоторых 
объектах. 

 
Увеличьте поля нижнего слоя, чтобы он 

не выступал за покрывающие стежки. 
 
Чтобы создать эффект плавного 
преобразования 
1 Выберите один или несколько объектов. 
Эффект плавного преобразования можно 
применить к любым объектам. 
 

 
 
2 Нажмите кнопку Morphing на главной 
панели инструментов General. 
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Отобразится панель Morphing Effect с 
кнопками выбора эффектов преобразования. 
 

 
 
3 Выберите желаемый эффект: 

 
Pinch  - сжимает контуры объекта 
и стежки ближе к  центру 
преобразования. Внешние стежки 
при этом расталкиваются. 
Punch - расширяет контуры 
объекта и стежки от центра 
преобразования. Контуры и стежки 
растягиваются в сторону 
воображаемой сферы  
Ripple – создает волнистые 
контуры, исходящие из центра 
преобразования как круги на воде 
от брошенного камня. 
Twirl - искривляет контуры объекта 
и стежки вокруг центра 
преобразования, создавая эффект 
вихря на поверхности воды. 
Skew Horizontal – наклоняет 
контуры объекта и стежки 
горизонтально (влево – вправо) 
 
Skew Vertical – наклоняет контуры 
объекта и стежки вертикально 
(вверх – вниз) 
 

Wave Horizontal – сдвигает 
контуры и стежки объекта по 
образцу горизонтальной волны 
 
Wave Vertical – сдвигает контуры и 
стежки объекта по образцу 
вертикальной волны. 
 

Выбранный эффект преобразования 
применяется к выбранным объектам. Центр 
преобразования по умолчанию помещается в 
центр выбранного объекта или группы 
объектов. 
 

 
Программа BERNINA Embroidery Software 
выполняет также следующие действия: 

• Группирует выбранные объекты, если 
они ранее не были сгруппированы. 

• Выполняет преобразование для всей 
группы как целого,  используя 
выбранный по умолчанию центр 
преобразований и текущие параметры. 

• Для получившихся объектов 
автоматически запускает инструмент 
редактирования Reshape Object. 

• Отображает графически управляющие 
точки для используемого 
преобразования. 

4  Нажав кнопку Undo можно отменить 
выбранное преобразование. С помощью 
управляющих точек, которые можно 
“перетаскивать” мышью, можно изменить 
форму преобразования. 
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Пока вы перемещаете контрольную точку, 
контуры изменяемого объекта отображаются 
в динамике черными линиями, пока вы не 
отпустите кнопку мыши. 
 

 
 

5 Если есть такая опция, можно переместить 
центр объекта с помощью инструмента  
Reshape Object. (Не для всех видов 
преобразований такая возможность имеется) 
На панели эффектов преобразований 
имеется кнопка Center Morphing , которая 
активируется при перемещении центра 
преобразования. Нажав эту кнопку можно 
вернуть центр преобразования в исходное 
положение. 
 

 

6 Вы можете применить к одному объекту 
несколько разных преобразований. 
 

 
 
7 Если нужно, можно отменить тот или иной 
эффект преобразования следующим 
образом: 
 

• Если к выбранному объекту применено 
одно или несколько преобразований, 
активируется кнопка Remove. Нажатие 
этой кнопки отменяет последнее 
примененное преобразование.  
Предшествующее преобразование 
(если было) после этого тоже можно 
отменить или изменить. 
 

• Нажатие кнопки Remove All отменяет 
все преобразования, примененные к 
выбранному объекту, и останавливает 
процесс редактирования 
преобразований Reshape. 



Глава 22: Узорные штампы, оконтуривание и заполнение узорами 

BERNINA® Вышивальное ПО Версия 6 234

ГЛАВА 22 
 

 
УЗОРНЫЕ ШТАМПЫ, 

ОКОНТУРИВАНИЕ И ЗАПОЛНЕНИЕ 
УЗОРАМИ 

-------------------------------------------- 

 
 
Узоры – это предварительно определенные элементы 
дизайна, такие как сердечки, листья или узоры бордюра, 
которые могут быть быстро вставлены в проект. Они 
обычно состоят из одного или нескольких простых 
объектов и сохраняются в специальном комплекте узоров. 
Вы можете создавать собственные узоры или 
использовать узоры, входящие в программное 
обеспечение. Узоры можно масштабировать, поворачивать 
и переводить в зеркальное отображение таким же 
образом, как и другие объекты. Вы можете использовать 
узоры, расположенные вдоль оцифрованной линии. Можно 
также заполнять формы рядами повторяющихся узоров и 
применять специальные эффекты. 
 
Вы можете также создавать образцы последовательностей 
хода иглы, используя в качестве шаблона “резной штамп”.   
В качестве “резного штампа”  можно использовать любой 
векторный рисунок и/или образец вышивки. 
 
В этом разделе описывается, как вставлять узоры в проект и как подгонять их настройки, чтобы 
получать наилучшие результаты. Также объясняется, как создавать собственные узоры и 
комплекты узоров, а также то, как создавать образцы стежков с резными штампами. 
. 
 
Добавление узорных штампов 
 
Выберите Pattern Stamp (меню Arrange), чтобы 
разместить простые узоры в проекте  
 
Функция Pattern Stamp позволяет размещать 
простые узоры в любом месте окна проектов. 
Вы можете получить доступ к любому узору. 
В том числе к специальным узорам для узорного 
заполнения, а также узорам из рукодельных 
стежков и из орнамента монограмм. 
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Как добавить узорный штамп 
1  Выберите Arrange > Pattern Stamp. 
 
Откроется диалоговое окно Select Pattern (Выбор 
узора). 
                              Выберите режим просмотра 
 
 
Выберите 
комплект 
узоров 
 
 
 
 
Выберите 
узор 
 
 
 
 
 
Совет: Выберите режим просмотра - вы сможете 
выбирать узоры по картинке, имени или по обоим 
признакам. 
 
2  Выберите комплект узоров из выпадающего 

списка и выберите узор из панели просмотра. 
Он станет текущим узором. См. также раздел 
Примеры узорного штампа, 
оконтуривания и заполнения. 

3  Щелкните по OK. 
Диалоговое окно закроется, узор появится в 
привязке к указателю мыши. 

4  Перемещайте указатель мыши в требуемое 
положение и щелкните для отметки 
направляющей точки. Эта точка становится 
анкером – центром вращения. Вам будет 
предложено назначить вторую направляющую 
точку. 
 

 
5  Перемещайте указатель мыши, пока узор не 

будет правильно ориентирован, и затем еще 
раз щелкните по направляющей точке.  

 
Вставка точки –    Вставка направляющей точки (для 
центра вращения   изменения размера и вращения 
 
 
Совет: Вы можете изменить размеры узора на 
экране, удерживая клавишу Shift перед тем, как 
наметить вторую направляющую точку. 
 
6  Нажмите клавишу Enter.  

Стежки будут сгенерированы. 
 
7  Повторите эту операцию, чтобы вставить  
     другой узор. 

Вы можете вращать узоры и изменять их 
размеры после вставки. 

 
 
 
 
 
 
 

Совет: Щелчок правой кнопкой мыши позволяет 
зеркально перевернуть узор.. 
 
8  Нажмите Esc для завершения. 
 
Примечание: Каждый узор обрабатывается как 
одиночный сгруппированный объект. Для правки 
отдельного фрагмента узора следует его 
разгруппировать. Подробнее см. в разделе 
Группировка и разгруппировка объектов. 
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Выберите  
Pattern Run 
 
Щелкните для  
выбора узора 

Создание цепочки узоров для 
контуров 
 
Цепочка узоров - Pattern Run – это тип стежков, 
которые создают повторяющиеся узоры вдоль 
оцифрованной линии. Вы можете создавать 
декоративные контуры, используя любой узор из 
списка. Вы можете изменять угол поворота, 
ориентацию и размеры, а также интервал между 
узорами. 

 
 
Применение цепочки узоров 

 
Используйте функцию Outline   
(панель Stitch and Color) для 
оцифровки контура 

  узорными стежками 
 
Выбирайте цепочку узоров до или после 
оцифровывания.  

 
 
 
 
 
 
 
 
 
 
 

 
Как применять цепочку узоров 
1  Щелкните на символ Outline в панели  Stitch 
and Color  и затем выберите Pattern Run из списка 
Stitch Type  
    (Тип стежка). Подробнее см. в разделе Выбор 
или изменение стежков.  

 
 
 
 
 
 
 
 
 
 
 
 
Выберите Pattern Run  

 
 

Совет: Вы можете оцифровывать форму до или 
после выбора цепочки узоров (Pattern Run). 
 
2  Последовательно оцифруйте контур цепочкой 

узоров. Подробнее см. в разделе Методы 
оцифровывания. 
  
 

 

Примечание: Контур создается с принятыми по 
умолчанию настройками стежка.  
Они могут быть изменены до или после оцифровки 
через Свойства объекта. 
 
3  Для изменения настроек дважды щелкните 

левой кнопкой или щелкните правой кнопкой по 
объекту. 
Откроется закладка Outline Stitch 
(Оконтуривающий стежок) диалогового окна 
Object Properties (Свойства объекта). 

 
 
4  Если предварительно не было выбрано, 

выберите Pattern Run из списка Stitch Type и 
щелкните по Select.  
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Выберите  
Настройки 
цепочки  
узоров 

  
Откроется диалоговое окно Select Pattern 
(Выбор узора), в котором показываются все 
имеющиеся узоры в данном комплекте. 

     Выберите режим просмотра 
 
 

Выберите 
комплект  
узоров. 

 
 

Выберите узор. 
 
 
 
 

 
Совет: Выберите режим просмотра. 
 Вы можете выбирать узоры по картинке, имени 
или по обоим признакам. 

 
5 Выберите комплект узоров из списка Pattern и 

выберите узор. Подробнее см. в разделе  
Узорные штампы, контуры и заполнения.  

6  Щелкните по кнопке OK. 

 
 
7  Выберите настройки цепочки узоров. 

Подробнее см. в разделе  
Выбор настроек цепочки узоров.  

8  Щелкните по Apply (Применить) 
Оцифрованный объект будет оконтурен 
выбранной цепочкой узоров. См. также Изменение 
формы цепочки узоров. 

 
 
 
 
 
 
 
 
 

 
Примечание: Если цепочка узоров не 
соответствует цвету, который вы выбрали в 
палитре цветов при первом оцифровывании, 
выберите контур после оцифровывания, затем 
выберите цвет. 
 
Настройка размера узоров и 
интервала между узорами 
Вы можете вставить цепочку узоров оригинального 
размера и ориентации и после этого изменить 
интервалы между узорами. Вы можете также 
установить точный размер и величину интервала 
до вставки цепочки узоров. Подробнее см. в 
разделе Применение цепочек узоров. В данном 
случае интервал – это расстояние между каждым 
повторением узора. 
 
первоначальный интервал 
 
 
 
 

 

увеличенный интервал 
 
Если цепочка узоров не точно соответствует 
базовой линии, ПО BERNINA проведет требуемые 
изменения интервала: 
◄ Если интервал, остающийся в конце базовой 

линии, меньше половины длины узора, то этот 
остаток равномерно распределяется между 
узорами.  

◄ Если интервал больше половины длины узора, 
то ПО BERNINA вставит дополнительный узор 
с небольшим взаимным перекрытием для 
равномерного распределения по базовой 
линии. 

 
Совет: Вы можете изменить форму базовой 
линии, чтобы получить требуемый вам точный 
интервал. Подробнее см. в разделе Изменение 
формы цепочки узоров. 
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Как настроить размер узоров и интервал 
между узорами 
1  Выберите цепочку узоров. 
2  Щелкните дважды по объекту. 

Откроется диалоговое окно Object Properties 
(Свойства объекта) – Outline Stitch.  

 
 
Введите 
размер  
узоров и  
интервал 
между 
 узорами 
 
 
3  В поле Size (Размер)  введите размер цепочки 
узоров. 

           
размер увеличен     стандартный размер      размер уменьшен 
 
4 Если размер задан правильно, отрегулируйте 
интервал (Spacing). 

               
увеличенный          стандартный         уменьшенный  
интервал                 интервал               интервал 

 

5 Нажмите кнопку Apply. 
Совет: Вы можете также изменить размеры 
цепочки узоров, используя маркеры 
выделения. Подробнее см. в разделе 
Изменение размеров объектов. 

 

 

Создание узорного заполнения  
Узорное заполнение Pattern Fill – это заполнение 
декоративными стежками, которое можно 
применять к объектам замкнутой кривой. Эта 
функция обеспечивает заполнение формы 
параллельными рядами узоров. Вы можете 
компоновать узоры на экране или с 
использованием настроек в диалоговом окне 
Object Properties (Свойства объекта). 
 

Примечание: Вы можете также создавать 
художественные эффекты, используя заполнение 
"рукодельными" и орнаментными стежками. См. 
разделы Создание заполнения рукодельными 
стежками и  
Создание заполнения орнаментным стежком. 
 
Добавление узорного заполнения 
 

Используйте функцию Fill (панель Stitch 
and Color) для выбора типа 
заполняющего стежка до или после  

                      оцифровки.  
 
Применяйте функцию Pattern Fill к объектам для 
создания декоративного заполнения с 
использованием текущих настроек узорного 
заполнения. Вы можете выбрать узор или 
изменить компоновку и настройки как до, так и 
после оцифровывания.  
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Выберите Pattern 
Fill 

 

 
Совет: Чтобы использовать узорное 
заполнение Pattern Fill для круговых 
объектов, надо выбрать объект, нажать 
кнопку Outline, а потом опять кнопку Fill. При 
этом становится возможным использовать 
любые стежки, так как объект преобразуется 
из категории Circle в категорию Outline Run, 
а потом в Closed Curve Fill. 
См. раздел Оцифровывание окружностей 
и овалов. 
 
 
Как добавить узорное заполнение 
 
1 Щелкните по значку Fill и выберите из 

выпадающего меню Pattern Fill. 
 

 
 
Совет: Вы можете оцифровывать форму до 
или после выбора Pattern Fill. 

2  Создайте и выделите форму. Подробнее см. в 
разделе Методы оцифровывания.  
  
  
 
 
 
 
 
 
Совет: Если узорное заполнение не 
соответствует цвету, который вы выбрали в 
палитре цветов при первом оцифровывании, 
выберите контур после оцифровывания, затем 
выберите цвет. 

3  Для изменения настроек дважды щелкните 
левой кнопкой или щелкните правой кнопкой по 
объекту/ам. 
 
 

 
Откроется закладка Fill Stitch (Заполняющий 
стежок) диалогового окна Object Properties 
(Свойства объекта).  
 

 
4  Если предварительно не было выбрано, 

выберите Pattern Fill из списка Stitch Type и 
щелкните по Select. 

Откроется диалоговое окно Select Pattern, в 
котором показываются все узоры с текущими 
настройками.  
 

Выбор режим просмотра 
 
 
Выбор комплекта узоров 
 
 
 
 
Выбор узора 
 

 
 
 
 

 
Совет: 
Выберите 
режим 

просмотра - вы сможете выбирать узоры по 
картинке, имени или по обоим признакам. 

5  Выберите комплект узоров из выпадающего 
списка и выберите узор из панели просмотра. 
См. также раздел Примеры узорного 
штампа, оконтуривания и заполнения. 
 

6  Щелкните по ОК. 

щелкните по 
Select. 
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Панель 
просмотра 

Использован Step 
Stitch 

Применен Wave 
Effect 

Выбран  
Pattern Fill 

Панель 
просмотра 

 
 Выбранный узор показывается в панели 

просмотра. 

 
7  Настройте компоновку узоров изменением 

настроек или на экране. См. раздел  
Настройка функции узорного заполнения 
или Компоновка узорного заполнения на 
экране. 
Примечание: Угол наклона стежка не влияет 
на расположение узоров. 
 

8  Щелкните по Apply (Применить) 
Оцифрованный объект будет заполнен текущим 
узорным заполнением. 
 
 
 
 
 
 
 
 
 
 
Совет: Эффект волнистости (Wave Effect) 
позволяет направлять строчки заполняющих 
стежков по оцифрованной направляющей линии. 
Эффект волнистости может быть применим к 
объектам Pattern Fill.  
 

 
Однако вам потребуется вначале применить этот 
эффект к заполнению простегивающим стежком, а 
потом преобразовать в Pattern Fill. См. также  
Создание эффекта волнистости. 

 
 
 
Настройка функции узорного 
заполнения 
 
Вы можете вставить узорное заполнение с 
оригинальным размером и ориентацией и затем 
изменить настройки. 
Вы можете также установить точный размер и 
величину интервала во время вставки узорного 
заполнения. Интервал – это расстояние между 
каждым повторением узора. См. также раздел  
Добавление узорного заполнения. 
 
Как настроить функцию узорного заполнения 
1  Дважды щелкните левой кнопкой или один раз 
правой кнопкой по объекту узорного заполнения. 

Откроется диалоговое окно Object Properties 
на закладке Fill Stitch с текущим узоров в 
панели просмотра. 

  
 
2  При необходимости выберите другой узор 

заполнения. Подробнее см. в разделе  
Добавление узорного заполнения. 
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3  При необходимости измените настройки Size X 

(Размер X), Size Y (Размер Y), Column 
Spacing (Интервал между колонками), Row 
Spacing (Интервал между рядами). 

 
 
 
 
 
 
 
 
 
 

4  При необходимо измените настройку Row 
Offset (Смещение рядов)  от -99.99 до 99.99 
мм. 

 
 
 
 
 
 
 

 
5  При необходимости измените настройку  
     Rotation Angle (Угол поворота)  от -180° до  
     +180°.. 

В этом поле устанавливается текущий угол 
поворота узорного заполнения (по умолчанию 
нуль) и назначается ориентация всего узорного 
заполнения. 

 
 

6  Щелкните по Apply (Применить) 
Оцифрованный объект будет заполнен 
выбранным узорным заполнением с 
использованием текущих настроек. 
Примечание: Если больше половины узора 
находится за пределами контура, он может 
быть подрезан вдоль контура. 

 
Компоновка узорного заполнения на 
экране 
Вы можете расположить узоры заполнения на 
экране, используя "направляющие узоры", чтобы 
масштабировать, трансформировать и смещать 
все узорное заполнение. Имеются три синих 
направляющих узоров. Другие примеры узоров 
появляются желтыми. Каждый направляющий узор 
позволяет изменять различные элементы 
компоновки. Если вы изменяете направляющий 
узор, соответственно изменяются все узоры 
заполнения. 
 
Совет: Вы можете также использовать этот метод 
для изменения заполнения черными узорами 
(Blackwork Fill), заполнения узелковыми строчками 
(Candlewicking Fill) и заполнения стежками 
кружевного переплетения (Lacework). 
Используйте верхний направляющий узор для  
изменения интервала между рядами, смещения рядя и 
масштабирования всех  узоров 
 

Используйте средний 
направляющий узор     
для изменения интервала 
между колонками и  
 масштабирования всех 
узоров      

Используйте боковой направляющий узор  
для перемещения, вращения, наклона  и 
масштабирования всех  узоров 
 
Совет: Как правило, расположение узоров 
определяется до оцифровывания объекта. Если 
важно, чтобы узоры были выровнены по контуру 
объекта, то нужно оцифровывать объект с 
использованием текущих настроек и после этого 
изменять расположение узоров. 



Глава 22: Узорные штампы, оконтуривание и заполнение узорами 

BERNINA® Вышивальное ПО Версия 6 242

 
Как компоновать узорное заполнение на 
экране 
1  Дважды щелкните по объекту с узорным 
заполнением. 
 Откроется закладка Fill Stitch (Заполняющий 

стежок) диалогового окна Object Properties 
(Свойства объекта). 

 
                                               Щелкните по кнопке Layout 
 
2  Щелкните по кнопке Layout (Размещение). 

Диалоговое окно Object Properties закроется и в 
окне проекта появится желтый узор и синие 
направляющие узоры.  Если вы изменяете 
направляющий узор, соответственно 
изменяются все узоры заполнения. 

 
 
 
Совет: Увеличьте изображение на экране, чтобы 
правильно выбрать направляющий узор. 
 
 
3  Настройте положение направляющих узоров, 
чтобы получить нужный эффект. 

◄ Перемещайте узоры путем выделения 
среднего направляющего узора и 
перетаскивания его в новое положение. 

◄ Масштабируйте узоры путем выделения 
направляющего узора и изменения его 
размеров с использованием маркеров 
выделения. 

 
пропорциональное изменение размеров 

  
  
 
 

Изменение размера по горизонтали 
 Изменение размера по вертикали 

◄ Вращайте узоры, дважды щелкнув по 
среднему направляющему узору, чтобы 
отобразить маркеры вращения. Щелкните 
по угловому маркеру и перетащите его, 
чтобы повернуть узор. 
 

 
◄ Перекашивайте узоры, дважды щелкнув 

по среднему направляющему узору, чтобы 
отобразить маркеры перекоса. 

вращение 
   

 
 
 
 
 
 
 

 

◄ Изменяйте интервал между колонками, 
выбрав боковой направляющий узор и 
перетащив его влево или вправо. 

      

 
◄ Изменяйте интервал между рядами, 

выбрав верхний направляющий узор и 
перетащив его вверх или вниз. 

◄ Изменяйте смещение рядов, выбрав 
верхний направляющий узор и перетащив 
его влево или вправо. Изменение смещения 
искажает ряды. 

 
 
 
 
 
 
4 Нажмите Enter для завершения. 

Диалоговое окно Object Properties откроется 
снова, что позволит вам применить другие 
настройки. Выбранные вами размер и 
расположение применяются к выделенному 
объекту и становятся текущими настройками 
узорного заполнения. 

анкер 
 
наклон 

Изменение  
интервала  
между  
колонками 

Изменение  
интервала  
между рядами 
 
Изменение  
смещения 
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Управление узорами 
BERNINA предоставляет различные возможности 
управления узорами, включая  составление 
комплектов узоров, сохранения узоров и удаление 
узоров. 
 
Сохранение собственных узоров 
 
Функция Create Pattern (Создание узора) 
позволяет сохранять ваши собственные узоры для 
использования в будущем. Сохраняйте их в 
собственном или существующем комплекте 
узоров. Они могут быть использованы в узорных 
заполнениях или цепочках, а также в узорных 
штампах. 
 
Как сохранить собственные узоры 
1 Выберите объект, который вы хотите 

сохранить. 
 
 
 
 
 
 
 
     Совет: Для создания объектов с отверстиями  

подробнее см. в разделе Вырезание 
отверстий и удаление  
перекрывающих стежков. 

2  Выберите Settings (Настройки) > Create Pattern 
(Создать узор). 
 Откроется диалоговое окно Create Pattern. 
 
 
 

Выберите 
комплект 
узоров 

 
Введите имя 
нового узора 

 
 
 

3  Выберите комплект узоров из списка Pattern 
Set. 

 
Примечание: Выбирайте комплект узоров 
внимательно, так чтобы вы могли вспомнить, 
где вы сохранили ваш новый узор. Подробнее 
см. в разделе Создание собственных 
комплектов узоров. 

4 Введите имя для вашего нового узора. 
5 Нажмите кнопку ОК. 

Вам будет предложено оцифровать базисные 
точки.  

 
6 Щелкните, чтобы наметить две базовые точки 
узора.  
 
 
 
 
 
 
 
 
 
 
 

◄ Базисные точки устанавливают 
стандартную ориентацию узора. 

◄ Базисные точки устанавливают также 
интервал между каждым повторением 
узора. 

  
 
 
 
 
 
 
 
7 Появится сообщение о подтверждении. 
 
8  Нажмите кнопку ОК. 
  Проверьте ваш новый узор. Подробнее см. в 

разделе Добавление узорных штампов,  
Создание узорных контуров и Создание 
узорных заполнений.  
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Создание собственных комплектов 
узоров 
 
Используйте команду Create Pattern (меню 
Settings) для создания собственного комплекта 
узоров.  
 
Функция Create Pattern (Создание узора) позволяет 
создавать собственные комплекты узоров для 
организации и классификации ваших узоров.  
 
Как создавать собственные комплекты 
узоров 
1  Выберите объект, который вы хотите сохранить 

в качестве узора. Подробнее см. в разделе  
Сохранение собственных узоров.  

 
2  Выберите Settings (Настройки) > Create Pattern  
     (Создать узор). 
 Откроется диалоговое окно Create Pattern. 
 

 
 
 
3  Щелкните по кнопке New Set (Новый  
     комплект). 
 Откроется диалоговое окно New Pattern Set 
     (Новый комплект узоров). 
 
 
Ввод имени нового  
комплекта узоров 
 
 
4 Введите имя нового комплекта узоров и 

нажмите OK. 
 Комплект узоров готов для использования. 
 
Примечание: Комплекты узоров хранятся в папке  
C:\..\Program Files\BERNINA\Embroidery Software 
6\Userletw 

 
Удаление узоров 

  
Щелкните по Object Properties (панель 
General), чтобы удалить узор. 
 

Можно удалить любой не нужный вам узор из 
комплекта узоров. Но вы можете удалять только 
собственные узоры. 
 
Как удалить узор 
1  Выберите Settings (Настройки) > Object 
Properties (Свойства объекта). 
 

2  Выберите закладку Outline (Оконтуривание), 
затем выберите Pattern Run или Pattern Fill из 
списка Stitch Type (Тип стежка). 

 
Выберите 
Pattern Run 
 
Щелкните, 
чтобы 
удалить узор 

 
 

3  Нажмите кнопку Select. 
 Откроется диалоговое окно Select Pattern 
(Выбор узора). 
 
Выберите 
комплект узоров  
 
 
 
Выберите узор 
для  
удаления 

 
 
 
 

 
 
 
 
 
 
Выберите номер 
узора 
 
 
 
Совет: Выберите режим просмотра - вы сможете 
выбирать узоры по картинке, имени или по обоим 
признакам. 
4  Выберите узор для удаления  
5 Нажмите кнопку Delete (Удалить). 
Появится сообщение о подтверждении 
 
 .6 Нажмите кнопку ОК. 
 

Щелкните по New Set 
для создания нового 
комплекта узоров 
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Функция “резной штамп” 
С помощью функции Carving Stamp (“резной 
штамп”) вы можете задать образец 
последовательности протыканий иглы, 
используя в качестве шаблона “резной 
штамп”.   В качестве “резного штампа”  можно 
использовать любой векторный рисунок и/или 
образец вышивки. Протыкание иглы 
помещается в точки, где стежок пересекается 
с векторной или вышивальной фигурой. 
 

 
С помощью функции Carving Stamp вы 
можете: 

• Использовать заготовленные, или 
выбранные, или оцифрованные 
“резные штампы” для подходящих 
объектов. 

• Перемещать/вращать/изменять 
размер и форму/удалять “резные 
штампы”, связанные с 
соответствующим объектом в режиме 
Reshape. 

• Создавать и работать с собственными 
“резными штампами”, сохраняя их в 
библиотеке образцов для 
последующего использования. 

 
Выбранные “резные штампы” можно 
использовать для оконтуривания объектов 
гладьевыми стежками, а для замкнутых 
объектов – стежками типа 
гладьевых/шаговых/орнаментных. 
 

 
Использование заготовленных 
образцов 
 

С помощью функции General > Carving 
Stamp можно задать образец 
последовательности протыканий иглы, 

используя в качестве шаблона “резной штамп”. 
 
Панель Carving Stamp содержит четыре 
закладки: Use Pattern (использовать образец), 
Use Object (использовать объект), Digitize 
(оцифровать), и Appearance (вид). Функция 
Use Pattern позволяет выбрать и 
использовать заготовленные образцы 
штампов для только для отобранных 
подходящих объектов, или для любых 
подходящих объектов, если ничего не 
отобрано. 
 
Как использовать заготовленные 
образцы 
1 Можно выбрать, а можно и не выбирать 
определенный Объект вышивки. 

 
 
Примечание: В начале работы можно 
выбрать определенный Объект вышивки, а 
можно его и не выбирать. Если будет выбран 
один или несколько объектов – штампы будут 
применяться только к выбранным объектам. 
Если  ничего не выбрано – штампы будут 
применяться к любым объектам. 
 
2 Нажмите кнопку Carving Stamp. 
Откроется диалог Carving Stamp. Закладка 
Use Pattern открывается по умолчанию. 
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3 Выберите набор образцов из списка Set  – 
например, “природа”. Выпадающий список 
Set включает как заготовленные образцы, так 
и образцы, добавленные пользователем. 
Подробнее см. раздел Наборы образцов: 
резные штампы. 
 
4 Выберите готовый образец штампа. 
На панели просмотра появится свернутое 
изображение образца и кнопка Use Stamp 
будет разблокирована. 
 
5 Нажмите кнопку Use Stamp и переведите 
курсор мыши на окно редактирования (Design 
Window). Подготовленный образец последует 
за пойнтером мыши.  
В строке текущего состояния (Status Bar) 
появится напоминание о том, чтобы задать 
анкер (точку привязки). 

 
6 Поставьте пойнтер мыши в требуемую 
позицию над объектом (объектами). 

• С помощью правой клавиши можно 
отразить штамп зеркально. 

• Нажмите клавишу Shift , чтобы не 
использовать автоматическую 
прокрутку Auto Scroll. 

 
7  Щелчком мыши зафиксируйте положение 
анкера.  Теперь можно указать управляющие 
точки. 

 
 
8   Поверните образец вокруг анкера к 
требуемой управляющей точке. Опция: можно 
удерживать клавишу Shift нажатой. 
Программа BERNINA Embroidery Software при 
этом автоматически масштабирует образец 
при перемещении пойнтера мыши. 
 
9   Нажмите кнопку мыши. 

• Если будет выбран один или несколько 
объектов – штампы будут применяться 
только к выбранным объектам, не 
зависимо от того, выходит данный 
образец за границы объекта или нет. 

Выбрать набор 
образцов 

Выбрать 
штамп 
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• Если  ничего не выбрано – штампы 

будут применяться к любым 
подлежащим объектам. 

 
Примечание:  Если в области применения 
штампа находится множество 
перекрывающихся объектов, штамп 
применяется ко всем подходящим объектам. 
 
10   Повторите эту операцию столько раз, 
сколько нужно. Для продолжения работы 
нажмите Esc. 
Примечание:  Если для работы выбран 
образец, добавленный пользователем, то 
кнопки Rename (переименовать) and Delete 
(удалить) будут разблокированы. Кнопка 
Rename открывает диалог переименования 
образца штампа Rename Stamp Pattern. В 
этом диалоге можно поменять название 
образца, добавленного пользователем. См. 
также раздел Добавление штампов в 
библиотеку. 
 

 
 
Совет:  На закладке Appearance имеются 
опции Softened Stamp (смягченный штамп) 
and Raised Stamp (рельефный штамп ), с 
помощью которых можно смягчить или 
подчеркнуть визуальный эффект. См. раздел 
Изменение вида резных штампов. 
 
Использование объектов в 
качестве резных штампов 
 
Панель Carving Stamp содержит четыре 
закладки: Use Pattern (использовать образец), 
Use Object (использовать объект), Digitize 
(оцифровать), и Appearance (вид). Функция 
Use Object позволяет выбирать контуры 
объектов из окна редактирования (Design 

Window) и либо непосредственно 
использовать их в качестве штампов, либо 
сохранять в библиотеке для последующего 
использования. 
 
Как использовать объекты в качестве 
резных штампов 
1 В начале работы можно выбрать 
определенный Объект вышивки, а можно его 
и не выбирать.  
 

 
2 Нажмите кнопку Carving Stamp и закладку 
Use Object . 

 
3 Нажмите кнопку Start Selecting (начать 
выбирать). Все объекты, которые были 
выбраны ранее, останутся выбранными. 
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4 Наведите мышь на любой объект в окне 
редактирования (Design Window). Контуры 
объекта будут выделены.  
• Выберите контуры объекта, который вы 

хотите включить в список штампов, 
любым действующим способом выбора. 
Выбранный контур отобразится на 
паненли просмотра. 

• Отменить выбор можно в любой момент 
нажатием клавиши Esc. 

 
Совет:  Выбираемые объекты могут включать 
векторные рисунки из программы Art Canvas. 
Это единственная возможность выбора 
векторных рисунков в режиме Embroidery 
Canvas. 
 
5 Нажатием кнопку Use Stamp выбранный 
объект включается в список штампов. См. 
также раздел Использование 
заготовленных образцов. 

 
6 Дополнительно можно нажать кнопку Add to 
Library и добавить выбранный образец в  
библиотеку для будущего использования. См. 
также раздел Добавление штампов в 
библиотеку. 
 
Совет:  На закладке Appearance имеются 
опции Softened Stamp (смягченный штамп) 
and Raised Stamp (рельефный штамп), с 
помощью которых можно смягчить или 
подчеркнуть визуальный эффект. См. раздел 
Изменение вида резных штамов. 

 
Оцифровка резных штампов 
 
Панель Carving Stamp содержит четыре 
закладки: Use Pattern (использовать образец), 
Use Object (использовать объект), Digitize 
(оцифровать), и Appearance (вид). Функция 
Digitize позволяет оцифровать контуры 
штампа и либо прямо использовать 
оцифрованный штамп, либо применить его к 
подходящим объектам в окне редактирования 
(Design Window). 
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Как оцифровать резной штамп 
1 В начале работы можно выбрать 
определенный Объект вышивки, а можно его 
и не выбирать. Если выбор сделан – 
оцифрованные штампы будут применены 
только к выбранным объектам. 
. 

 
2 Нажмите кнопку Carving Stamp и откройте 
закладку Digitize. 
 

 
 
3 Нажмите кнопку Start Digitizing (начать 
оцифровку). 

 
Программа напомнит, что нужно ввести 
начальную точку контура штампа. 

 
 
4 Как оцифровать контуры штампа: 

• Нажмите один раз Enter, чтобы 
завершить наметку границы. 

• Второй раз нажмите Enter, чтобы 
завершить оцифровку штампа. 

 
5 Нажмите разблокированнную кнопку Stamp. 

• Нажатие кнопки Stamp применяет 
штамп только к подходящим 
выбранным объектам. 

 

 Применение кнопки Stamp при наличии выбранных объектов
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• Если никакие объекты не были 

выбраны, кнопка Stamp применит 
штамп ко всем подходящим объектам. 
 

 
 
 

• С помощью кнопки Use Stamp 
поместите штамп в нужное место. 
Программа напомнит, что надо указать 
точку анкера. Подробнее см. раздел 
Использование заготовленных 
объектов. 

 
6 Дополнительно можно нажать кнопку Add to 
Library и добавить выбранный образец в  
библиотеку для будущего использования. См. 
также раздел Добавление штампов в 
библиотеку. 

 
Изменение вида резных штампов 
 
Панель Carving Stamp содержит четыре 
закладки: Use Pattern (использовать образец), 
Use Object (использовать объект), Digitize 
(оцифровать), и Appearance (вид). Под 
закладкой Appearance имеются чекбоксы   
Softened Stamp и Raised Stamp, а также 
кнопка Clear All Stamps. Когда выбран один 
или несколько объектов, эти функции 
разблокированы. 
 
Как изменить вид резного штампа 
1 Выберите объект вышивки, к которому 
штампы уже применены. 
 

 
2 Нажмите кнопку Carving Stamp и откройте 
закладку Appearance. 
 

 
 
3 Выберите нужный вариант изменения вида 
штампа: 

Применение кнопки Stamp при отсутствии выбранных объектов 
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• Поставив галочку в окошке Softened 

Stamp можно смягчить вид штампа 
(штампов). 
 

 
 

• Поставив галочку в окошке Raised 
Stamp можно удалить все пропуски в 
комбинации замкнутых контуров 
резного штампа.  Пересекающиеся и . 
перекрывающиеся границы 
объединяются в комбинации.. 

 

 
 
Примечание:  Кнопка Clear All Stamps 
удаляет все примененные штампы из 
выбранных объектов. 

 
Изменение формы резного штампа 
 
В режиме Reshape можно перемещать / 
вращать / изменять размер и форму / удалять 
“резные штампы”, связанные с 
соответствующим объектом . При изменении 
резного штампа, точки прокола иглой в 
подлежащем объекте автоматически 
обновляются. 
 
Как изменить форму резного штампа 

• В режиме Reshape выберите объект 
вышивки, к которому штампы уже 
применены.  
В центре каждого штампа отобразится 
ромбический управляющий элемент. 

 
 

• Щелкните мышью по ромбическому 
управляющему элементу. Отобразится 
целый набор управлющих элементов, 
позволяющих изменять размеры, 
растягивать и поворачивать фигуру. 
 

 
• Потяните мышью за ромбик, чтобы 

переместить фигуру. 
 

Щелкните мышью по 
ромбическому 
управляющему 
элементу 
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Совет:  При удержании клавиши Ctrl, 
перемещение фигуры будет происходить 
строго вертикально или строго 
горизонтально. 
 
• Для изменения размеров фигуры потяните 

за один из угловых управляющих 
элементов. 
 

 
• При нажатии и удержании клавиши 

Shift изменение размера будет 
происходить симметрично от центра. 

• При нажатии и удержании клавиши 
Ctrl изменение размера будет 
пропорционально. 

• Одновременное нажатие и удержание 
клавиш Ctrl и Shift при  перемещении 
углового управляющего элемента 
сделает изменение размеров 
пропорциональным относительно 
центра. 

 
• Потяните за один из боковых 

управляющих элементов, чтобы растянуть 
объект в нужном направлении. 

 
• Верхний и нижний элементы 

обеспечивают вертикальное 
растяжение. 

• Левый и правый элементы 
обеспечивают горизонтальное 
растяжение. 

• Если нажать и удерживать клавишу 
Shift,  растяжение будет происходить с 
сохранением позиции центра (от 
центра). 

 

 
 
• Для поворота штампа потяните за 

управляющий элемент вращения. 
 

 
 
• Нажмите на синий ромбик. Он опять 

станет зеленым и все другие 
управляющие элементы исчезнут с 
экрана.. 

• Нажмите на контур штампа, чтобы 
отобразить управляющие точки. С их 
помощью, также как и для других 
объектов, можно менять форму и удалять 
линии штампа. 

 

 
 
Примечание:  При изменении формы 
объекта вышивки, к которому применен 
резной штамп, форма штампа меняется 
соответственно.  

Потяните за боковой 
управляющий элемент 

Потяните за 
управляющий элемент 
вращения 
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Добавление штампа в библиотеку 
 
Эта процедура запускается нажатием кнопки 
Add to Library (добавить в библиотеку) под 
закладками Use Object или Digitize на 
панели Carving Stamp. 
 
Как добавить штамп в библиотеку 
1 Выберите объект, который нужно добавить 
в библиотеку в качестве заготовленного 
пользователем образца штампа. 

• Свои собственные штампы вы можете 
создавать с помощью функции Carving 
Stamp > Use Object. См. раздел 
Использование объектов в 
качестве резных штампов. 

• Оцифровать резной штамп можно с 
помощью функции Carving Stamp > 
Digitize. См. раздел Оцифровка 
резных штампов. 
 

 
2 Под любой из этих закладок нажмите кнопку 
Add to Library (добавить в библиотеку). 

 
Откроется диалог создания образца штампа 
Create Stamp Pattern. 
 

 
 
 
3  Выберите имя библиотеки из списка или с 
помощью кнопки New Set создайте новую 
библиотеку. В последнем случае используйте 
диалог создания новой библиотеки New 
Stamp Set. Имя новой библиотеки 
отобразится в списке библиотек Set под 
закладкой Use Pattern. 
 

 
4  Введите имя новой библиотеки и нажмите 
OK. Система напомнит, что надо ввести 
первую контрольную точку в окне 
редактирования (Design Window). 
 
5 Укажите первую контрольную точку: 

• При нажатии клавиши Enter 
контрольная точка создается 
автоматически. 

• Можно сделать это вручную, поместив 
пойнтер мыши в точку, где вы хотите 
поместить анкер и щелкнув левой 
клавишей мыши. 

 
 

 

Нажать для добавления 
в библиотеку

Выбрать имя 
библиотеки  
 
Ввести имя 
нового  
штампа 

Ввести имя новой 
библиотеки  

Указать первую  
контрольную точку  
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6 Укажите вторую контрольную точку: 
• При нажатии клавиши Enter 

контрольная точка создается 
автоматически. 

• Можно сделать это вручную, поместив 
пойнтер мыши в точку, где вы хотите 
поместить управляющую точку и 
щелкнув левой клавишей мыши. 

 

 
 
Программа BERNINA Embroidery Software: 

• Создает штамп 
• Запоминает управляющие точки, как 

автоматически созданные, так и 
заданные вручную  

• Замещает штампы с совпадающим 
именем на новые 

• Выводит на экран подтверждающее 
сообщение. 
 

7 Нажмите OK. 
 
Имя нового штампа появится в списке под 
закладкой Use Pattern. 
 
Примечание: Если для работы выбран 
образец, добавленный пользователем, то 
кнопки Rename (переименовать) and Delete 
(удалить) будут разблокированы. Кнопка 
Rename открывает диалог переименования 
образца штампа Rename Stamp Pattern. В 
этом диалоге можно поменять название 
образца, добавленного пользователем. См. 
также раздел Использование 
заготовленных образцов. 
 

 
 

 

Указать вторую контрольную 
точку  
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ГЛАВА 23 
 

 
ОКОНТУРИВАНИЕ И ЗАПОЛНЕНИЕ 

РУКОДЕЛЬНЫМИ СТЕЖКАМИ 
------------------------------------------- 

 
 

BERNINA предлагает ряд 
"рукодельных" стежков, которые вы 
можете использовать в своих проектах 
для имитации некоторых традиционных 
ручных вышивок. Сюда входит большой 
выбор черно-белых узоров "blackwork" и 
узелковых узоров "candlewicking", 
подходящих как для оконтуривания, так 
и для заполнения объектов. Подробнее 
см. в разделе  
Образцы узоров рукодельных 
стежков. 
Стежок "назад в иголку" (Backstitch) и 
стебельчатый стежок (Stemstich) 
являются двумя разными 
оконтуривающими стежками. Стежок "назад в иголку" образует непрерывную тонкую 
линию, подобную машинной строчке, в то время как стебельчатый стежок образует 
шнуроподобную строчку, толщину которой можно изменять в зависимости от угла наклона 
стежков. Оба стежка могут быть использованы для создания ровных рядов стежков, 
пригодных для оконтуривания и образования черно-белых узоров blackwork. 
Стежки кружевного переплетения (Lacework) и пунктирные стежки (Stipple) используются 
для декоративного заполнения. Кружевное переплетение можно использовать для 
придания таким объектам, как цветы, вид кружева. Строчки пунктирного простегивания, 
известные также, как "вермишель", образуют плавные произвольные линии, 
используемые для декоративных эффектов или для стежки квилтов. 
В этом разделе поясняется, как выбирать типы рукодельных стежков, а также изменять 
настройки стежков для получения наилучших результатов. 

 

Создание контуров 
рукодельными стежками 
 
BERNINA предоставляет ряд "рукодельных" 
стежков для оконтуривания. В их число входят 
стежки типа "blackwork", "backstitch", "stemstitch" и 
"candlewicking". См. также раздел Образцы 
узоров рукодельных стежков. 
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Выбор оконтурива-
ющих рукодельных 
стежков 

 
Совет: Вы можете также создавать декоративные 
эффекты цепочками узоров. Подробнее см. в 
разделе Создание узорных контуров. 
 
 
Создание контуров рукодельными 
стежками 
 

Щелкните по значку Outline     
(панель Stitch & Color) для 
выбора оконтуривающих  

     стежков. 
 

Используйте инструмент Blackwork 
Border (панель Craft Stitch) для 
оконтуривания в технике blackwork.  
 

Используйте инструмент Candlewicking 
Border (панель Craft Stitch) для 
оконтуривания в технике candlewick. 
 

Используйте инструмент Backstitch 
(панель Craft Stitch) для оконтуривания  
стежками "назад в иголку". 
 

Используйте инструмент Stemstitch 
(панель Craft Stitch) для оконтуривания 
стебельчатыми стежками. 

 
Различные типы стежков подходят для различных 
форм. Когда вы оцифровываете объект, 
используется текущий тип стежка для выбранного 
метода оцифровывания. Однако вы можете 
изменить тип стежка в любое время. Подробнее 
см. в разделе Настройка текущих свойств 
объекта. 
 
Как создать контур рукодельными 
стежками 
1  Выберите на панели Craft Stitch требуемый 
вам рукодельный стежок. 

 
 Альтернативно щелкните по значку Outline на 
панели Stitch and Color и выберите из 
выпадающего меню оконтуривающий 
рукодельный стежок. См. также раздел  
Выбор или изменение стежков. 
 

 

 
 
 
2  Используйте инструменты Open Object 

(Открытый объект), Closed Object (Замкнутый 
объект), Circle (Окружность) или Rectangle 
(Прямоугольник) для создания направляющей 
линии оконтуривания. Подробнее см. в разделе  
Методы оцифровывания. 

 

 
 
 Примечание: Контур создается с принятыми по 
умолчанию настройками стежка. Они могут быть 
изменены до или после оцифровки через 
Свойства объекта. 

3  Для изменения настроек дважды щелкните 
левой кнопкой или щелкните правой кнопкой по 
объекту. 

 Откроется закладка Outline Stitch 
(Оконтуривающий стежок) диалогового окна 
Object Properties (Свойства объекта). 

4  Измените при необходимости настройки: 
◄ Оконтуривание в технике Blackwork: 

Подробнее см. в разделе Создание 
контуров в технике   
    "черной  вышивки" ("блэкуорк"). 

◄ Стежок "назад в иголку": Подробнее см. в 
разделе Создание контуров стежками 
"назад в иголку"  
     ("бэкстич"). 

◄ Стебельчатый стежок: Подробнее см. в 
разделе Создание контуров 
стебельчатыми стежками. 

◄ Обрамление строчкой Candlewicking: 
Подробнее см. в разделе Создание 
контуров узелковым  
    швом. 

 
Совет: Вы можете быстро перейти от заполнения 
к оконтуриванию рукодельными стежками, 
используя кнопки на панели Craft Stitch или 
выпадающее меню Outline. См. также Создание 
заполнения рукодельными стежками. 
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В
у

 

Создание контуров обрамления 
в технике Blackwork  
 

Используйте инструмент Blackwork Border 
(панель Craft Stitch) для оцифровывания 
обрамления в технике blackwork.  

 
Техника Blackwork (дословно "черная работа") 
получила свое название от черных шелковых 
ниток, используемых в этом виде вышивания. В 
более ранних проектах преобладали угловатые 
мотивы, тогда как теперь больше используются 
диагональные стежки. 
В технике Blackwork используется лишь несколько 
простых стежков для создания комплексных 
проектов. Эта техника может быть использована 
для декорирования предметов одежды или 
украшения, например, носовых платков, скатертей 
и салфеток. 
Используйте инструменты Open Curve 
(Незамкнутая кривая), Closed Curve (Замкнутая 
кривая), Circle (Окружность) или Rectangle 
(Прямоугольник) для создания направляющей 
линии обрамления в технике Blackwork. 

 
Как создать контур в технике blackwork  
1  Выберите Blackwork Border из меню Outline 
или на панели Craft Stitch. Подробнее см. в 
разделе Создание контуров рукодельными 
стежками. 

2  Оцифруйте линию контура. Подробнее см. в 
разделе Методы     оцифровывания.  
 

 
 
 
 
 
 
  
3  Для изменения 
настроек дважды щелкните левой кнопкой или 
щелкните правой кнопкой по объекту. 
 
 

 
 Откроется закладка Outline Stitch 

(Оконтуривающий стежок) диалогового окна 
Object Properties (Свойства объекта). 

 
 

Щелкните для выбора узора 
 
4  Выберите Blackwork Border из списка Stitch 

Type. если этот стежок еще не был выбран. 
5  Щелкните по кнопке Select (Выбрать). 
 Откроется диалоговое окно Select Pattern 

(Выбор образца). 
 

       Выберите режим просмотра 
 
 
 
 
 

Выберите 
узор 

 
 
 
 
 
 
 Совет: Выберите режим просмотра - вы сможете 
выбирать узоры по картинке, имени или по обоим 
признакам. 

6  Выберите узор на панели просмотра. 
 Он станет текущим узором. См. также раздел  
Образцы узоров рукодельных стежков. 

7  Щелкните по Apply (Применить) для 
предварительного просмотра эффекта.  
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Выбранный узор будет применен к объекту. 
 

 
 
 
 
 
 
8 

 Измените, если требуется, размер узора (Size) 
и щелкните по Apply. 

уменьшение размера 
 
9  Измените, если требуется, плотность стежков 
узора и щелкните по Apply. 
◄ Для увеличения плотности стежков 

введите меньшее значение. 
◄ Для уменьшения плотности стежков 

введите большее значение. уменьшенный 
интервал 

уменьшение интервала 
 
Совет: Если к обрамлению автоматически не 
подобран нужный вам цвет, вы можете 
переназначить цвет, выбрав его по цветовой 
палитре. 

 
Создание обрамления стежками 
"назад в иголку" ("бэкстич")" 
 
 

 Используйте инструмент Backstitch 
(панель Craft Stitch) для оцифровывания 
обрамления стежками "назад в иголку". 
 

Стежок "назад в иголку" (Backstitch) является 
старым легко приспосабливаемым стежком, 
который может быть использован для изысканного 
оконтуривания. Строчка этого стежка хорошо 
вписывается в замысловатые кривые, Эти стежки 
небольшие и ровные, так что они точно 
располагаются на очертании кривой Стежок "назад 
в иголку" может быть использован для проектов 
"черной" и "красной" вышивки. Отрегулируйте 
настройки, чтобы получить желаемые точные 
результаты. Вы можете назначить точную длину 
стежка, толщину и величину перекрытия, а также 
число строчек. 

 
Как создать контур стежком "назад в иголку" 
1  Выберите Blackwork из меню Outline или на 
панели Craft Stitch. Подробнее см. в разделе  
   Создание контуров рукодельными 
стежками. 

2  Оцифруйте линию контура. Подробнее см. в 
разделе Методы оцифровывания.  

 
 
 
 
 
 
 
 
 

3 Для изменения настроек дважды 
щелкните левой кнопкой или щелкните 
правой кнопкой по объекту. 
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Откроется закладка Outline Stitch 
(Оконтуривающий стежок) диалогового окна Object 
Properties (Свойства объекта). 

 
 
 
4  Выберите Backstitch из списка Stitch Type, 
если этот стежок еще не был выбран. 
 
5  Измените, если требуется, длину стежков 
в (Stitch Length) и щелкните по Apply. 
 
 
 
 
 
 
 
 
 
 
     Длина стежка: 3.0 мм              Длина стежка: 1,5 мм  
 
 
6  Измените, если требуется, толщину строчки 

(Stitch Thickness) и щелкните по Apply. 
 

 
  
Толщина строчки: 0,15 мм   Толщина строчки: 0,25 
мм 
 
 

 
7  Измените, если требуется, величину перекрытия 

(Overlap) и щелкните по Apply. 
 
 
 
 
 
 
 
 
 
 
Перекрытие: 30 %     Перекрытие: 70 % 
 
 
8  Измените, если требуется, число строчек. 
 
 
 
 
 
 
 
 
Число строчек: 3   Число строчек: 5 
 
 
Создание контуров обрамления 
стебельчатыми стежками  
 

Используйте инструмент Stemstitch 
(панель Craft Stitch) для оцифровывания 
обрамления стебельчатыми стежками. 
 

 
Стебельчатый стежок (Stemstitch) является 
детализированным стежком, который может быть 
использован для оконтуривания или заполнения 
форм. Он используется для вышивки стеблей и 
виноградной лозы вместе с другими 
декоративными стежками или в качестве 
оконтуривающих стежков совместно с гладьевыми 
заполняющими стежками. Отрегулируйте 
настройки, чтобы получить желаемые точные 
результаты. Вы можете назначить точную длину 
стежка, толщину и величину перекрытия, а также 
число строчек. 

Настройка обрамления 
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Как создать контур обрамления 
стебельчатым стежком 

 
 
1  Выберите Stemstitch из меню Outline или на 
панели Craft Stitch. Подробнее см. в разделе  
   Создание контуров рукодельными 
стежками. 
2  Оцифруйте линию контура. Подробнее см. в 
разделе Методы оцифровывания.  

 
 
 
 
 
 
 
 
3  Для изменения настроек дважды щелкните 
левой кнопкой или щелкните правой кнопкой по 
объекту. 

 Откроется закладка Outline Stitch 
(Оконтуривающий стежок) диалогового окна 
Object Properties (Свойства объекта). 

 
 
 
4  Выберите Stemstitch из списка Stitch Type, 
если этот стежок еще не был выбран. 

 
5  Измените, еcли требуется, толщину линии (Line 

Thickness) и щелкните по Apply. 
 
 

Толщина линии: 2,0 мм  Толщина линии: 1,0 мм 
6  Измените, если требуется, шаг стежков 
(Spacing) и щелкните по Apply. 
 

Шаг:0,8 мм      Шаг:1,5 мм 
 
7  Измените, если требуется, величину угла 

(Angle) и щелкните по Apply. 
 

Угол: 90°     Угол: 45° 
 
8  Select either Single or Triple and click 
Apply. 

Тип: тройной     Тип: одинарный 
 

Настройка обрамления 
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9 Только для тройного стежка (Triple Stich)  
в поле Stitch Thickness (Толщина стежка) введите  
нужное значение. 

 

  
Тройной стежок     Тройной стежок 
Толщина: 0,25 мм           Толщина: 0,15 мм 
 

Настройка контуров 
обрамления в технике 
Candlewicking  
 

Используйте инструмент 
Candlewicking Border (панель Craft 
Stitch) для оцифровывания 
обрамления в технике candlewicking.  

 
Вышивание узелковыми строчками 
(Candlewicking) является традиционной 
техникой вышивания "белым-по-белому", 
выполняемому обычно на белой льняной или 
хлопчатобумажной ткани толстыми 
хлопчатобумажными нитками. 
Применяются в основном стежки, образующие 
узелки, - "колониальные" и "французские", а 
также стебельчатый стежок. Контур узелковой 
строчкой может быть использован для 
орнаментального обрамления. Вы можете 
назначить точные размеры каждого узора, а 
также интервала между узорами. См. также 
Создание заполнения строчками в технике 
Candlewicking. 
 
Как создать контур в технике 
candlewicking  

1  Выберите Candlewicking Border из меню 
Outline или на панели Craft Stitch. Подробнее 
см. в разделе Создание контуров 
рукодельными стежками. 
2  Оцифруйте линию контура. Подробнее см. в 
разделе Методы оцифровывания.  

 
 
 
 
 
 
 
 
 
3  Для изменения настроек дважды щелкните левой 
кнопкой или щелкните правой кнопкой по объекту. 

 Откроется закладка Outline Stitch (Оконтуривающий 
стежок) диалогового окна Object Properties 
(Свойства объекта). 

 

 
                              Выбор узора  
4  Выберите Candlewicking Border из списка Stitch 

Type. если этот стежок еще не был выбран. 
5  Щелкните по кнопке Select (Выбрать). Откроется 
диалоговое окно Select Pattern (Выбор узора).  
                           Выберите режим просмотра 

 
 

 
 

Выбор  
узора 

 
 
 

 
 Совет: Выберите режим просмотра - вы сможете 
выбирать узоры по картинке, имени или по обоим 
признакам. 

6  Выберите узор на панели просмотра. Он станет 
текущим узором. См. также раздел  
   Образцы узоров рукодельных стежков. 
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7 Щелкните по Apply (Применить) для 

предварительного просмотра 
эффекта. 

 
Выбранный узор будет применен к объекту. 
 

8  Измените, если требуется, размер (Size) и 
щелкните по Apply. 
 

 
9  Измените, если требуется, шаг узоров 

(Spacing) и щелкните по Apply. 
 

Совет: Если к обрамлению автоматически не 
подобран нужный вам цвет, вы можете 
переназначить цвет, выбрав его из цветовой 
палитры. 
 
 
Создание заполнения 
рукодельными стежками 
BERNINA предоставляет ряд "рукодельных" 
стежков для заполнения. В их число входят 
стежки типа "blackwork", "backstitch", 
"stemstitch" и "candlewicking". См. также раздел 
Образцы узоров рукодельных стежков.  

 

Совет: Вы можете также создавать декоративные 
эффекты, используя орнаментные и рукодельные 
стежки и узоры. См. разделы Создание заполнения 
орнаментным стежком и Создание узорных 
заполнений. 
 

Создание заполнения 
рукодельными стежками 

Нажмите кнопку Fill (Заполнение) на 
панели Stitch & Color (Стежок и Цвет) 
для выбора заполняющих стежков. 
 

Используйте инструмент Blackwork Fill 
(панель Craft Stitch) для заполнения в 
технике blackwork.  
 

Используйте инструмент Candlewicking 
Fill (панель Craft Stitch) для заполнения 
в технике candlewick. 
 

Используйте инструмент Lacework 
(панель Craft Stitch) для получения 
специальных кружевных эффектов. 
 

Используйте инструмент Sculpture 
(панель Craft Stitch) для получения 
поворачивающихся  “кафельных” 
образцов с заданными точками 
прокола. 
 

Используйте инструмент Ripple (панель 
Craft Stitch) для спирального 
прострачивания от центра любого 
заполненного объекта. 
 

Используйте инструмент Stipple Run 
(панель Craft Stitch) для получения 
специальных пунктирных эффектов. 

 
BERNINA предоставляет четыре вида рукодельных 
стежков заполнения -- Blackwork Fill, Candlewicking Fill, 
Lacework и Stipple. Различные типы стежков подходят 
для разных форм. Вы можете выбрать эти стежки 
заполнения с помощью панели инструментов Stitch & 
Color (Стежок и Цвет) или специально выделенной 
для них панели Craft Stitch (Рукодельный Стежок). 
Подробнее см. в разделе Образцы узоров 
рукодельных стежков. 

Уменьшение 
размера

Уменьшение 
шага узоров
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Выбор 
заполняющего 
рукодельного 
стежка 

 
Примечание: Пунктирные стежки (Stipple) 
позволяют заполнять объекты извилистыми 
линиями в пределах контура. Такое 
заполнение слегка отличается от других типов 
рукодельных стежков. 
 Подробнее см. в разделе Создание 
заполнения пунктирными стежками. 
 
 
 
Как создать заполнение рукодельными 
стежками 
 

1  Выберите на панели Craft Stitch требуемый 
вам заполняющий рукодельный стежок. 

 
 Альтернативно щелкните по значку Fill на 
панели Stitch and Color и выберите из 
выпадающего меню заполняющий 
рукодельный стежок. См. также раздел 
Выбор или изменение стежков.  

  

 
   Совет: Вы можете оцифровывать форму до 
или после выбора заполнения. 

 

2  Создайте замкнутую фигуру. Подробнее см. 
в разделе Методы оцифровывания. 

 
 
 
 Примечание: Заполнение создается с 
принятыми по умолчанию настройками 
стежка. Они могут быть изменены до или 
после оцифровки через Свойства объекта. 

 

 
3  Для изменения настроек дважды щелкните левой 
кнопкой или щелкните правой кнопкой по объекту. 

 Откроется закладка Fill Stitch (Заполняющий 
стежок) диалогового окна Object Properties 
(Свойства объекта). 

 Совет: Вы можете быстро перейти от заполнения к 
оконтуриванию рукодельными стежками, используя 
кнопки на панели Craft Stitch или выпадающее меню 
Fill. См. также  
Создание контуров рукодельными стежками. 

 

4  Измените при необходимости настройки: 
◄ Заполнение стежками в технике Blackwork: 

Подробнее см. в разделе Создание заполнений 
в технике "черной вышивки" ("блэкуорк"). 

◄ Заполнение строчками в технике Candlewicking: 
Подробнее см. в разделе Создание заполнений 
строчками в технике Candlewicking. 

◄ Кружевное переплетение (Lacework): 
Подробнее см. в разделе Создание заполнений 
стежками кружевного переплетения. 

 
Совет: Эффект волнистости (Wave Effect) позволяет 
направлять строчки заполняющих стежков по 
оцифрованной направляющей линии. Эффект 
волнистости может быть применим к некоторым 
рукодельным стежкам. Однако вам потребуется 
вначале применить этот эффект к заполнению 
простегивающим стежком, а потом преобразовать 
заполняющие стежки в рукодельные. См. также 
Создание эффекта волнистости. 

 
 

 
 
Создание заполнений в технике "черной 
вышивки" ("блэкуорк")  
 
 

Используйте инструмент Blackwork Fill 
(панель Craft Stitch) для заполнения в технике 
blackwork.  

 
 
Техника Blackwork (дословно "черная работа") 
получила свое название от черных шелковых ниток, 
используемых в этом виде вышивания. В большинстве 
случаев при таком "черно-белом" заполнении 
используются простые стежки для создания 
комплексных геометрических узоров.  

Используемый 
простегивающий 
стежок 

Применение 
эффекта 
волнистости 

Выбранный 
рукодельный 
стежок 
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При использовании различных узоров 
заполнения "блэкуорк" вы можете создавать 
светлые и темные тона участков проекта. См. 
также Создание контуров в технике 
"черной вышивки" ("блэкуорк").  

 
 
Как создать заполнение в технике blackwork  
1  Щелкните по значку Blackwork Fill или по 
значку Fill и выберите из выпадающего меню 
Blackwork Fill (Заполнение в технике 
Blackwork). Подробнее см. в разделе 
Создание заполнений рукодельными 
стежками. 

2  Создайте замкнутую фигуру. Подробнее см. 
в разделе Методы оцифровывания. 
  
  
  
 

 Примечание: Угол наклона стежка не влияет 
на расположение узоров. 

3  Для изменения настроек дважды щелкните 
левой кнопкой или щелкните правой кнопкой 
по объекту. 
 
 
 

 
 Откроется закладка Fill Stitch (Заполняющий 
стежок) диалогового окна Object Properties 
(Свойства объекта).  

 

 
4  Если предварительно не было выбрано, выберите 

Blackwork Fill из списка Stitch Type и щелкните по 
Select. 

 Откроется диалоговое окно Select Pattern (Выбор 
узора), в котором показываются все имеющиеся 
узоры.  

 
Выбор режима просмотра и образца узора 

 
Совет: Выберите режим просмотра - вы сможете 
выбирать узоры по картинке, имени или по обоим 
признакам. 
 
5  Выберите желаемый узор на панели просмотра. 
См. также раздел Образцы узоров рукодельных 
стежков. 

 
6  Щелкните по Apply (Применить) для 
предварительного просмотра эффекта. 
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 Выбранный узор будет применен к объекту. 
 

7  Измените компоновки узора изменением 
настроек в диалоговом окне или на экране 
через кнопку Layout. 

 Техника настройки компоновки узоров та же, 
что и для заполнения узорами. Подробнее 
см. в разделе Создание узорных 
заполнений. 

 
8  Щелкните по Apply (Применить) для 
предварительного просмотра эффекта или на 
ОК для завершения и выхода. 

 
Примечание: Если больше половины узора 
находится за пределами контура, он может 
быть подрезан вдоль контура. 
 
Создание заполнений строчками в 
технике candlewicking  

 
Используйте инструмент 
Candlewicking Fill (панель Craft Stitch) 
для заполнения в технике candlewick. 

 
 
Вышивание узелковыми строчками 
(Candlewicking) является традиционной 
техникой вышивания "белым-по-белому", 
выполнявшейся обычно на белой льняной или 
хлопчатобумажной ткани толстыми 
хлопчатобумажными нитками. Сегодня более 
популярно использование цветных ниток.  

 
Применяются в основном стежки, образующие узелки, 
- "колониальные" и "французские", а также 
стебельчатый стежок. Эта техника может 
использоваться для вышивания на постельных 
покрывалах, наволочках и одежде.  См. также 
Настройка контуров обрамления в технике 
Candlewicking. 

 
Как создать заполнение в технике candlewicking  
1  Щелкните по значку Candlewicking Fill или по 
значку Fill и выберите из выпадающего меню 
Candlewicking Fill (Заполнение в технике 
Candlewicking). Подробнее см. в разделе Создание 
заполнений рукодельными стежками. 

 
2  Создайте замкнутую фигуру. Подробнее см. в 
разделе Методы оцифровывания. 

 Примечание: Угол наклона стежка не влияет на 
расположение узоров. 

 

 
 
3  Для изменения настроек дважды щелкните левой 
кнопкой или щелкните правой кнопкой по объекту. 
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 Откроется закладка Fill Stitch (Заполняющий 
стежок) диалогового окна Object Properties 
(Свойства объекта). 

 

 
 
4  Если предварительно не было выбрано, 
выберите Candlewicking Fill из списка Stitch 
Type и щелкните по Select. 

 Откроется диалоговое окно Select Pattern  
     (Выбор узора), в котором показываются все  
     имеющиеся узоры.  
 
                                  Выберите режим просмотра 
 
 
 
Выберите 
узор 
 
 
 
 Совет: Выберите режим просмотра - вы 
сможете выбирать узоры по картинке, имени 
или по обоим признакам. 

5  Выберите желаемый узор на панели 
просмотра. См. также раздел Образцы 
узоров рукодельных стежков. 

 
6  Щелкните по Apply (Применить) для 
предварительного просмотра эффекта. 
 
 

 
 Выбранный узор будет применен к объекту.  
 
 
 
 
 
 
 
 
 
 
7  Для изменения компоновки узора измените 
настройки в диалоговом окне или на экране через 
кнопку Layout. 

 Техника настройки компоновки узоров та же, что и 
для заполнения узорами. Подробнее см. в разделе 
Создание узорных заполнений. 

8  Щелкните по Apply (Применить) для 
предварительного просмотра эффекта или на ОК для 
завершения и выхода. 
. 
 

Примечание: Если больше половины узора находится 
за пределами контура, он может быть подрезан 
вдоль контура. 

 
 
Создание заполнений стежками 
кружевного переплетения 

 
Используйте инструмент Lacework (панель 
Craft Stitch) для получения специальных 
кружевных эффектов. 

 
Стежки кружевного переплетения образуют похожие 
на сетку узоры, которые придают объекту вид 
кружева.  
 

Нажмите 
Select,  
чтобы 
выбрать 
узор 
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С таким заполнением вы можете подогнать 
компоновку стежков к заданным узорам. 
 

 
Как создать заполнение стежками 
кружевного переплетения 
1  Щелкните по значку Lacework или по 
значку Fill и выберите из выпадающего меню 
Lacework. Подробнее см. в разделе 
Создание заполнений рукодельными 
стежками. 

2  Создайте замкнутую фигуру. Подробнее см. 
в разделе Методы оцифровывания.  

 
 
 
 
 
 

 Примечание: Угол наклона стежка не влияет 
на расположение узоров. 

3  Для изменения настроек дважды щелкните 
левой кнопкой или щелкните правой кнопкой 
по объекту. 

 

 
 Откроется закладка Fill Stitch (Заполняющий 

стежок) диалогового окна Object Properties 
(Свойства объекта). 

 

 
 
4 Выберите Lacework из списка Stitch Type, если этот 
стежок еще не был выбран. 
3 Нажмите кнопку Select. 
 Откроется диалоговое окно Select Pattern (Выбор 
узора). 
 
                      Выберите режим просмотра 
 
 
 
 
 

Выберите  
узор 

 
 
 
 
 
Совет: Выберите режим просмотра - вы сможете 
выбирать узоры по картинке, имени или по обоим 
признакам. 
5  Выберите желаемый узор на панели просмотра. 
См. также раздел Образцы узоров рукодельных 
стежков. 

6  Щелкните по Apply (Применить) для 
предварительного просмотра эффекта 

 

Нажмите 
Select, чтобы 
выбрать узор 
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 Выбранный узор будет применен к объекту. 
 
7  Для изменения компоновки узора измените 

настройки в диалоговом окне или на экране 
через кнопку Layout. 

 Техника настройки компоновки узоров та же, 
что и для заполнения узорами. Подробнее 
см. в разделе Создание узорных 
заполнений. 

8  Щелкните по Apply (Применить) для 
предварительного просмотра эффекта или на 
ОК для завершения и выхода. 
. 

 
Примечание: Если больше половины узора 
находится за пределами контура, он может 
быть подрезан вдоль контура. 
 
 
Создание рельефных 
заполнений 
 

Используйте инструмент Sculpture 
(панель Craft Stitch) для получения 
рельефных 
поворачивающихся  образцов с 
заданными точками прокола  

 
Рельефные стежки (Sculpture stitch) 
относятся к заполнениям орнаментного 
типа Fancy Fill и используют игольные 
проколы для создания рельефных 
образцов. Разница состоит в том, что 
рельефные стежки Sculpture можно 
применять к объектам с  
поворачивающимися стежками, создавая 
эффекты вращения и трехмерности, что  
одними орнаментными заполнениями  
Fancy Fill не достигается. См. также 
раздел Создание заполнения 
орнаментными стежками. 
.

 

 
 
Совет: Если объект, над которым вы работаете, 
поворачивающихся стежков не содержит, вы 
можете добавить их с помощью инструмента 
Add Stitch Angles. См. раздел Подгонка углов 
наклона стежков. 
 
Как создать рельефное заполнение 
1 Создайте или выберите замкнутый объект с 
поворачивающимися стежками. См. раздел 
Методы оцифровывания. 

 

 
 

2 Нажмите кнопку Sculpture. См. раздел 
Создание заполнения рукодельными 
стежками. 
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Рельефный эффект применяется на 
основе имеющегося образца типа Fancy 
Fill. См. раздел Создание заполнения 
орнаментными стежками. 
 

 
 
Создание спиральных 
заполнений 
 
 Используйте инструмент Ripple (панель Craft 

Stitch) для спирального 
прострачивания от центра любого 
заполненного объекта. 
 

 
Стежки типа Ripple относятся к типу 
контурных стежков (Contour stitch), 
создавая вышивки похожего вида (с 
фиксированным числом линий и 
переменными зазорами между ними). 
В этом случае, однако, стежки расходятся 
от центра заполненного объекта по 
спирали. Этот тип стежков лучше всего 
использовать для небольших, компактных 
объектов, но можно использовать и для 
более вытянутых объектов. В последнем 
случае некоторые стежки могут выходить 
за периметр объекта, но это может дать 
интересный визуальный эффект.  

 
См. раздел Создание контурного 
заполнения. 

 

 
Спиральные стежки типа Ripple можно 
применить к любым заполненным объектам. Эта 
функция находится в списке стежков на панели 
стежков и цветов ниток Stitch and Color Bar , 
под закладкой свойств объекта функции 
заполняющих стежков (Fill Stitch object 
properties tab), а также на панели узорных 
стежков Craft Stitch. Центр заполняющих 
спиральных стежков можно перемещать с 
помощью инструмента Reshape Object. 
 
Как создавать спиральные стежки 

1 Нажмите кнопку Ripple или кнопку Fill и 
выберите позицию Ripple из выпадающего 
меню. См. раздел Создание заполнения 
рукодельными стежками. 
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2 Создайте или выберите замкнутый 
образец. Подробнее см. раздел Методы 
оцифровывания. 
 

 
Примечание: Угол поворота стежка не 
оказывает влияния на вид объекта. 
 
3 Для изменения настроек надо применить 
двойной щелчок или воспользоваться 
правой клавишей мыши. Откроется 
диалоговое окно Object Properties > Fill 
Stitch. 

 
 
4 Настройте параметры спиральных 
стежков (Stitch Values) как считаете 
нужным: 

• Укажите длину стежка (Stitch 
Length), она влияет на четкость и 
гладкость линий. 
 

 

 

 
• Укажите нужную плотность стежков 

(расстояния между строчками) с помощью 
функции Stitch Spacing. 
 

 
5 Нажмите Apply, чтобы просмотреть вид 
объекта на экране, или OK, чтобы закончить 
работу и закрыть диалог. Выбранные настройки 
будут применены к объекту. 
 
Примечание:  Если объект имеет отверстие, 
спиральные стежки игнорируют это 
обстоятельство, но другие типы стежков 
учитывают это отверстие. 

 
 
Совет: Можно добиться интересных визуальных 
эффектов, перемещая центр спиральных 
стежков Ripple за пределы контура объекта. 
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Создание заполнений пунктирными 
стежками 
 

Используйте инструмент Stipple Run 
панель Craft Stitch) для получения 
специальных пунктирных эффектов. 

 
Пунктирные стежки позволяют заполнять 
объекты извилистыми линиями в пределах 
контура. Есть три типа пунктирных 
заполнений: Stipple Run, Stipple 
Backstitch и Stipple Stemstitch. 
Пунктирные заполнения можно применять 
к тем же объектам, что и заполнения по 
образцам (Pattern Fill) – то есть, к 
замкнутым объектам с углами поворота 
стежков или без них. Их можно применять 
к буквам, авто аппликациям или к 
составным объектам. 

 
Вы можете регулировать плотность стежков и 
расстояние между строчками. 
Вы можете поменять форму и масштаб 
контуров заполняемого пунктирными 
стежками объекта при сохранении 
настроек. 
 
Как создавать пунктирное заполнение 
 
1 Нажмите кнопку Stipple Run или кнопку 
Fill и выберите позицию Stipple Run из 
выпадающего меню. См. раздел  
Создание заполнения рукодельными 
стежками. 
 

 
2 Создайте или выберите замкнутый образец. 
Подробнее см. раздел Методы 
оцифровывания. 

 
Примечание: Угол поворота стежка не 
оказывает влияния на вид объекта. 
 
3 Для изменения настроек надо применить 
двойной щелчок или воспользоваться правой 
клавишей мыши. Откроется диалоговое окно 
Object Properties > Fill Stitch 

 
4 Настройте параметры пунктирных стежков 
(Stitch Values) как считаете нужным: 

• Укажите длину стежка (Stitch Length), она 
влияет на четкость и гладкость линий. 

 

 
Длина стежка: 1,0 мм   Длина стежка: 2,0 мм 
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• Функция Run Count определяет 
число повторов стежков – то есть,. 
1, 3, 5, 7, 9 – и тем самым 
массивность стежков. 

5 Укажите желательные параметры 
пунктирных стежков (Stipple Values): 

• Задайте интервал между петлями 
(Loop Spacing) . Он определяет 
плотность стежков. 
 

 

 
 

 
• Параметр Inset Step задает 

интервал между контуром объекта 
и заполнением спиральными 
стежками. Большему значению 
соответствует больший зазор. 
Заметим, что заполнение 
пунктирными стежками за пределы 
контуров объекта выходить не 
может. 

6 Выберите тип стежка (Stitch Type).  
Стежки типа Stemstitch и Stipple 
Backstitch работают также, как и стежки 
типа Stipple Run,  но при этом имеют 
более выраженный орнаментный 
характер. 
 

 

• Параметры стежков типа Stipple 
Stemstitch настраиваются через 
функцию свойств объекта Object 
Properties. См. раздел Создание 
контуров обрамления 
стебельчатыми стежками 
 

  
 
• Параметры стежков типа Stipple 

Backstitch настраиваются через 
функцию свойств объекта Object 
Properties. См. раздел Создание 
обрамления стежками "назад в 
иголку". 
 

 
 
7 Нажмите Apply, чтобы просмотреть вид 
объекта на экране, или OK, чтобы закончить 
работу и закрыть диалог. 
После создания заполнения пунктирными 
стежками, можно в любое время поменять 
свойства объекта (object properties). Можно 
поменять размеры и форму заполненного 
пунктирными стежками объекта при сохранении 
настроек. См. раздел Изменение формы 
объектов с использованием контрольных 
точек.. 
 

И нтерв ал меж ду
пет лям и : 1,5мм

Интервал между
петлями: 2,5мм
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Совет: К объектам, заполненным 
пунктирными стежками можно применить 
операцию Break Apart. С ее помощью 
можно напрямую изменять форму 
пунктирной строчки. Можно применять 
разные типы оконтуривающих стежков, 
такие, как Pattern Run, Satin и другие. 
Подробнее см. раздел Разбивка 
объектов на компоненты. 
 

 
Пунктирное заполнение 
стежками Candlewicking  

Пунктирное заполнение  
стежками Blanket 
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ГЛАВА 24 
 

 
ОЦИФРОВЫВАНИЕ ДЛЯ 

АППЛИКАЦИЙ 
------------------------------------------- 

 
Техника аппликации занимает важное место в 
домашнем рукоделии, и функция Auto Applique 
облегчает достижение высокого качества 
работы. Используйте функцию Auto Applique для 
получения стежков, которые требуются для объектов 
аппликации. Генерируется до четырех слоев 
стежков – линия размещения, линия обрезки, 
закрепляющие и покрывающие стежки. 
Используя инструмент Partial Applique, вы 
можете создавать объекты аппликации с 
частичным покрытием вышивкой для 
образования эффекта нахлестки без 
дублирования обрамления Иногда может 
потребоваться дополнительная гибкость для расширения диапазона проектов, которые вы 
можете вышивать. Например, проекты, содержащие открытые объекты, не могут 
обрабатываться функцией Auto Applique. В таком случае специальный инструмент 
Advanced Applique позволит создавать "объект открытой аппликации" из одного или 
нескольких исходных объектов. 
В этом разделе рассматривается создание замкнутого объекта аппликации, а также 
частичного покрытия объектов аппликации. Рассматривается также создание объекта 
открытой аппликации. 
 

Создание замкнутого объекта 
аппликации 
Используйте функцию Auto Applique для 
получения стежков, которые требуются для 
объектов аппликации. Оцифровка контура вокруг 
фигуры аппликации производится почти таким же 
образом, как и для замкнутого объекта вышивки. 
Вы можете выбирать различные настройки, 
включая тип покрывающего стежка - гладьевый 
или краеобметочный, - шаг стежка, а также 
смещение. Автоматически может быть 
сгенерировано до трех типов "вторичных 
объектов". 

 
◄ Линии размещения: Линии размещения 

применяются опционально  для 
позиционирования предварительно вырезанных 
лоскутов аппликации на материале заднего 
плана. 

 
◄ Линии обрезки: И в этом случае опционально 

линии обреза образуют направляющие при 
обрезании лоскута ткани на месте. 

 
◄ Закрепление: Это строчка зигзаг, 

прокладываемая после разметки линий 
размещения и обрезки, которая используется 
для закрепления элементов аппликации к 
материалу фона перед покрывающим 
вышиванием. 
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Совет: Вы можете также создавать объекты 
аппликации с частичным покрытием вышивкой для 
создания эффекта нахлестки без дублирования 
обрамления. См. также Создание частичного 
покрытия объектов аппликации. 
 

Создание объектов аппликации 
 
 Используйте инструмент Auto Applique 
(панель Digitize) для оцифровывания  
замкнутых объектов аппликации.. 

 
 
Используйте функцию Auto Applique для 
получения стежков, которые требуются для 
объектов аппликации. Для каждого объекта 
аппликации генерируется до четырех слоев 
вышивки – линию размещения, линию обрезки, 
закрепляющие и покрывающие стежки в 
соответствии с текущими настройками. Опции, 
определяющие одинарные или сложные контуры, 
а также положение выхода пялец, настраиваются в 
диалоговом окне Options. Подробнее см. в 
разделе Настройка опций автоаппликации. 
 
 
 
 

Совет: При шитье объекта аппликации, машина 
останавливается между слоями. Перед началом 
шитья аппликации уложите ткань на проект и 
запустите машину. После прострачивания 
направляющей линии обрежьте излишек 
материала аппликации и снова запустите машину 
для выполнения закрепляющих и покрывающих 
стежков. 
 
Как создавать объекты аппликации с 
использованием функции Auto Applique. 
1 Загрузите рисунок в режиме Picture. См. также 
Загрузка изображений.  
 Совет: По умолчанию инструмент позволяет 

оцифровывать несколько объектов аппликации. 
Если вы хотите оцифровать одиночный объект, 
активируйте опцию Single в диалоговом окне 
Options. Подробнее см. в разделе Настройка 
опций автоаппликации. 

 
2 Щелкните по значку Auto Applique в режиме 
посмотра Design или Artistic View.  
3 Оцифруйте контур аппликации, наметив 

базисные точки вокруг контура фигуры. 
◄ Щелкните для создания угловой точки. 
◄ Щелкните правой кнопкой, чтобы создать 

точку кривой. 
 
 
 
 
 
 
 
 
 
 
 
 
 
Совет: Следуйте указаниям в строке состояния, 
помогающим при оцифровывании. Если вы 
ошиблись, нажмите клавишу Backspace, чтобы 
удалить последнюю базисную точку, и затем 
продолжайте оцифровывание. 
 
4 Нажмите Enter для закрытия формы. 
 
Примечание: когда замкнутая фигура 
оцифровывается по часовой стрелке, 
краеобметочные стежки ориентированы 
вовнутрь. Соответственно, при оцифровке 
против часовой стрелки они ориентированы 
вовне фигуры. См. Создание контуров с 
краеобметочными стежками 
 
 
5 Щелкните по контуру, чтобы установить точки 

входа и выхода, или нажмите Enter, чтобы 
принять стандартные настройки.  
 

6  В зависимости от выбранного способа вывода 
пялец вам может быть предложено отметить 
позицию вывода пялец. Подробнее см. в 
разделе Настройка опций автоаппликации. 
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Позиция 
выхода 
пялец 

 
◄ Automatic (Автоматически): При выборе этой 

опции положение вывода пялец назначается 
автоматически. 

 
◄ Manual (Вручную): При активировании этой 

опции щелкните в ту точку, в которой должна 
быть позиция вывода пялец. 

 
 
 
 
 
 
 
 
 

◄ Place Under Cover Stitches (Положение под 
покрывающими стежками): Если выбрана эта 
опция, положение вывода пялец определяется 
местом последнего прокола иглы перед тем, как 
произойдет выход пялец. 

 
7  Нажмите клавишу Enter. 
 Фигура замкнута, и сгенерировано до четырех 

слоев вышивки - линия размещения, линия 
обреза, закрепляющие и покрывающие стежки. 
Подробнее см. в разделе Настройка 
параметров автоаппликации. 

 
 
 
 
 Примечание: Команда Ungroup 

(Разгруппировать) не действует, если выбран 
объект Auto Applique. Если вы хотите получить 
доступ к компонентам объекта, используйте 
инструмент Break Apart. Подробнее см. в 
разделе Разбивка объектов на 
компоненты. 

 

 
Настройка параметров 
автоаппликации  
 

 Используйте функцию Object Properties 
(панель General) для настройки свойств 
объекта. 
 

 
Покрывающий стежок создает обрамление вокруг 
формы аппликации. Вы можете контролировать 
различные настройки, включая тип покрывающего 
стежка, шаг стежка, а также смещение по 
отношению к оцифрованному контуру. 
 
Как настроить параметры функции 
автоаппликации 
1  Дважды щелкните левой кнопкой или один раз 

правой кнопкой по объекту автоаппликации. 
 Откроется диалоговое окно Object Properties > 

Applique (Свойства объекта > Аппликация). 
 

 
 Совет: Чтобы настроить параметры до 

оцифровки без выбранного объекта, откройте 
диалоговое окно Object Properties > Applique. 

 
2  На панели выберите тип покрывающего стежка 

– гладьевый валик или краеобметочный 
стежок. 

 
Примечание: Покрывающие стежки активируются 
по умолчанию. 
Этим обеспечивается совместимость аппликаций, 
созданных в программе Explorations, где 
предусмотрена опция ‘No Border’ (Без 
обрамления), с аппликациями, создаваемыми в 
BERNINA Embroidery Software. 
 
3  Настройте ширину строчки и шаг 
покрывающего стежка: 
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◄ Width (Ширина): введите ширину строчки 

гладьевого или обметочного стежка. 
 
 

Ширина гладьевого  Ширина гладьевого  
             валика: 2,5 мм   валика: 1,0 мм 
 
◄ Spacing (Шаг стежка): введите шаг гладьевого 

или обметочного стежка. 
 

 
Шаг обметочного      Шаг обметочного  

             стежка: 1,3 мм       стежка: 2,0 мм 
 
 
 
4  При использовании гладьевого валика 

проставьте "галочку" в окошке Use Tackdown 
(Использовать закрепляющую строчку) и 
выберите ширину строчки и шаг стежков. 
Ширина закрепляющей строчки не может быть 
больше ширины покрывающего стежка. 

 
Закрепляющая 
строчка 
 Ширина: 
уменьшена 
Шаг стежка: 
увеличен 

Закрепляющая 
строчка 
Ширина: по 
умолчанию 
Шаг стежка: по 
умолчанию 

Закрепляющая 
строчка 
Ширина: 
увеличена 
Шаг стежка: 
уменьшен 

 

 
Примечание: Закрепляющие стежки для 
обметочной покрывающей строчки не 
предусмотрены.  
5  Выберите требуемые стили аппликации. 
 Имеются две опции – "линия размещения" 

(Placement Line) и "линия обрезки" (Cutting 
Line). Используйте линию размещения для 
укладки предварительно вырезанных лоскутов 
ткани. Используйте линию обрезки для обрезки 
на месте лоскутов ткани.  

 

 
6  Щелкните по Choose на панели Fabric, чтобы 

выбрать ткань или однотонный цвет для детали 
аппликации. Подробнее см. в разделе 
Размещение тканей в проекты Auto 
Applique. 

 
7  Используйте ползунок, чтобы сместить 

покрывающие стежки внутрь или наружу по 
отношению к линии размещения. 

 
 
 

Настройте смещение 
 покрывающих и  

закрепляющих стежков 
 
 
 
 

Выберите линию 
размещения и/или 
обрезки 
 

Щелкните для выбора 
ткани или цвета  
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Гладьевый стежок по умолчанию не смещен, а 
обметочный стежок смещен на 100 % внутрь. 

 
 

 
 
8  Щелкните по Apply (Применить). 
 
 Текущие настройки будут применены к 
выбранным объектам. 
 
Размещение тканей в проектах 
автоаппликации 
 

Используйте функцию Show Appliqué Fabric 
(панель General), чтобы 
включать/отключать показ ткани/цвета 
аппликации. 

 
 
Диалоговое окно Object Properties > Applique 
содержит панель Fabric, которое позволяет 
выбрать ткань или однотонный цвет для детали 
вашей аппликации. 

 

 

 

 

Как размещать ткани в проектах 
автоаппликации 
 
 
1  Дважды щелкните левой кнопкой или один раз 

правой  
кнопкой по объекту автоаппликации. 

 Откроется диалоговое окно Object Properties > 
Applique (Свойства объекта > Аппликация). 
 

 
 
2  Щелкните по Choose на 

панели Fabric, чтобы выбрать ткань или 
однотонный цвет для аппликации. patch.  

 Откроется диалоговое окно Applique Fabric.  
Опции Fabric/Color/None позволяют вам 
выбрать ткань  
или однотонный цвет. По умолчанию  выбрана 
опция Fabrics (Ткани). 

 

 
 
 
 

3  Прокрутите вниз панель, чтобы найти 
подходящую категорию и щелкните по узлу 
дерева тканей для просмотра имеющегося 
диапазона, например ‘Anniversary Florals’. 

Смещение: 
внутрь 

Смещение: 
отсутствует  

Смещение: 
наружу 

Образец показы-
вает текущую 
ткань, используе-
мую для 
аппликации 
 
Щелкните для  
выбора ткани или 
цвета 

Выберите
между

тканью или
однотонным

цветом

Щелкните по
узлу, чтобы 

увидеть 
диапазон
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4 Щелкните по OK для применения к 

выбранному объекту аппликации.  
 
  
  
  

 
 

 Примечание: Диапазон Benartex отображается 
как в диалоговом окне Patch Properties 
(Свойства лоскута). Подробнее см. в разделе 
Создание открытого объекта аппликации. 

 
 
5  Если вы предпочитаете назначить цвет детали 

аппликации, выберите опцию Color (Цвет). 
 Диалоговое окно Applique Fabric 

преобразуется с отображением палитры 
цветов.   

 

 
 

 
6  Выделите тональный диапазон – светлый 

(Light), средний (Mid) или темный (Dark) – и 
выберите цвет. 

 

 
 
7  Щелкните по OK, чтобы закрыть диалоговое 

окно и вставить ткань в диалоговое окно Object 
Properties > Applique.  

 

 
8  Щелкните по Apply для применения к 

выбранному объекту аппликации. 
 
 
Совет: Используйте переключатель Show 
Appliqué fabric (Показать ткань), чтобы включить 
или выключить отображение цвета / ткани 
аппликации. 
 
 

Создание частичного покрытия 
объектов аппликации. 
 

Щелкните по значку Partial Applique 
(панель Digitize) для создания объектов 
аппликации с частичным покрытием 
стежками. 

 
Вы можете создавать объекты аппликации с 
частичным покрытием вышивкой для создания 
эффекта нахлестки без дублирования 
обрамления.  

Щелкните 
для 

выбора
цвета 

 

Образец 
показывает 
текущую 
ткань или 
цвет 
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Важно тщательно заблаговременно спланировать 
ваш проект, чтобы вы знали, где нужны и где не 
нужны аппликационные покрывающие стежки. 
Нижние слои являются теми, к которым 
применяется частичное покрытие аппликации. 
 
 
 
 
 
 
 
 
 
 
 
 
Как создавать частичное покрытие 
объектов аппликации. 
1 Создайте форму аппликации функцией Auto 
Applique; 
 Подробнее см. в разделе Создание 

аппликации с функцией Auto Applique . 
.        

 
 
 
2

 Выберите объекты аппликации. 
 

 

 
3 Щелкните по значку Partial Applique. 
 При нахлестке объектов покрывающие стежки 

удаляются,  
остаются только вторичные объекты –  
линии закрепления, размещения и обрезки. 
 

 
 
 
частичное покрытие 
 
непрострачиваемые 
части контура 
 
 
 
 

 
 
Создание открытого объекта 
аппликации 
Техника аппликации занимает важное место в 
домашнем рукоделии, и функция Auto Applique 
облегчает достижение высокого качества работы. 
Однако иногда может потребоваться 
дополнительная гибкость для расширения 
диапазона проектов, которые вы можете 
вышивать. 
Например, проекты, содержащие открытые 
объекты, не могут обрабатываться функцией Auto 
Applique. 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
В этом проекте стебель в середине листа должен 
быть вышит после линий размещения и обрезки 
вокруг контура листа, но раньше покрывающих 
стежков. Здесь может быть одна или две зоны 
ткани. Если имеется только один лоскут ткани, для 
стебля не требуются стежки размещения и 
закрепления. 
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Контур 
гладьевым 

валиком

Контур 
обметочным 

стежком

Оцифрованный 
блочный объект 
(повернутый угол 
заполнения) 

Лоскут

 
Если имеются два лоскута, стебель, как и контур, 
должны быть снабжены стежками линий 
размещения и закрепления. 
Еще одна проблема показана на проекте "Кролик". 
Вся форма состоит из открытых линий, порядок 
вышивания которых очень важен, например левое 
ухо должно быть сверху. Внутренняя часть кролика 
должна быть заполнена тканью, даже если ни 
одна из составляющих ее кривых не является 
замкнутой. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
В обоих случаях вы захотите суметь ввести кривые 
в естественном порядке, если возможно, и 
правильно применить программу для замкнутых 
зон. В таком случае специальный инструмент 
Advanced Applique позволит создавать "объект 
открытой аппликации" из одного или нескольких 
"первичных" объектов.  
 

 
Контуры могут быть определены смешиванием 
объектов, как показано здесь. 
 

 
 
Первичные объекты 
Источник "первичных" объектов, используемых при 
создании открытого объекта аппликации, должен 
быть создан и расположен в последовательности 
до применения функции. Эти объекты не 
подвергаются каким-либо изменениям при их 
включении в открытый объект аппликации. Могут 
быть использовано несколько типов источника 
объекта. 

◄ Любой тип оконтуривающего стежка – 
одинарный, оконтуривающий гладьевый и др. 

◄ Любой замкнутый заполненный объект или 
◄ Любой оцифрованный блочный объект. 

В комбинации с указанными выше объектами  
могут быть использованы некоторые другие типы 
объектов. В том числе текстовые объекты, 
автоаппликации и даже другие объекты открытой 
аппликации. 
 
Примечание: Если вышивальное ПО BERNINA 
Embroidery Software обнаруживает больше одной 
зоны, появляется опция объединения их в один 
лоскут. Подробнее см. в разделе Соединение и 
разъединение лоскутов. 
 
Вторичные объекты 
Автоматически может быть сгенерировано до трех 
типов "вторичных объектов". 
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Линии размещения: Эти линии используются 
опционально для обшивания первого слоя 
аппликации. Линии размещения применяются для 
позиционирования предварительно вырезанных 
лоскутов аппликации на материале заднего плана. 
 
◄ Линии обрезки: И в этом случае 

опционально линии обреза образуют 
направляющие при обрезании лоскута ткани 
на месте. 
 

◄ Закрепление: Это строчка зигзаг или 
сметочные стежки, прокладываемые после 
разметки линий размещения и обрезки, 
которые используется для закрепления 
элементов аппликации к материалу фона 
перед покрывающим вышиванием. 
 

Каждый "граничный сегмент" генерирует линию 
размещения, линию обрезки и/или закрепляющую 
строчку в зависимости от текущих настроек. 
 
Примечание: Вторичные объекты шьются раньше 
первичных объектов и поэтому находятся ниже. 
Вы можете сами назначить цвет ниток каждого 
вторичного объекта или принять предложение 
программы BERNINA Embroidery. 
 
 
Создание проекта открытого объекта 
аппликации 

 
Используйте кнопку Advanced Applique 
(панель Digitize) для создания открытого 
объекта аппликации из одного или 
нескольких источников объектов. 

 
 
Для создания открытого объекта аппликации могут 
быть использованы разные типы "первичных 
объектов", в том числе любой тип 
оконтуривающего стежка - одинарный, 
оконтуривающий гладьевый и др. – любой объект с 
заполнением или любой оцифрованный блочный 
объект. Кроме того, могут быть использованы 
некоторые другие объекты, включая текстовые 
объекты, автоаппликации или даже открытые 
объекты аппликации. 

 
 
 
 
 
 
 
 
 
 
 

 
 
Примечание: По умолчанию проекты 
автоматически группируются при открытии или 
вставке в другой проект. Если вы открываете 
проект аппликации после сохранения, вам 
потребуется вначале разгруппировать его, чтобы 
получить доступ к свойствам аппликации.  
Подробнее см. в разделе Настройка других 
общих опций. 
 
Как создать проект открытого объекта 
аппликации 
1  Создайте нужные вам объекты, чтобы включить 

покрывающие стежки проекта аппликации. 
 Подробнее см. в разделе Оцифровывание 

открытых форм. 

 
2  Назначьте свойства стежков и 

последовательность шитья этих объектов. 
 
3  Выберите все объекты, которые должны быть 

включить в открытый объект аппликации,  и 
щелкните по значку Advanced Applique. 
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Вышивальное ПО BERNINA Embroidery 
определяет, содержит ли выделение по меньшей 
мере один объект, пригодный для оконтуривания, 
и правильно ли замкнута зона. Если эти условия 
соблюдены, создается открытый объект 
аппликации и открывается диалоговое окно 
Applique Properties. 
 

 
 
Зоны, входящие в объекты  
"приемлемого контура" маркируются  
заштрихованным белым контуром 
 
Примечание: Формы являются "правильными", 
если открытый объект аппликации создан первым. 
Это может создать эффект удаления сегментов 
малых деталей. Однако первичные объекты 
остаются неизменными. 
 
4  Щелкните по опции Place Fabric and Color in 

Patches, чтобы добавить ткань или цвет. 
Подробнее см. ниже, в разделах Размещение 
ткани в лоскутах и Размещение цвета в 
лоскутах. 

 

 

 
5  После завершения щелкните по Back. 
6  Щелкните по кнопке Close, чтобы закрыть 

диалоговое окно. 
 
Совет: Открытые объекты аппликации можно 
выделять и обрабатывать тем же способом, что с 
группированные объекты, т.е. их можно 
перемещать, изменять размеры, перекашивать 
или поворачивать, используя тот же метод 
перетаскивания мышью, применимый для всех 
объектов. 
Однако изменять форму открытых объектов 
аппликации невозможно. И при этом нет какого-
либо способа, чтобы выбрать первичные или 
вторичные индивидуальные объекты, в пределах 
открытого объекта аппликации, если объект не 
будет вначале обособлен Подробнее см. в 
разделе  
Разбивка объектов на компоненты. 
 
Размещение ткани в лоскутах 

 
Используйте функцию Show Appliqué 
Fabric (панель General), чтобы 
включать/отключать показ ткани/цвета 
аппликации. 

 
 
 
Вы можете добавить образец ткани к открытому 
объекту аппликации, если он создан на первой или 
любой из последующих стадий. 
 
Как разместить ткань в лоскутах 
1  Если редактируется существующий открытый 

объект аппликации, дважды щелкните левой 
кнопкой или щелкните правой кнопкой по 
объекту. 
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Вокруг любой замкнутой 
формы при перемещении 
указателя мыши 
появляется белый контур 

Откроется диалоговое окно Applique Properties 
(оно может быть открыто, если вы уже создали 
объект). 
 

 
 
 
2  Активируйте опцию Place Fabric and Color in 

Patches. Диалоговое окно изменится, будет 
показана панель Place Fabric in Patches 
(Размещение ткани в лоскутах).  

 
 
 Примечание: На панели Used Fabrics and 

Colors (Используемые ткани и цвета) могут 
быть уже предварительно выбранные опции. 

 
3  Выберите ткань из дерева тканей, – например 

‘Vintage Shirtings’,– или из панели Used Fabrics 
and Colors (Используемые ткани и цвета). 

4  Переместите указатель мыши по зоне проекта. 
Вокруг любой замкнутой формы, по которой 
перемещается указатель мыши, появится белый 
контур 
 
5  Щелкните по зоне, которая в настоящее время 

заштрихована или заполнена. Зона заполнится 
выбранной тканью, и образец будет добавлен в 
поле Used Fabrics and Colors (Используемые 
ткани и цвета). 

 
 
 
 
 
 
 
 

Примечание: Для каждого нового созданного 
лоскута создаются вторичные вышитые объекты с 
использованием принимаемых по умолчанию 
типов стежка и цвета ниток. Подробнее см. в 
разделах Настройка цвета стежков и 
Настройка типа стежков. 
 
6  Выберите другие требуемые зоны, чтобы 

добавить больше лоскутов.  
 
7  После завершения щелкните по Back. 
 
8  Щелкните по кнопке Close, чтобы закрыть 

диалоговое окно. 
 Альтернативно для активирования других 

опций щелкните по Place Color in Patches 
(Размещение цвета в лоскутах) или Remove 
Fabric from Patches (Удаление ткани из 
лоскутов). 

 Подробнее см. ниже, в разделах Размещение 
цвета в лоскутах и Удаление ткани или 
цвета из лоскутов. 

 Совет: Используйте переключатель Show 
fabric (Показать ткань), чтобы включить или 
выключить отображение цвета / ткани 
аппликации. 
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Вокруг любой замкнутой 
формы при перемещении 
указателя мыши появляется 
белый контур 

 
Размещение цвета в лоскутах 
 

Используйте функцию Show Appliqué Fabric 
(панель General), чтобы 
включать/отключать показ ткани/цвета 
аппликации. 

 
Вы можете добавить цвет образца ткани к 
открытому объекту аппликации, если он создан на 
первой или любой из последующих стадий. 
 
Как разместить цвет в лоскутах 
 
1  Если редактируется существующий открытый 

объект аппликации, дважды щелкните левой 
кнопкой или щелкните правой кнопкой по 
объекту. Откроется диалоговое окно Applique 
Properties (оно может быть открыто, если вы 
уже создали объект). 

 

 
 
 
2  Активируйте опцию Place Fabric and Color in 

Patches. 
 

 
 Диалоговое окно изменится, будет показана 

панель Place Fabric in Patches (Размещение 
ткани в лоскутах).  На панели Used Fabrics 
and Colors (Используемые ткани и цвета) могут 
быть уже предварительно выбранные опции. 

 

 
 
 Примечание: На панели Used Fabrics and 

Colors (Используемые ткани и цвета) могут 
быть уже предварительно выбранные опции. 

 
3  Выделите тональный диапазон – светлый 

(Light), средний (Mid) или темный (Dark), – 
используя один из трех переключателей в 
верхней части палитры. 

 
4  Выберите цвет из цветовой палитры. 
 
5  Переместите указатель мыши по зоне проекта. 

Вокруг любой замкнутой формы, по которой 
перемещается указатель мыши, появится 
белый контур 

 
6  Щелкните по оконтуренной зоне, которая в 

настоящее время заштрихована или 
заполнена. 
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Зона заполнится выбранной тканью, и образец 
будет добавлен в поле Used Fabrics and Colors 
(Используемые ткани и цвета). 

 
 
 
 
 
 
 

Примечание: Для каждого нового созданного 
лоскута создаются вторичные вышитые объекты с 
использованием принимаемых по умолчанию 
типов стежка и цвета ниток. Подробнее см. в 
разделах Настройка цвета стежков и 
Настройка типа стежков. 
 
7  Выберите другие требуемые зоны, чтобы 

добавить больше цветов.  
 

8  После завершения щелкните по Back. 
 

9  Щелкните по Close, чтобы закрыть диалоговое 
окно. 

 Альтернативно для активирования других 
опций щелкните по Place Fabric in Patches 
(Размещение ткани в лоскутах) или Remove 
Fabric from Patches (Удаление ткани из 
лоскутов). 

 Подробнее см. ниже, в разделах Размещение 
цвета в лоскутах и Удаление ткани или 
цвета из лоскутов. 

 Совет: Используйте переключатель Show 
Appliqué fabric (Показать ткань), чтобы 
включить или выключить отображение цвета / 
ткани аппликации. 

 
Удаление ткани или цвета из лоскутов 
Вы можете удалять цвета или ткани из открытого 
объекта аппликации на любой стадии. 
 
Как удалить ткани или цвета из лоскутов 
1  Дважды щелкните левой кнопкой или один раз 

правой кнопкой по открытому объекту 
аппликации. 
 
 

 
 Откроется диалоговое окно Applique 

Properties (Свойства аппликации). 
 

 
 
 
2  Активируйте опцию Remove Fabric from 

Patches (Удаление ткани из лоскута). 
 Диалоговое окно изменится, будет показана 

панель Remove Fabric from Patches.  
 

 
3  Переместите указатель мыши по зоне проекта. 
 Вокруг любой замкнутой формы, по которой 

перемещается указатель мыши, появится 
белый контур 

 
4  Щелкните по оконтуренной зоне, которая в 

настоящее время заштрихована или 
заполнена. 
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 Лоскут ткани или цвет заменяется с белым 

заштрихованием и все сопутствующие 
вторичные объекты удаляются. 

 
 
 
 
 
 
 
 
 
 
 
 
 

 
 Примечание: Ткань или цвет удаляются также 

из панели Used Fabrics and Colors, если они 
использовались в качество примера ткани или 
цвета.  
 

5  Выберите другие требуемые зоны, чтобы 
удалить больше лоскутов.  
 

6  После завершения щелкните по Back. 
7  Щелкните по Close, чтобы закрыть диалоговое 

окно. 
 Альтернативно для активирования других 

опций щелкните по Place Color in Patches 
(Размещение цвета в лоскутах) или Place 
Fabric in Patches (Размещение ткани в 
лоскутах). Подробнее см. ниже, в разделах 
Размещение ткани в лоскутах и 
Размещение цвета в лоскутах. 

 
 
 
Соединение и разъединение лоскутов 
На показанном ниже примере может быть одна 
или две зоны ткани. Если имеются два лоскута, 
стебель, как и контур, должны быть снабжены 
стежками линий размещения и закрепления. Если 
имеется только один лоскут ткани, для стебля не 
требуются стежки размещения и закрепления. В 
этом случае две зоны ткани требуется объединить 
в одну. 
 

 
 

 
Как соединять и разъединять лоскуты 

1  Дважды щелкните левой кнопкой или один раз 
правой кнопкой по объекту Advanced Applique. 

 Откроется диалоговое окно Applique 
Properties (Свойства аппликации). 

 
 

 
 
 
2  Выберите опцию Merge Patches Together 

(Соединение лоскутов). 
 



Глава 24: Оцифровывание для аппликаций 

BERNINA® Вышивальное ПО  Версия 6 288

 
 Откроется панель Merge Patches Together. 
 

 
 
 
3  Выберите подлежащий присоединению лоскут. 
 Вокруг контура появится красная линия. 
4  Наведите указатель мыши на второй лоскут. 

Этот элемент может быть заполнен или не 
заполнен тканью или цветом. Вокруг контура 
появится белая линия. 

 

 
 
5  Щелкните по лоскуту. 
 Оба лоскута сольются в единый лоскут, приняв 

ткань или цвет первого элемента. Все 
вторичные стежки удаляются из сегментов 
контура перед слиянием лоскутов. 
 
 

 
 
 
 
 
 
 
 

 Примечание: Два лоскута считаются 
примыкающими, если у них совмещаются 
контуры, которые могут быть частью объекта 
оконтуривания – одинарная строчка, гладьевый 
стежок и др. – или частью заполненного 
объекта, который свертывается в середине, 
образуя часть общего контура.  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
6  Повторяйте эти операции столько раз, сколько 

требуется. 
 

Лоскуты 1 и 2 не 
могут быть 
объединены, так как 
они не примыкают 
друг к другу. 
 

Лоскуты 3 и 4 могут 
быть объединеныы, 
так как они примыкают 
друг к другу 
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 Совет: Чтобы разъединить соединенные 

лоскуты, активируйте на любой стадии опцию 
Unmerge Patches и щелкните по 
разъединемому лоскуту. 

 

 
 
 Объединенный лоскут разделяется на 

оригинальные индивидуальные лоскуты, 
каждый со своим текущей тканью или цветом 
(не с оригинальной тканью или цветом). 
Создается новый вторичный объект для общих 
контурных линий между вновь разделенными 
лоскутами. Свойства стежков этих вторичных 
объектов являются теми же, которые были до 
слияния зон. 

7  После завершения щелкните по Back. 
 

8  Щелкните по Close, чтобы закрыть диалоговое 
окно. 

 Совет: Используйте переключатель Show 
fabric (Показать ткань), чтобы включить или 
выключить отображение цвета / ткани 
аппликации. 

 
Настройка цвета стежков 
Вы можете установить цвета автоматически или 
вручную. Для любого создаваемого вновь 
открытого объекта аппликации вторичные объекты 
создаются с использованием автоматического 
выбора цвета стежков. Имеются две опции: 
Special colors for each layer (Специальные цвета 
для каждого слоя) и Match color of cover stitching 
.(Соответствие цвета покрывающих стежков).  См. 
также раздел Настройка типа стежков. 
 
Как настроит цвет стежков 
1  Дважды щелкните левой кнопкой или один раз 

правой кнопкой по объекту Advanced Applique. 
 

 
 Откроется диалоговое окно Applique 

Properties (Свойства аппликации). 
 

 
2  Выберите опцию Set Colors Automatically 

(Автоматическая установка цвета). 
 Откроется диалоговое окно Automatic Stitch 

Colors (Автоматическая установка цвета 
стежков). 

 

 
 
 
3  Выберите одну из цветовых схем из 

имеющихся опций: 
◄ Match color of cover stitching (Подбор 

соответствующего цвета покрывающих 
стежков): Если выбрана эта опция, все 
вторичные объекты показываются в цвете 
сопутствующих им   первичных объектов. 

 
◄ Special colors for each layer (Специальные 

цвета для каждого слоя): Если выбрана эта 
опция, все вторичные объекты показываются 
и вышиваются отображенными на панели 
цветами (выбраны для более четкого 
отображения на экране). 

 
 Примечание: Использование ниток 

показанного на экране цвета не обязательно, 
но цвет отдельных ниток для всех вторичных 
объектов должен в полной мере сочетаться с 
цветом ткани основы аппликации  
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4  Щелкните по OK для завершения. 
5  Щелкните по Close, чтобы закрыть диалоговое 

окно. 
 
Настройка типа стежков 
У вас имеются две опции для настойки типа 
стежка, используемого для вторичных объектов: 
автоматический или ручной способ.. Для 
автоматической настройки вам нужно просто 
активировать опцию Set Stitch Types 
Automatically (Автоматическая настойка типа 
стежков) в диалоговое окне Applique Properties. 
Типы стежков для всех закрепляющих строчек 
устанавливаются в соответствии с типом 
покрывающего стежка следующим образом: 

◄ Если в качестве покрывающих используются 
оконтуривающий гладьевый стежок, 
заполняющий гладьевый стежок, 
заполняющий простегивающий стежок или 
заполнение орнаментными стежками, для 
закрепления выбирается зигзаг. 

◄ Если покрывающими являются стежки 
другого типа, то для закрепления 
используется переходной стежок. 

 
Если требуется более тщательно подбирать типы 
стежков, используемых для линий размещения, 
обрезки и закрепления, используйте следующую 
процедуру. При ручном выборе цветов, любое 
выполненное вами изменение автоматически 
отменяет выбранный цвет. 
 
Как настроит тип стежков 
1  Дважды щелкните левой кнопкой или один раз 

правой кнопкой по объекту Advanced Applique. 
 

 
 Откроется диалоговое окно Applique 

Properties (Свойства аппликации). 
 

 
 
2  Выберите опцию Set Stitch Types Manually 

(Настройка типа стежков вручную).  
 Откроется панель Set Properties Manually 

(Ручная настойка свойств). 
 

 
 
3  Для активирования панели Set Properties 

Manually выберите сегмент контура 
следующим образом: 

 
◄ При наведении указателя мыши на 

индивидуальный сегмент контура, он 
подсвечивается белым. Если вы наведете 
указатель мыши на заполненный элемент, то 
подсвеченным белым будет весь контур 
лоскута. Если вы затем щелкните мышью, 
подсвеченный участок будет выделен. Контуры 
выделенных сегментов окрасятся в пурпурный 
цвет. 
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Закрепляющие 
стежки 

Смещение: наружу 
Шаг : уменьшен

Закрепляющие 
стежки 

Смещение: нет 
Шаг : по умолч. 

Закрепляющие 
стежки 

Смещение: внутрь
Шаг : увеличен

 
◄ Если удерживать нажатой клавишу Ctrl при 

подсвеченном контуре или сегменте контура, 
подсвеченная часть добавляется к выделению, 
если она не была выделена, или удаляется из 
выделения, если она была выделена. 

 
4  Выберите вторичные объекты, которые вы 

хотите включить в открытый объект 
аппликации: 

 
◄ Линии размещения: Эти линии используются 

опционально для обшивания первого слоя 
аппликации. Линии размещения применяются 
для позиционирования предварительно 
вырезанных лоскутов аппликации на материале 
заднего плана. 

 
◄ Линии обрезки: И в этом случае опционально 

линии обрезки образуют направляющие при 
обрезании лоскута ткани на месте. 

 
◄ Закрепление: Это строчка зигзаг или 

сметочные стежки, прокладываемые после 
разметки линий размещения и обрезки, которые 
используется для закрепления элементов 
аппликации к материалу фона перед 
покрывающим вышиванием. 

 
5  Установите цвет отображения для каждого из 

вторичных объектов – линий размещения, 
линий обрезки и/или закрепления, - которые вы 
выбираете. 

 
Примечание: При ручном выборе цветов, любое 
выполненное вами изменение автоматически 
отменяет ранее выбранный цвет. Подробнее см. в 
разделе Настройка цвета стежков. 
 
6  Если вы хотите включить закрепляющие 

стежки, выберите требуемый тип:   
 

 
 

 
Зигзаг: В этом случае имеется выбор:  
◄ Stitch width (Ширина строчки): 

устанавливается ширина зигзага. 
◄ Spacing (Шаг стежка): устанавливается шаг 

зигзагов. 
◄ Color (Цвет):  устанавливается цвет стежков. 
◄ Offset (Смещение): устанавливается 

положение строчки по отношению к вторичному 
объекту, как показано на рисунке. 

 
 
 
 
 
Сметочный стежок: В этом случае имеется 
выбор: 
◄ Stitch length (Длина стежка): устанавливается 

длина стежка, подходящая для оцифрованной 
формы, - для кривых с резкими изгибами 
выбирается меньшая длина стежка, для пологих 
кривых можно увеличивать длину стежка для 
сокращения общего количества стежков. 

◄ Color (Цвет):  устанавливается цвет стежков. 
7  Для возврата щелкните по Back. 
8  Щелкните по Close, чтобы закрыть диалоговое 
окно. 
 
Восстановление оригинальных 
проектов вышивки 
Первичные объекты могут быть восстановлены в 
любое время. Вышивальное ПО BERNINA 
Embroidery удалит все вторичные объекты, 
разгруппирует первичные объекты и преобразует 
их в индивидуальные объекты. См. также раздел 
Разбивка объектов на компоненты. 

Выберите тип 
закрепляющего  
стежка 
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Как восстановить оригинальные проекты 
вышивки 
1  Дважды щелкните левой кнопкой или один раз 

правой кнопкой по объекту Advanced Applique. 
 Откроется диалоговое окно Applique 

Properties (Свойства аппликации).  
 

 
2  Активируйте опцию Recover your original 

embroidery objects (Восстановить ваш 
оригинальный проект вышивки). 

 Будут 
удалены все 

вторичные объекты и разгруппированы все 
первичные объекты. 

 
 
 
 
 
 
 
 
 
 
 
 
 
3  Щелкните по Close, чтобы закрыть диалоговое 

окно. 
 Примечание: Если весь открытый объект 

аппликации был изменен по размеру, 
перемещен или перекошен, первичные 
объекты будут восстановлены в 
трансформированном состоянии. 
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ЧАСТЬ VI 
 

ТЕКСТОВЫЕ ЭФФЕКТЫ 
------------------------------------------ 

 
 
 
 
Основные сведения о текстовых объектах 
 
В этом разделе описывается, как добавлять текст к проектам вышивки. Также 
объясняется, как использовать базовые линии текста, форматировать текст и 
настраивать интервал между буквами.  
Подробнее см. в главе Основные сведения о текстовых объектах 
 
Правка вышиваемых текстов 
 
В этой главе описывается, как редактировать текстовые объекты. Поясняется так же, 
как изменять размер текста и удалять стабилизирующие стежки из небольших букв. 
Кроме того, рассматриваются способы трансформирования текстовых объектов и 
изменения формы базовых линий. 
Подробнее см. в главе Правка вышиваемых текстов 
 
Специальные текстовые эффекты 
 
В этой главе описывается порядок конвертирования шрифтов TrueType в 
вышивальные шрифты. Кроме того, объясняется, как добавлять в ваши проекты 
специальные символы, а также орнаментальные буквы и монограммы. Поясняется 
также, как применять различные типы стежков к тестовым объектам т как создавать 
специальные эффекты функцией Elastic Lettering.  
Подробнее см. в главе Специальные текстовые эффекты 
 
Монограммы 
 
В этой главе рассматриваются способы создания текстовых монограмм с инициалами 
или именем, с добавлением к монограммам орнамента, а также порядок компоновки 
элементов орнамента. Кроме того, поясняется, как добавлять и создавать собственные 
обрамления.  
Подробнее см. в главе Монограммы. 
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ГЛАВА 25 

 

 
ОСНОВНЫЕ СВЕДЕНИЯ О 
ТЕКСТОВЫХ ОБЪЕКТАХ 

------------------------------------------- 

 
Текстовые объекты добавляются к проекту быстро и легко 
или на экране с использованием текущих настроек, или 
через диалоговое окно Object Properties - Lettering. Вы 
можете поместить текст на прямой горизонтальной или 
вертикальной линии, по окружности или по дуге или же 
создать собственную базовую линию произвольной формы. 
Вы можете применять форматирование текстовых объектов 
таким же образом, как при работе в текстовом редакторе, 
включая придание тексту курсивного или полужирного 
начертания или выравнивание по левому или правому краю. Интервалы между 
буквами, словами и строчками могут быть определены до или после создания 
текстовых объектов и размещения их в вашем проекте.  Подробнее см. в разделе 
Примеры алфавитов. 
 
В этом разделе описывается, как добавлять текст к проектам вышивки. Также 
объясняется, как использовать базовые линии текста, форматировать текст и 
настраивать интервал между буквами. 

 

Добавление текста к проектам 
вышивки  
 
Вы можете добавлять текст в проект, набирая 
его непосредственно на экране.  Настройка 
свойств объекта для форматирования текста 
выполняется до или после добавления его к 
проекту. BERNINA Embroidery Software 
предоставляет несколько алфавитов, 
подходящих для многих применений. Выберите 
нужное из входящих в комплект поставки 
алфавитов или конвертируйте шрифты 
TrueType. 
 

Создание текстовых объектов на 
экране 
 

 Используйте инструмент Lettering 
(панель Digitize) для добавления 
текста непосредственно на экране. 
 

 

Нет особой необходимости вставлять буквы в 
определенную зону, вы можете печатать их 
непосредственно на экране. Вы можете также 
редактировать текстовые объекты 
непосредственно на экране для получения 
различных художественных эффектов. 
Внешний вид и компоненты зависят от текущих 
установок. Вы можете изменить их в любое 
время. Подробнее см. в разделе Правка 
вышиваемых текстов. 
 

Как создавать текстовые объекты на 
экране 
1  Нажмите кнопку Lettering (Текст). 
2 Выберите цвет из цветовой палитры. 

Подробнее см. в разделе Выбор нового 
текущего цвета.  

3 Щелкните мышью в том месте, где вы хотите 
начать текст.
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При этом появится балочный (I-образный) 
указатель. 

 
4 Напечатайте буквы, которые вы хотите 
вышить. 
 

Совет: Чтобы начать новую строку, нажмите 
Shift + Enter. 

5 Нажмите Enter для завершения.   
     Стежки будут сгенерированы немедленно. 

      
Примечание: Внешний вид и компоненты 
зависят от текущих установок в диалоговом окне 
Object Properties – Lettering. Вы можете изменить 
их в любое время. Подробнее см. в разделе  
Правка вышиваемых текстов. 
 

Создание текстовых объектов в 
диалоговом окне Object Properties  
 

Щелкните правой кнопкой мыши по 
инструменту Lettering (панель Digitize), 
чтобы ввести текст в диалоговое окно 
и настройки параметров вышиваемого 

                  текста. 
 
Используя диалоговое окно Object Properties – 
Lettering, вы можете назначить формат текста, 
прежде чем добавлять его в проект. Это 
наиболее традиционный метод, который удобно 
использовать с более сложными проектами. 
 

Как создавать текстовые объекты в 
диалоговом окне Object Properties  
1  Щелкните правой кнопкой мыши по значку 
Lettering (Текст). 
 

 
 Откроется диалоговое окно Object Properties - 
Lettering (Свойства объекта - Текст). 
 
        Ввод текста 

 
                                  Выбор опций 
  

 

2 В окно ввода текста введите текст, который 
вы хотите вышить. 

 Чтобы начать новую строку текста, нажмите 
Shift + Enter. 

 
 Совет: Вы можете вставить изменение цвета 

между двумя буквами, поместив символ 
знака вставки (^). Последующие буквы по 
умолчанию примут следующий цвет из 
последовательности палитры. 

3 Выберите алфавит, форматирования и 
настройки базовой линии для текста. 

 Подробнее см. в разделах Выбор 
алфавитов и Форматирование текста. 

4 Нажмите кнопку Apply. 
5 Щелкните в том месте, куда вы хотите 

поместить текст, или наметить базисные 
точки для выбранной вами базовой линии. 

 Подробнее см. в разделе Применение 
базовых линий текста. 
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Примечание: Буквы заполняются стежками в 
соответствии с текущими установками в 
диалоговом окне Object Properties. Вы можете 
изменить их в любое время. Подробнее см. в 
разделе Применение различных типов 
стежков и эффектов в текстовых 
объектах. 
 

Выбор алфавитов 
 
Щелкните правой кнопкой мыши по 
значку Lettering (панель Digitize), чтобы 
выбрать алфавит для новых или 
выбранных текстовых объектов. 

 
BERNINA Embroidery Software предоставляет 
несколько алфавитов, подходящих для многих 
применений. Выберите нужное из входящих в 
комплект поставки алфавитов или конвертируйте 
шрифты TrueType. 
При выборе алфавита следует учитывать, где 
будет вышит текст и сам характер текста. Если 
вы украшаете вышивкой детскую одежду, то 
нужно применять простой алфавит, например 
Childs Play. Для вышивания на дамской ночной 
рубашке вы можете использовать элегантный 
рукописный шрифт, например Anniversary. 
 
Примечание: Соблюдайте 
минимальные/максимальные рекомендации для 
каждого алфавита и для получения наилучших 
результатов не выходите за пределы этих 
рекомендаций. Подробнее см. в разделе 
Примеры алфавитов. 
 

Как выбрать алфавит 
1 Щелкните правой кнопкой мыши по значку 

Lettering (Текст). 
 Откроется диалоговое окно Object Properties - 

Lettering (Свойства объекта - Текст). 
    

       
              
 

                  Выбор алфавита 
 

2 Выберите алфавит из списка Alphabet. 
 В окне просмотра появятся пример буквы 

выбранного алфавита. Подробнее см. в 
разделе      Примеры алфавитов. 

 
Совет: Перед выбором алфавита обратите 
внимание на размеры букв. Некоторые 
алфавиты выглядят лучше в меньшем 
размере. Другие могут быть вышиты в 
большом размере. См. также Подгонка 
текста по высоте и ширине. 

3 Нажмите кнопку Apply. 
 Выбранный алфавит установлен. 

Применение базовых линий 
текста 
Базовые линии определяют форму текстовых 
объектов в проекте. Вы можете поместить текст 
на прямой горизонтальной или вертикальной 
линии, по окружности или по дуге или же создать 
собственную базовую линию произвольной 
формы. В зависимости от используемой базовой 
линии потребуются различные базовые точки. 
Вы можете оцифровывать базовые линии на 
экране. 
 

 

 

 

 

 

 

 
 
 
 
 
В базовых линиях используются стандартные 
установки, определяющие их размеры, 
межбуквенные интервалы и углы наклона. 
BERNINA предоставляет возможность как 
диалогового, так и точного цифрового 
управления многими настройками базовых 
линий. Имеется возможность изменять тип 
базовой линии, ее длину, радиус и угол, а также 
ее положение. 
 
Примечание: BERNINA Embroidery Software 
запоминает, какую базовую линию вы 
использовали в последний раз и будет 
использовать ее, если вводите текст 
непосредственно на экране. 

Окно просмотра  
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Выбор базовых линий 
 
Щелкните правой кнопкой мыши по 
значку Lettering (панель Digitize) и 
настройте установки базовой линии. 

 

Используйте значок Free Line (закладка 
Lettering) для создания горизонтальных 
базовых линий произвольной или 
заранее определенной длины. 

И 

спользуйте значок Circle CW (закладка 
Lettering) для создания базовых линий 
по верхней дуге по часовой стрелке. 
 
Используйте значок Circle CCW 
(закладка Lettering) для создания 
базовых линий по нижней дуге против 
часовой стрелки. 
 

Используйте значок Any Shape 
(закладка Lettering), чтобы подогнать 
форму текста к элементам проекта. 

Используйте значок Free Line Vertical 
(закладка Lettering) для создания 
вертикальных базовых линий 
произвольной или заранее 
определенной длины. 
 
 
Используйте значок Predefined 
(закладка Lettering) для создания 
сложных дугообразных базовых линий. 
 

Имеются различные базовые линии для 
использования с новыми или выделенными 
текстовыми объектами. Настраивайте базовые 
линии в диалоговом режиме или через свойства. 
 
Как выбирать базовые линии 
1 Дважды щелкните по выбранному текстовому 

объекту или щелкните правой кнопкой мыши 
по значку Lettering. 

 Откроется диалоговое окно Object Properties - 
Lettering (Свойства объекта - Текст). 

 

 
Выбор 

базовой 
линии 

 

 

2 Выберите базовую линию. 
 Выбор базовой линии зависит от желаемого 

вами эффекта. Вы можете оцифровывать 
различные базовые точки в зависимости от 
выбранной вами базовой линии. Имеются 
следующие опции: 
◄ Прямая горизонтальная линия. 

Подробнее см. в разделе Создание 
горизонтальных базовых линий. 

◄ Окружность по часовой стрелке. 
Подробнее см. в разделе Создание 
базовых линий по окружности. 

◄ Окружность против часовой стрелки. 
Подробнее см. в разделе Создание 
базовых линий по окружности. 

◄ Базовая линия произвольной формы. 
Подробнее см. в разделе Создание 
пользовательских базовых линий. 

◄ Вертикальная базовая линия. Подробнее 
см. в разделе Создание вертикальных 
базовых линий. 

◄ Комплект базовых линий. Подробнее см. в 
разделе Создание пользовательских 
базовых линий. 

 
3 Нажмите кнопку Apply. 
 
Выбранная базовая линия применима к любому 
выделенному текстовому объекту или вновь 
созданным текстовым объектам. 
Совет: Создавайте идентичные базовые линии 
путем дублирования или копирования в вашем 
проекте. 
 

Создание горизонтальных базовых 
линий 
 

Щелкните правой кнопкой мыши по 
значку Lettering (панель Digitize)  
и настройте установки базовой линии. 
 
Используйте значок Free Line (закладка 
Lettering) для создания горизонтальных  
базовых линий произвольной или 
заранее определенной длины. 
 

Прямые горизонтальные базовые линии не 
имеют фиксированной заранее определенной 
длины. Они растягиваются по мере добавления 
букв. 
      
 
 
 
 
 
 

Как создавать горизонтальные базовые 
линии 
1 Щелкните правой кнопкой мыши по значку 

Lettering (Текст), чтобы открыть диалоговое 
окно Object Properties - Lettering (Свойства 
объекта – Текст). Подробнее см. в разделе 
Создание текстового объекта в 
диалоговом окне Object Properties.  
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2 Введите текст в окно ввода текста. 
Подробнее см. в разделе Создание 
текстового объекта в диалоговом окне 
Object Properties.  

3 Выберите значок Free Line (Свободная 
линия). 

4 Нажмите кнопку Apply. 
5 Щелкните по экрану по тому месту, в которое 

вы хотите вставить буквы. 
 

Создание вертикальных базовых 
линий 

 

Щелкните правой кнопкой мыши по 
значку Lettering (панель Digitize)  
и настройте установки базовой линии. 
 
Используйте значок Free Line (закладка 
Lettering) для создания горизонтальных  
базовых линий произвольной или 
заранее определенной длины. 
 
 

 
Вертикальные базовые линии 
являются прямыми 
вертикальными базовыми 
линиями. Вертикальные 
базовые линии не имеют 
фиксированной длины и 
растягиваются по мере ввода 
букв. 
Интервал между строками 
рассчитывается по горизонтали, 
в то время как интервал между 
буквами рассчитается по 
вертикали. Буквы по умолчанию 
выравниваются по центру вдоль 
вертикальной линии. Новые 
строки располагаются по 
умолчанию справа налево для 
приспособления к азиатским языкам. 
Вертикальные базовые линии эффективны для 
вышивания на рукавах для создания 
декоративного эффекта и для текстов на 
азиатских языках. 
 
Совет: Вертикальный текст лучше подходит для 
прописных букв западных языков, поскольку 
строчные буквы с нижними выносными 
элементами нарушают нормальный интервал 
между буквами. 
 

Как создавать вертикальные базовые 
линии 
1 Щелкните правой кнопкой мыши по значку 

Lettering (Текст), чтобы открыть диалоговое 
окно Object Properties - Lettering (Свойства 
объекта – Текст). Подробнее см. в разделе 
Создание текстового объекта в 
диалоговом окне Object Properties.  
 

 
2 Введите текст в окно ввода текста. 

Подробнее см. в разделе Создание 
текстового объекта в диалоговом окне 
Object Properties.  

3 Выберите значок Free Line Vertical  
(Свободная вертикальная линия).  

4 Нажмите кнопку Apply. 
5 Щелкните по экрану в том месте, в которое 

вы хотите вставить буквы. 
 

Создание базовых линий по 
окружности 

 

Щелкните правой кнопкой мыши по 
значку Lettering (панель Digitize)  
и настройте установки базовой линии. 
 
Используйте значок Circle CW (закладка 
Lettering) для создания базовых линий 
по часовой стрелке. 
 
Используйте значок Circle CCW 
(закладка Lettering) для создания 
базовых линий против часовой стрелки. 
 
 

Используйте базовые линии по окружности по 
часовой стрелке и против часовой стрелки, 
чтобы расположить буквы по полной окружности. 
Вы можете расположить текст на окружности по 
часовой стрелке (CW) или против часовой 
стрелки (CCW). По умолчанию буквы 
располагаются над  базовой окружностью по 
часовой стрелке и под базовой окружностью 
против часовой стрелки. По умолчанию они 
выравниваются по центру.  
 

 
       

Как создавать базовые линии по 
окружности 
1 Щелкните правой кнопкой мыши по значку 

Lettering (Текст), чтобы открыть диалоговое 
окно Object Properties - Lettering (Свойства 
объекта – Текст). Подробнее см. в разделе 
Создание текстового объекта в 
диалоговом окне Object Properties.  

2 Введите текст в окно ввода текста. 
Подробнее см. в разделе Создание 
текстового объекта в диалоговом окне 
Object Properties.  

3 Выберите значок Circle CW  (Базовая линия 
по окружности по часовой стрелке)  или 
Circle CCW (Базовая линия по окружности 
против часовой стрелки) и нажмите кнопку 
Apply. 

 В строке состояния будут появляться 
подсказки.
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ва
п

Нажмите Enter 
для 
завершения 
установки 

4 Щелкните по экрану в то место, в которое вы 
хотите вставить центр окружности.. 

  
 

     
 
5  Наметьте точку на контуре окружности, чтобы 

определить радиус. 
 6  Нажмите Enter для завершения установки  
    окружности. 
 
 
 
 
 
 
 
7  Альтернативно, если вы хотите создать 

овальную базовую линию, наметьте третью 
контрольную точку. 

 
                               

 
 
 
 
 
 
 
 
 
 

 
 
 
8 Нажмите Enter для завершения создания 

овала.  
 
 
 
 
 

 
Совет: Наметьте  достаточно большую 
окружность для размещения вашего текста.  
Если она слишком мала или текст слишком 
длинен, текст будет искажен. Но вы можете 
изменить радиус базовой линии в диалоговом 
окне. См. также раздел Изменение формы 
базовой линии. 

 
 
 
 
Совет: Можно получать различные эффекты 
путем изменения настроек выравнивания текста 
- по левому или правому краю, по центру или по 
ширине. Подробнее см. в разделе 
Выравнивание текста. 

 
Создание сложных базовых линий 
 

Щелкните правой кнопкой мыши по 
значку Lettering (панель Digitize) и 
настройте установки базовой линии. 
 
Используйте значок Predefined (закладка  
Lettering). для создания сложных 
дугообразных базовых линий. 
 

Используйте сложную базовую линию, чтобы 
расположить текст по верхней дуге по часовой 
стрелке, по прямой линии в середине и по дуге 
против часовой стрелки внизу. 
 
 
 
 
 
 
 
 
 
 

 
 

 
 

Настройка радиуса  
базовой линии 

Радиус базовой 
линии 10 мм

Радиус базовой 
линии 20 мм

Щелкните, чтобы 
наметить центр 
окружности Щелкните, 

чтобы 
установить 
радиус 

Щелкните, чтобы 
определить  
радиус овала 

 Нажмите Enter, чтобы 
завершить установку 
окружности 
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Введите текст для 
каждой линии 

 
Как создавать сложные базовые линии 
1 Щелкните правой кнопкой мыши по значку 
Lettering (Текст), чтобы открыть диалоговое 
окно Object Properties - Lettering (Свойства 
объекта – Текст). Подробнее см. в разделе 
Создание текстового объекта в 
диалоговом окне Object Properties.  
2 Введите текст для линии по верхней части  
окружности в окно ввода текста. 

 

 3 Нажмите Enter. 
 

 
 
 
 

 
4 Для следующей строки введите текст для 

средней базовой линии в середине 
окружности и нажмите Enter. 

5 Для следующей строки введите текст для 
базовой линии по нижней дуге окружности. 

6  Выберите значок Predefined.  
7  Нажмите кнопку Apply. 
8  Щелкните по экрану в том месте, в которое 

вы хотите вставить центр окружности.. 
 

 
9  Наметьте точку на контуре окружности, чтобы 

определить радиус. 

 
 
10 Нажмите Enter для завершения установки 

окружности или щелкните мышью еще раз, 
чтобы преобразовать окружность в овал.  

 
 

Создание пользовательских базовых 
линий 
 

Щелкните правой кнопкой мыши по значку 
Lettering (панель Digitize) и настройте 
установки базовой линии. 
 

Используйте значок Any Shape (закладка 
Lettering), чтобы подогнать форму текста к 
элементам проекта. 

 
Используйте базовые линии Any Shape (Любая 
форма), чтобы подогнать форму текста к 
элементам вашего проекта. Создайте базовые 
линии типа Any Shape путем отметки базовых 
точек, которые определят форму нужной вам 
базовой линии. Число базовых точек и длина 
базовой линии практически не ограничены. 
     

 
Если базовая линия слегка искривлена или 
имеет острые углы, буквы могут накладываться 
друг на друга. Для получения наилучших 
результатов намечайте точки кривой и 
создавайте линии, которые имеют пологие, 
плавные кривые. 
 
Как создавать пользовательские 
базовые линии 
1 Щелкните правой кнопкой мыши по значку 

Lettering (Текст), чтобы открыть диалоговое 
окно Object Properties - Lettering (Свойства 
объекта – Текст). Подробнее см. в разделе 
Создание текстового объекта в 
диалоговом окне Object Properties. 
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2 Введите текст в окно ввода текста. 

Подробнее см. в разделе Создание 
текстового объекта в диалоговом окне 
Object Properties. 

3 Выберите значок Any Shape (Любая форма) и 
нажмите кнопку Apply. В строке состояния 
будут появляться подсказки. 

4 Щелкайте по экрану, чтобы наметить 
опорные точки базовой линии. 
◄ Намечайте точки кривой правой кнопкой 

мыши. 
◄ Намечайте угловые точки левой 

кнопкой мыши. 
  

  

 
 
 
 
 
5 Нажмите Enter для завершения. 

 

Форматирование текста 
 
Вы можете преобразовывать внешний вид 
текста, изменяя настройки формата в 
диалоговом окне Object Properties – Lettering. 
Изменяйте текущие настройки формата до или 
после добавления текста таким же образом, как 
и для других объектов. 
 
Придание буквам курсивного 
начертания 
 

Щелкните правой кнопкой по значку 
Lettering (панель Digitize) для настройки 
наклона букв. 

 
Вы можете наклонять буквы влево или вправо 
для создания эффекта курсивного шрифта. По 
умолчанию наклон равен 0°, что соответствует 
прямому шрифту. Максимальный наклон букв 
45°. 
 

Как придать буквам курсивное 
начертание 
1  Щелкните правой кнопкой мыши по значку 

Lettering или дважды щелкните по 
выбранному текстовому объекту. 
 

 
 Откроется диалоговое окно Object Properties - 

Lettering (Свойства объекта - Текст). 

 
 

2 Введите угол в поле Italic (Курсив). 
 Вы можете ввести любой угол наклона в 
пределах от 45° до -45°. 
 

3 Нажмите кнопку Apply. Выбранная 
настройка применима к любому выделенному 
текстовому объекту или вновь созданным 
текстовым объектам. 

 
                   угол наклона 0° 

 
      
 
 

  угол наклона - 45° 

  
угол наклона 45° 

 

Придание буквам полужирного 
начертания 
 

Щелкните правой кнопкой по значку 
Lettering (панель Digitize) для настройки 
полужирного начертания. 

 
Вы можете создать эффект полужирного 
начертания букв путем увеличения установок 
компенсации стягивания для выбранных 
текстовых объектов.  
 
Как придать буквам полужирное 
начертание 
1  Щелкните правой кнопкой мыши по значку 

Lettering или дважды щелкните по 
выбранному текстовому объекту. 
Откроется диалоговое окно Object Properties - 
Lettering (Свойства объекта - Текст). 

2 Нажмите кнопку Effects.   

Выбор угла 
наклона букв 
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Откроется диалоговое окно Effects (Эффекты). 

 
Увеличьте компенсацию стягивания 

3 Выберите закладку Others (Другие). 
4  Проставьте флажок в окошке Pull 

Compensation (Компенсация ткани) и 
увеличьте значение компенсации стягивания  
до 0.4 - 0.6 мм. 

 Величина компенсации стягивания не должна 
превышать 0,6 мм, иначе буквы могут быть 
искажены. 

5 Нажмите кнопку Apply. 

Выбранная настройка применима к любому 
выделенному текстовому объекту или вновь 
созданным текстовым объектам. 
                     

Компенсация стягивания  Компенсация  
      0,2 мм                                         стягивания 0,6 мм 
 

Выравнивание текста 
Щелкните правой кнопкой по значку 
Lettering (панель Digitize) для настройки 
выравнивания текста. 

 
Функция выравнивания позволяет выравнивать 
текст на базовой линии. Вы можете выравнивать 
текст по левому или правому краю, по центру 
или по ширине. При выравнивании по ширине 
текст растягивается по всей длине базовой 
линии. 
 

Как выравнивать текст 
1 Щелкните правой кнопкой мыши по значку 

Lettering или дважды щелкните по 
выбранному текстовому объекту. 

 Откроется диалоговое окно Object Properties - 
Lettering (Свойства объекта - Текст). 
 

 

2 Выберите способ выравнивания – Left (По 
левому краю), Center (По центру), Right (По 
правому краю) или Justified (По ширине). 

 
 

3 Нажмите кнопку Apply. 
Выбранная настройка применима к любому 
выделенному текстовому объекту или вновь 
созданным текстовым объектам. 
 

Подгонка интервала между 
буквами 
 
Интервалы между буквами, словами и строчками 
могут быть определены до или после создания 
текстовых объектов и размещения их в вашем 
проекте. Вы можете изменять интервалы 
непосредственно на экране или в диалоговом 
режиме. Интервалы между буквами 
рассчитываются автоматически в соответствии 
выбранным видом выравнивания – по левому 
или правому краю, по центру или ширине. См. 
также раздел Выравнивание текста. 
 

 

Подгонка на экране интервалов 
между буквами по всему тексту  
 

Щелкните по значку Reshape Object 
(панель Edit), чтобы изменить 
интервал между буквами. 
 

 
Интервал между буквами рассчитывается 
автоматически в виде процентного отношения к 
высоте букв. В большинстве случае 
предлагаемый по умолчанию интервал является 
вполне приемлемым. Однако иногда вам может 
потребоваться изменить интервал между 
буквами по всему тексту. 
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Как подогнать на экране интервалы 
между буквами по всему тексту  
1  Выберите текстовый объект и нажмите 
кнопку Reshape Object (Изменение формы 
объекта). 
2 Перетащите контрольную точку интервала 

между буквами, чтобы подогнать интервал 
между всеми буквами вдоль базовой линии.  

 Перетащите контрольную точку интервала между 
буквами 

 

3 Отпустите кнопку мыши для завершения и 
нажмите Esc.  

     
 
 
 

Совет: Если принято выравнивание текста по 
ширине, буквы равномерно распределяются по 
бузовой линии. В этом случае для изменения 
интервала между буквами просто измените 
длину базовой линии. 
 

Подгонка на экране индивидуальных 
интервалов между буквами  
 

Щелкните по значку Reshape Object 
(панель Edit), чтобы изменить 
индивидуальный интервал между 
буквами. 

 
Интервал между буквами рассчитывается 
автоматически в виде процентного отношения к 
высоте букв. В большинстве случае 
предлагаемый по умолчанию интервал является 
вполне приемлемым. Однако иногда интервал 
между отдельными буквами может показаться 
слишком большим или слишком малым в 
зависимости от формы соседних букв. Для 
компенсации этого визуального эффекта вы 
можете переместить одну или нескольких 
выбранных букв вдоль базовой линии, чтобы 
изменить интервал.  

 
Как подогнать на экране 
индивидуальные интервалы между 
буквами  
1 Выберите текстовый объект и нажмите кнопку 
Reshape Object (Изменение формы объекта). 

              
Перетащите ромбовидную контрольную точку 

2 Щелкните по ромбовидной контрольной точке 
в середине буквы. 
 
 Совет: Для выбора нескольких букв  
     удерживайте нажатой клавишу Ctrl. 
 

3 Перетащите букву или буквы вдоль базовой 
линии для подгонки интервала между 
буквами. Щелкните по значку Reshape Object 
(панель Design), чтобы изменить 
индивидуальный интервал между буквами. 

      
Совет: Альтернативно для перемещения 
нескольких букв щелкните правой кнопкой по 
ромбовидной контрольной точке первой буквы и 
перетащите ее. Все буквы до конца строки 
перемещаются одновременно. 
 

4 Отпустите кнопку мыши для завершения и 
нажмите Esc. 
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Подгонка интервала между строками 
на экране 

 
 Щелкните по значку Reshape Object 
(панель Edit), чтобы изменить 
интервал между строками. 
 

 
Для изменения интервала между строками в 
многострочных текстовых объектах используйте 
инструмент Reshape (Изменение формы). 
 

Как подогнать интервал между строками 
на экране 
 

1 Выберите текстовый объект и нажмите 
кнопку Reshape Object (Изменение 
формы объекта) 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 

 
                 
 
 
 
 
 
 
 
 

 

 

 

 

            

  

 

 
2 Перетащите вверх или вниз контрольную 
точку интервала между строками. 
 

 
 
 

Для увеличения интервала  
между строками перетащите  
контрольную точку вниз 
 

3 Отпустите кнопку мыши для завершения и 
нажмите Esc. 
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ГЛАВА 26 

 

 
ПРАВКА ВЫШИВАЕМЫХ ТЕКСТОВ 

------------------------------------------- 
 
BERNINA Embroidery Software предоставляет 
возможность как диалогового, так и точного 
цифрового управления многими атрибутами, 
воздействующими на текстовые объекты. Вы 
можете настраивать текстовые объекты как в 
целом, так и по отдельным буквам. 
Текст можно изменять непосредственно на экране 
или через свойства объекта. Вначале при 
создании текста он может быть слишком большим 
или слишком малым. Размер можно изменять в 
диалоговом режиме или вводом соответствующих 
цифр. Для мелких, узких букв стабилизирующие стежки могут не потребоваться, в 
зависимости от размеров букв и вида материала, на которых они будут вышиты. 
Используйте соответствующие инструменты, чтобы изменять угол наклона и 
поворачивать текстовые объекты. Отдельные буквы настраиваются так же, как и 
другие объекты вышивки. Изменение формы текста, настройка угла наклона 
стежков и изменение цвета производятся индивидуально. Базовые линии могут 
быть назначены после размещения текста непосредственно на экране или через 
свойства объекта. 
 
В этой главе описывается, как редактировать текстовые объекты. Поясняется так 
же, как изменять размер текста и удалять стабилизирующие стежки из небольших 
букв. Кроме того, рассматриваются способы трансформирования текстовых 
объектов и изменения формы базовых линий. 

 

Редактирование текстовых 
объектов 
 
Если вы создали текстовый объект, вы можете 
выделить его и изменять непосредственно на 
экране, через панель инструментов или через 
диалоговое окно Object Properties – Lettering. 
 

Редактирование текстового объекта 
на экране 

 
Используйте инструмент Lettering 
(панель Digitize) для редактирования 
текста на экране. 

 
Наиболее простым способом редактирования 
текста является внесение изменений 
непосредственно на экране. 
 

 
Как редактировать текстовый объект на 
экране 
1 Щелкните на кнопку Lettering, затем щелкните 

внутри текстового объекта.  
 При этом появится балочный (I-образный) 

указатель. 
      

щелкните здесь для редактирования 
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2 Отредактируйте текст, как вам требуется. 
    

 
 
 
 
 

буква удалена 
 

Совет: Для начала новой строки нажмите 
Shift + Enter. 

3 Нажмите Enter для завершения. 
 

      
 
Редактирование текстовых объектов 
в диалоговом окне Lettering  
Если вы создали текстовый объект, вы можете 
выделить его и изменять в диалоговом окне 
Object Properties – Lettering. 
 

Как редактировать текстовые объекты в 
диалоговом окне Object Properties  
1  Щелкните правой кнопкой мыши по значку 

Lettering или дважды щелкните по 
выбранному текстовому объекту. 

 Откроется диалоговое окно Object Properties - 
Lettering (Свойства объекта - Текст). 

 
 

2 Отредактируйте текст в окне ввода текста. 
 

 

3 При необходимости выполните любые другие 
изменения. 
 Подробнее см. в разделе  
     Форматирование текста. 
4 Нажмите кнопку Apply.  
           

 
Примечание: Буквы заполняются стежками в 
соответствии с текущими установками на 
закладке Fill Stitch (Заполняющий стежок) 
диалогового окна Object Properties – Lettering. Вы 
можете изменить их в любое время. Подробнее 
см. в разделе  Применение различных типов 
стежков и эффектов в текстах. 

 

Изменение размеров текста 
 
Вначале при создании текста он может быть 
слишком большим или слишком малым. Размер 
текстового объекта может быть изменен одним 
из следующих трех способов: 
◄ изменением размеров на экране 

инструментом Select Object (Выбор объекта) 
или Reshape Object (Изменение формы 
объекта). 

◄ подгонкой ширины и высоты объекта на 
закладке Lettering 

◄ подгонкой ширины и высоты объекта на 
закладке General 

 

Изменение размеров текста 
инструментом Select Object 
 

Для изменения размеров текстового 
объекта на экране используйте 
инструмент Select Object (панель Edit). 

 
Вы можете изменять размер текстового объекта 
по вертикали, по горизонтали или 
пропорционально, используя инструмент Select 
Object (Выбор объекта). См. также раздел 
Преобразование текста инструментом 
Select Object. 

 Правка 
текста

Настройка 
параметров:
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Как изменять размеры текста 
инструментом Select Object 
1  Щелкните по значку Select Object и 
выберите текстовый объект. 
 
  Изменение размера по вертикали 
      

      

    
Пропорциональное 
изменение размера  

      

          
Изменение размера по горизонтали 
 

 

2 Перетащите мышью одну из квадратных 
контрольных точек, чтобы изменить объект 
по горизонтали, по вертикали или 
пропорционально. 

 
 

 

 

 

 

 
 При перетаскивании теневым контуром будет 

показан новый размер текстового объекта. 
3 Для завершения отпустите кнопку мыши. 
 

Изменение размеров текста 
инструментом Reshape Object 

 
 Для изменения размеров текстового 
объекта на экране используйте 
инструмент Reshape Object (панель 
Edit). 

 
Вы можете изменять размер текстового объекта 
по вертикали, по горизонтали или 
пропорционально, используя инструмент 
Reshape Object (Изменение формы объекта). 
См. также раздел Вращение текста 
инструментом Reshape Object. 
 
Как изменять размеры текста 
инструментом Reshape Object 
1  Выберите текстовый объект и щелкните по 

значку Reshape Object, чтобы отобразить на 
экране контрольные точки. 
 

 

2 Перетащите мышью одну из темных 
треугольных контрольных точек, чтобы 
изменить объект по горизонтали, по 
вертикали или пропорционально. 

перетащить 
 

 

 

 

 

 

 

 

перетащить 
 

 

 

 
 
 
 
3 Для завершения отпустите кнопку мыши. 

 
 

 
 
 
 
 
 
 
 
 
 
Подгонка текста по высоте и ширине 

 
Используйте инструмент Lettering 
(панель Digitize) для подгонки текста по 
высоте и ширине. 

 
 

Вы можете изменять ваши текстовые объекты по 
вертикали, по горизонтали или пропорционально 
с помощью закладки Lettering (Текст) 
диалогового окна Object Properties – Lettering.  
 

Совет: Изменяйте внешний вид букв путем 
изменения их ширины по отношению к высоте. 
Оригинальное соотношение равно 100 %. 

Перетащить

изменение  
размера по  
вертикали 

пропорциональное  
изменение размера 

Перетащить

Перетащить

изменение размера  
по горизонтали 

изменение  
размера по  
вертикали 

пропорциональное  
изменение размера 

изменение размера  
по горизонтали 
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Как подгонять текст по высоте и ширине 
1  Щелкните правой кнопкой мыши по значку 

Lettering или дважды щелкните по 
выбранному текстовому объекту. 

 Откроется диалоговое окно Object Properties - 
Lettering (Свойства объекта - Текст). 

 

 
Выбор 
высоты  
букв в мм 
 
Выбор 
ширины  
в процентах 
 

 

 

 

2 В поле Height (Высота) введите высоту 
текстового объекта в миллиметрах.  

 

Примечание: Высоту букв следует выбирать в 
пределах от 1 до 200 мм. Подробнее см. в 
разделе Примеры алфавитов. 
3 Введите ширину текстового объекта в поле 

Width (Ширина) в виде процентного 
отношения к высоте.  

4 Нажмите кнопку Apply. 
 Выбранная настройка применима к любым 

выделенным текстовым объектам или вновь 
созданным текстовым объектам. 

 
ширина 100 %     ширина 70 % 

          
    ширина 140 % 

Подгонка размеров текста 
 
Используйте значок Lettering (панель 
Digitzie) для настройки размеров текста. 

 
Вы можете изменять ваши текстовые объекты по 
вертикали, по горизонтали или пропорционально 
с помощью закладки General диалогового окна 
Object Properties – Lettering.  
 

Совет: Изменяйте внешний вид букв путем 
изменения их ширины по отношению к высоте. 
Оригинальное соотношение равно 100 %. 
 

Как подгонять размеры текста 
1 Щелкните правой кнопкой мыши по значку 

Lettering или дважды щелкните по 
выбранному текстовому объекту. 

 Откроется диалоговое окно Object Properties - 
Lettering (Свойства объекта - Текст). 

2 Выберите закладку General. 
 Откроется диалоговое окно Object Properties - 

Lettering > General. 
 
Подгонка 
ширины  
и высоты 
текста 
 

 

 

3 Подберите ширину и высоту текста в 
абсолютных (мм) или относительных 
значениях (%). 

4 Нажмите кнопку Apply. 
   

 
оригинал       высота 140 % 

 
                ширина 140 % 
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Отключение функции 
автоматической стабилизации 
ткани для мелких букв 

 
Используйте инструмент Auto Underlay 
(панель General) для упрочнения и 
стабилизации проектов вышивки 
автоматически выполняемыми 

стабилизирующими стежками. 
 
 

Качество большинства букв может быть 
улучшено при использовании стабилизирующих 
стежков таким же образом, как и для других 
вышиваемых объектов. Для мелких, узких букв 
стабилизирующие стежки могут не 
потребоваться, в зависимости от размеров букв 
и вида материала, на которых они будут 
вышиты. См. также Упрочнение и 
стабилизация ткани стабилизирующими 
стежками. 
 

Как отключить функцию автоматической 
стабилизации ткани для мелких букв 
1 Выберите текстовый объект. 
2 Нажмите кнопку Auto Underlay 

(Автоматическая стабилизация ткани). 
 Функция стабилизации ткани будет 

отключена. 
 

 

 

 

Преобразование текстовых 
объектов 
 

Помимо масштабирования, вы можете 
использовать инструменты Select Object (Выбор 
объекта) и Reshape Object (Изменение формы 
объекта),  чтобы наклонять и поворачивать 
текстовые объекты. См. также Изменение 
размеров текста. 
 

 
 

 
Преобразование текста 
инструментом Select Object 
 

Используйте инструмент Select Object 
(панель Edit) для преобразования 
текстового объекта на экране 
 

Вы можете преобразовывать текстовые объекты 
путем манипулирования контрольными точками 
на экране с использованием инструмента Select 
Object (Выбор объекта). См. также раздел 
Изменение размеров текста инструментом 
Select Object. 
 
Как преобразовывать текст 
инструментом Select Object 
1 Щелкните по значку Select Object и выберите 

текстовый объект.  
 Появятся метки - маркеры выделения, 

позволяющие изменять размеры объекта. 
Подробнее см. в разделе Изменение 
размеров текста инструментом Select 
Object. 

2 Щелкните по текстовому объекту еще раз. 
 Появится другой комплект маркеров 

выделения. Эти точки позволяют 
поворачивать и наклонять текстовый объект.  

   
              Маркер наклона 
              

    

 

 

 
Маркер 
вращения  
 

 

 
Точка вращения  

3 Перетащите один из ромбовидных маркеров, 
чтобы придать текстовому объекту наклон. 

 
Перетащить 
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4 Перетащите один из маркеров в виде 
светлого квадрата, чтобы повернуть 
текстовый объект.  

 

Перетащить 
 

 

 
Точка центра 
вращения  

  
 

  

Совет: Перетащите точку центра вращения в 
новое положение перед вращением объекта. 

       
новая точка центра вращения  

 

5 Для завершения отпустите кнопку мыши. 
 

Вращение текста инструментом 
Reshape Object 
 

Для вращения текстового объекта на 
экране используйте инструмент 
Reshape Object (панель Edit). 
 

Вы можете вращать текстовые объекты путем 
манипулирования контрольными точками на 
экране с использованием инструмента Reshape 
Object (Изменение формы объекта). См. также 
раздел Изменение размеров текста 
инструментом Select Object. 
 

Как вращать текст инструментом 
Reshape Object 

1 Выберите текстовый объект и нажмите кнопку 
Reshape Object (Изменение формы 
объекта). 
 

 
 Вокруг текстового объекта появятся маркеры 
выделения. 
     

маркеры вращения базовой линии 
 

2 Перетащите один из маркеров в виде 
светлого квадрата на базовой линии, чтобы 
повернуть текстовый объект. 

 
 

 

 

 

 
                                                             Перетащите 
3 Для завершения отпустите кнопку мыши и 

нажмите на ESC. 

         
 

Установка положения 
отдельных букв 
 
Инструмент Reshape Object, также как и 
функции масштабирования и вращения 
букв, используется для работы с 
отдельными буквами. Вы можете изменять 
положение букв относительно друг-друга, 
менять их размеры, поворачивать, 
наклонять их. Можно изменить форму 
отдельных букв, изменить углы стежков, 
изменить цвет отдельных букв. 
 

 
.
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Перемещение букв на экране 
 

С помощью функции  Reshape Object 
(на панели редактирования) можно 
менять положение отдельных букв на 
экране. 

 
 
С помощью инструмента  Reshape Object 
можно менять положение отдельных букв 
текстового объекта. 
 
Чтобы поменять положение буквы на 
экране 
1 Выберите текстовый объект. 
2 Нажмите Reshape Object. 
3 Нажмите на контрольную точку в виде 
ромбика в центре буквы. 
 

 
 
Подсказка: если вам надо выбрать не одну, 
а несколько букв (или ряд букв подряд), 
удерживайте при выборе букв нажатыми 
клавиши Ctrl или Shift. 
4 Захватите мышкой и перетащите 
выбранную букву на ее новое положение: 
• Для горизонтального перемещения 

тяните букву вдоль базовой линии. 
• Для вертикального перемещения 

удерживайте нажатой клавишу Shift. 
 

 
• Для свободного перемещения буквы, 

удерживайте нажатой клавишу Ctrl. 
 

 
5 Когда перемещение закончено, отпустите 
клавишу мыши и нажмите Esc. 
 

 
 
Преобразование букв на экране 
 

С помощью функции  Reshape Object 
(на панели редактирования) можно 
менять вид отдельных букв на экране. 
 

 
С помощью инструмента  Reshape Object 
можно менять вид отдельных букв, 
манипулируя управляющими точками. 
. 
 
Чтобы изменить форму буквы на экране 
1 Выберите текстовый объект. 
2 Нажмите Reshape Object. 
На экране отобразятся управляющие точки. 
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3 Нажмите на контрольную точку в виде 
ромбика в центре буквы. Вокруг буквы 
отобразится целый набор управляющих 
узлов для изменения ее формы. 
 

 
4 Захватите узел мышью и перетяните его в 
нужную позицию для изменения формы 
буквы. 

 
 
5 По завершении работы нажмите Esc. 
 

 
 
 
Изменение формы букв на экране 
 

Для преобразования отдельных букв на 
экране используйте инструмент Reshape 
Object (панель Edit). 
 

Изменением формы контуров букв инструментом 
Reshape Object (Изменение формы объекта) 
можно получать специфические эффекты.  

 
Как изменять форму букв на экране 
1 Выберите текстовый объект и нажмите кнопку 

Reshape Object (Изменение формы 
объекта). 

 Вокруг текстового объекта появятся маркеры 
выделения. 

 
                                          Щелкните по контуру буквы 

 
2 Щелкните по контуру буквы. Вокруг нее 

появятся маркеры изменения формы.  
  
  

 
 
 
 
 
 
 
 
  
 

Совет: Увеличьте изображение буквы для 
более точного изменения формы. 
Подробнее см. в разделе Увеличение и 
уменьшение изображения. 

 
3  Измените форму буквы путем добавления, 

удаления, изменения или перемещения 
маркеры изменения формы. Подробнее см. в 
разделе Изменение формы объектов с 
использованием узлов изменения формы. 
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4  Переключитесь в режим Artistic View, чтобы 
увидеть результат. 

 
 
Регулировка углов наклона стежков 
индивидуальных букв 

 
Используйте инструмент Add Stitch 
Angles (панель Stitch and Color), чтобы 
настроить различные углы наклона  

                  стежков для выбранных букв. 
 
Установите различные углы наклона стежков в 
буквах, используя инструмент Stitch Angle. 
Каждый сегмент буквы может иметь различные 
углы наклона стежков. 
 

Как отрегулировать углы наклона 
стежков индивидуальных букв 
1 Выберите текстовый объект. 
2 Щелкните по значку Stitch Angles. 
 Вам будет предложено ввести точку угла 

наклона 1 (angle point 1). 
 

 

3 Назначьте такие углы наклона, чтобы стежки 
пересекали две стороны объекта. 

     
 
 Примечание: Убедитесь в том, что углы 

наклона стежков не пересекают друг друга. 
4 Нажмите Enter. 
 Стежки будут пересчитаны с новыми углами 

наклона. 
 

Удаление углов наклона стежков в 
буквах 
 

Используйте инструмент Reshape 
Object (панель Edit) для удаления 
индивидуальных углов наклона 
стежков в текстовых объектах. 

 
Удаляйте индивидуальные углы наклона стежков 
в текстовых объектах инструментом Reshape 
Object (Изменение формы объекта). 
 

Как удалять углы наклона стежков в 
буквах 
1 Выберите текстовый объект и нажмите кнопку 

Reshape Object (Изменение формы 
объекта). 

2 Щелкните по ромбовидной контрольной точке 
в середине буквы, чтобы выделить ее. 

3 Затем щелкните по контуру буквы. Появятся 
контрольные точки.  
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4 Выберите и удалите контрольные точки, как 
вам требуется. 

    
 Примечание: Контуры букв сохраняются 

после любого удаления угла наклона. 
 

 
 
Изменение цвета букв 

 
Используйте инструмент Lettering 
(панель Digitize) для изменения цвета 
букв. 
 

 
BERNINA Embroidery Software  позволяет 
изменять цвет отдельных букв в пределах 
текстового объекта. Совет: Вы можете также 
вставить изменение цвета между двумя буквами, 
поместив символ знака вставки (^). 
Последующие буквы по умолчанию примут 
следующий цвет из последовательности 
палитры. Подробнее см. в разделе Создание 
текстовых объектов в диалоговом окне 
Lettering.  
 

Как изменять цвет букв на экране 
1 Щелкните по кнопке Lettering, затем щелкните 

внутри текстового объекта.  
     Указатель мыши преобразуется в I-образный 

курсор.  

    
I-образный указатель  

 

 

 

2  Выделите букву/буквы перетаскиванием 
указателя по букве/буквам. 

 

 
выделенная буква 
 

3 Щелкните по цвету в цветовой палитре. 
4 Нажмите Enter. 

 
Изменение базовых линий текста 

 
Используйте инструмент Reshape 
Object (панель Edit) для изменения 
базовых линий текста. 
 

Базовые линии можно изменять на экране после 
размещения их в проекте инструментом Reshape 
Object (Изменение формы объекта).  Изменяйте 
форму прямой базовой линии, чтобы 
расположить ее под углом. Для вертикальной 
базовой линии вы можете также изменить ее 
длину и интервал между буквами. Изменяйте 
форму окружности и базовой линии, чтобы 
изменить глубину кривой, точки выравнивания и 
длину базовой линии. Изменяйте базовые линии 
типа Any Shape путем перемещения, добавления 
или удаления контрольных точек вдоль базовой 
линии.  См. также Применение базовых линий 
текста  
 

Как изменять форму базовой линии  
 
• Выберите текстовый объект и нажмите 

кнопку Reshape Object (Изменение формы 
объекта). 
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 На экране появятся контрольные точки для 

разных типов базовой линии. 
 
 

 

 

 

 

контрольные точки базовой линии 
 

 
 Совет: Крупные ромб и крестик 

соответствуют началу и концу 
последовательности вышивания. Вам может 
потребоваться переместить их, чтобы 
совместить к контрольными точками базовой 
линии. Их можно переместить в новое 
положение входа и выхода согласно 
выполненными вами изменениями базовой 
линии. 

 
• Для изменения угла наклона прямой 

горизонтальной или вертикальной базовой 
линии перетащите мышью крупный черный 
квадратик. 

Перетащите 
вверх или вниз  
для изменения 
угла базовой 
линии. 
 

 

• Для увеличения или уменьшения длины 
базовой линии перетащите мышью 
треугольную контрольную точку. Интервал 
между буквами будет подогнан к новой 
длине строчки. 

 

Перетащите треугольник для изменения интервала 
между буквами. 
 

• Для изменения формы строки с кривой 
базовой линией перетащите контрольную 
точку в центре окружности, чтобы увеличить 
радиус. 

 
 
 Перетащите вверх или вниз  
для изменения радиуса кривой 
 

• На базовой линии по окружности имеются 
две фактические контрольные точки на 
периметре окружности, одна находится над 
другой. Оттащите одну точку от другой, 
чтобы создать дуговую базовую линию. 

      
Перетащите влево или вправо, чтобы 

превратить окружность в дуговую базовую линию 
   

 
• Чтобы равномерно распределить интервалы 

между буквами по дуговой базовой линии 
перетащите треугольник. 

             

 
Перетащите треугольник для изменения  

              интервала между буквами. 
 

 Совет: Точное положение букв зависит от 
вида выравнивания – по левому краю, по 
центру, по правому краю или по ширине. 
Если базовая линия становится слишком 
короткой, интервал между буквами 
сокращается, и буквы могут заходить друг за 
друга. См. также Выравнивание текста.  
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◄ Чтобы подогнать базовые линии 

произвольной формы типа Any Shape, 
добавьте, удалите или переместите 
опорные точки, как это делается с любым 
объектом вышивания. Подробнее см. в 
разделе Изменение формы объектов. 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

                    
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 Нажмите ESC для завершения. 

Щелкните по базовой линии, чтобы 
изогнуть, затем перетащите контрольную 
точку вверх или вниз. 

Щелкните правой кнопкой, 
чтобы плавно изогнуть базовую 
линию 



Глава 27: Специальные текстовые эффекты 

BERNINA® Embroidery Software Версия 6 317

 
ГЛАВА 27 

 

 
СПЕЦИАЛЬНЫЕ ТЕКСТОВЫЕ 

ЭФФЕКТЫ 
------------------------------------------- 

 
 
 

Все шрифты TrueType, установленные в вашем 
компьютере, также могут быть использованы для 
вышивания текста в вашем проекте. BERNINA Embroidery 
Software позволяет добавлять к тексту специальные 
символы, которых нет на клавиатуре. BERNINA Embroidery 
Software также предоставляет несколько специальных 
алфавитов с орнаментными буквами, а также буквами для 
монограмм. Как и все объекты вышивания, каждый 
текстовый объект имеет свои собственные свойства. Вы можете настраивать их до 
или после создания текстового объекта. BERNINA Embroidery Software, кроме того, 
дает возможность точно контролировать углы стежков отдельных букв. Применяйте 
функцию Elastic Lettering (Гибкий текстовый объект) к текстовым объектам, чтобы 
сделать текст выпуклым или дугообразным, растянутым или сжатым. В этой главе 
описывается порядок конвертирования шрифтов TrueType в вышивальные 
шрифты. Кроме того, объясняется, как добавлять в ваши проекты специальные 
символы, а также орнаментальные буквы и монограммы. Поясняется также, как 
применять различные типы стежков к тестовым объектам т как создавать 
специальные эффекты функцией Elastic Lettering.  

 

Конвертирование шрифтов в 
алфавиты 
В дополнение к профессиональным  
алфавитам, поставляемым в составе 
программного обеспечения, программа 
BERNINA Embroidery Software 
предоставляет разнообразные технические 
возможности для конвертирования любых 
шрифтов типаTrueType и OpenType для 
работы с вашей вышивальной системой. 
 

 

 
Преобразование текста в вышивку  

 
С помощью функции Art Toolbox > 
Convert Text to Embroidery можно 
преобразовать текстовые объекты в  

             буквы гладьевой вышивки с  
             поворачивающимися стежками. 
 
Инструмент Convert Text to Embroidery 
преобразует текстовые объекты программы 
CorelDRAW® в: 
• буквы гладьевой вышивки с 

поворачивающимися стежками, если 
текст не сгруппирован и не имеет 
внешнего контура, или 

• объекты вышивки, не являющиеся 
буквами, если текст сгруппирован и 
имеет внешний контур. 
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Чтобы преобразовать текст в 
вышивку 
1 Войдите в режим Art Canvas. 
 

 
2 Выберите один или несколько текстовых 
объектов и нажмите кнопку инструмента 
Convert Text to Embroidery. Программа 
BERNINA Embroidery Software 
автоматически переходит в режим 
Embroidery Canvas. Исходные объекты 
удаляются из образца. 
 

 
 
После преобразования объекта в 
вышивальный алфавит, вы можете 
использовать любые виды шрифтов. 

 
 
Подсказка: можно использовать 
инструмент Convert Text to 
Embroidery и в применении к обычным 
объектам векторной графики. Результат 
будет несколько другим, чем при 
использовании инструмента Convert 
to Embroidery. 

 

Конвертирование шрифтов в 
вышивальные шрифты 

 Используйте инструмент Lettering 
(панель Digitize) для конвертирования 
шрифтов TrueType в вышивальные 
шрифты. Щелкните правой кнопкой  

                   мыши для выбора опций текста.  
 
Операционная система Windows поставляется с 
коллекцией шрифтов TrueType и OpenType и 
другие шрифты устанавливаются с различными 
прикладными программами включая CorelDRAW 
Essentials 4. Все эти шрифты доступны для 
размещения в текстовых объектах вашего 
проекта. 
Для установки новые шрифтов откройте Control 
Panel (Панель управления).  Дважды щелкните 
по папке Fonts (Шрифты), затем выберите File 
(Файл) > Install New Font (Установить новый 
шрифт). Прежде чем вы сможете использовать 
новый шрифт, вам нужно перезагрузить 
компьютер, и BERNINA Embroidery Software 
отобразит новый шрифт в списке Alphabet. 
 
Как конвертировать шрифты в 
вышивальные шрифты 
1 Щелкните правой кнопкой мыши по значку 

Lettering (Текст). 
 
 Откроется закладка Lettering диалогового 

окна Object Properties (Свойства объекта). 
 
 

 
 
Выберите один  
из шрифтов TrueType  
 
2 Выберите из списка Alphabet один из 

шрифтов TrueType. 
 В этом списке перечислены все шрифты 

TrueType, установленные в вашем 
компьютере. 

3 В окно ввода текста введите текст, который 
вы хотите вышить. 
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4 Нажмите кнопку Apply. 
5 Щелкните по экрану в том месте, в которое 

вы хотите вставить буквы. 
 Текст будет вышит с использованием 

выбранного шрифта. 
 
 
 
 
 

 Примечание: Не все шрифты TrueType 
пригодны для включения в проекты 
вышивания. Поэкспериментируйте с 
понравившимся вам шрифтом и различными 
настройками стежка. 

 

Добавление специальных 
шрифтовых знаков  
 
В BERNINA Embroidery Software вы можете 
добавлять специальные шрифтовые знаки и 
символы, используя диалоговое окно Select 
Symbols (Выбрать символ) из таблицы шрифтов 
Windows. 
 
Выбор специальных шрифтовых 
знаков 

 
Используйте инструмент Lettering 
(панель Digitize) для добавления 
специальных шрифтовых знаков 

непосредственно на экране. Щелкните правой 
кнопкой мыши для выбора опций текста. 
 
Вы можете быстро 
добавлять 
специальные 
шрифтовые знаки к 
вашему текстовому 
объекту.  
Если вы знаете 
клавиатурную команду 
для символа, то 
вставьте этот символ в 
текст, выбрав соответствующую комбинацию 
клавиш на экране, или же в закладке Lettering. 
 
Как выбирать специальные шрифтовые 
знаки 
1 Щелкните правой кнопкой мыши по значку 

Lettering. 
 

 
 Откроется диалоговое окно Object Properties - 

Lettering (Свойства объекта - Текст). 

  Нажмите кнопку 
Select Character для выбора знака.  

 
Совет: Если вы знаете код  клавишей Alt для 
специального символа, вы можете 
непосредственно вставить этот символ в поле 
ввода. В таблице символов вы найдете коды для 
всех символов. Подробнее см. в разделе 
Использование таблицы символов. 
 
 
2 Нажмите кнопку Select Character 
 Откроется диалоговое окно Select Character. 
               
                              Выберите режим просмотра. 
 
 

Выбор 
алфавита 

 
 

Выбор 
символа 

 
 

Соответст-
вующая  

комбинация 
клавиш 

 
 
Совет: Выберите режим просмотра - вы сможете 
выбирать узоры по картинке, имени или по 
обоим признакам. 
 
3 Выберите алфавит или набор символов из 

списка Alphabet Set. 
4 Выберите символы, которые вы хотите 

использовать. 
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 Совет:  Если вы щелкните по символу, то 
буква появится в поле Selection. 
.    Эта буква или цифра обозначает комбинацию 

клавиш, требуемую для набора этого 
символа непосредственно на экране. 
Например, ‘m’ означает, что нужно нажать 
клавишу m, в то время как ‘M’ означает 
нажатие клавиш Shift + M. 

5 Нажмите кнопку ОК. 
 Выбранные символы появятся на панели 

ввода текста на закладке Lettering. 
6  Нажмите кнопку Apply. 

 
 
Использование таблицы символов 
Используйте Таблицу символов (Character Map) 
системы Windows для быстрого доступа к 
специальным символам и буквам. Таблица 
символов обычно входит в стандартный пакет 
системы Windows. Подробнее см. в 
документации по операционной системе 
Windows. 
 
Совет: Вы можете создавать специальные 
символы из любого алфавита, удерживая 
нажатой клавишу Alt на клавиатуре и набирая 0 
(ноль) и код символа на цифровой клавиатуре. 
Например, чтобы выбрать è с кодом 232, 
наберите Alt + 0232. Символ появится, как 
только вы отпустите клавишу Alt. В таблице 
символов вы найдете коды для всех символов. 
 
Как пользоваться таблицей символов 
1 Откройте Таблицу символов ОС Windows. 

 

 
 Эта таблица находится по адресу: кнопка  

Start (Пуск) > Programs (Программы) > 
Accessories (Стандартные) > System Tools  
(Служебные) > Character Map (Таблица 
символов). 

     
2 Дважды щелкните по символу или выберите 

его и нажмите кнопку Select (Выбрать). 
 Символ появится в поле Characters to copy 

(Копировать символы). 
 
Примечание: Эквивалентный код клавиши Alt 
показывается в нижней части диалогового окна. 
Этот код можно использовать для ввода 
символа непосредственно на экране. 
 
3 Нажмите кнопку Copy (Копировать), 

чтобы скопировать символ в буфер обмена.  
4 Вставьте его в панель ввода текста закладки 

Lettering. 
 Чтобы сделать это, нажмите Ctrl + V. 
5  Нажмите кнопку Apply. 
 Продолжайте создавать текстовый объект 
обычным способом. 

Код клавиши Alt
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Применение специальных 
алфавитов 
BERNINA Embroidery Software предлагает 
орнаментные алфавиты, такие как Creative Cross 
и Secret Garden. Используйте эти алфавиты, 
чтобы добавлять текстовые объекты к проекту, 
каждая буква вставляется в проект или 
используется как самостоятельный маленький 
проект. 
 
Добавление орнаментных букв 

 
Используйте значок Lettering (панель 
Digitize) для добавления орнаментных 
букв.. Щелкните правой кнопкой мыши 
для выбора опций текста. 

 
 
Алфавит Creative Cross  

 
 
 
             

Алфавит Secret Garden  
 
 
Примечание: При редактировании букв вам 
нужно удалить текущие свойства объекта. 
 
Как добавлять орнаментные буквы 
1 Щелкните правой кнопкой мыши по значку 

Lettering (Текст). 
 Откроется диалоговое окно Object Properties - 

Lettering (Свойства объекта - Текст). 
 
Выберите 
алфавит  
Creative 
Cross  
 
 
Щелкните 
для 
выбора 

орнаментных  
букв 

 
 
2 Выберите алфавит Creative Cross или Secret 

Garden из списка  Alphabet (Алфавит). 
 В окне просмотра появится образец буквы. 
3 Нажмите кнопку Select Character 

(Выбрать символ). 
 

 
 Откроется диалоговое окно Select Character. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Совет: Выберите режим просмотра - вы сможете 
выбирать буквы по картинке, номеру или по 
обоим признакам. 
4 Выберите символы, которые вы хотите 

использовать. 
Совет:  Если вы щелкните по символу, то в поле 
Selection появится комбинация клавиш. 
.    Эта буква или цифра обозначает комбинацию 

клавиш, требуемую для набора этого 
символа непосредственно на экране. 
Например, ‘m’ означает, что нужно нажать 
клавишу m, в то время как ‘M’ означает 
нажатие клавиш Shift + M. 

5 Нажмите кнопку OK. 
 Выбранные символы отобразятся в панели  
      ввода текста. 
6 Нажмите кнопку Apply. 

Выберите  
символ 

Соответствующее 
сочетание клавиш 

Выберите режим просмотра 
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 Совет: Для изменения цвета букв назначьте 

требуемый цвет. Подробнее см. в разделе 
 Подбор и выбор ниток. 

 
 
буквы и небольшой  
проект  

 
 
 
 
одни буквы 

 
 
 

 
только небольшой  
проект  

 

 

Создание монограмм 
 
В дополнение к специальной функции создания 
монограмм вышивальное ПО BERNINA 
Embroidery позволяет создавать проекты 
монограмм с использованием специальных 
монограммных алфавитов.   
 Используйте шрифт Diamond2 для создания 2-
буквнных монограмм и шрифт Diamond3 для 
создания 3-буквнных монограмм.  См. также 
 Создание монограмм 
 
Как создавать монограммы 
1 Щелкните правой кнопкой мыши по значку 

Lettering. 
 Откроется диалоговое окно Object Properties - 

Lettering (Свойства объекта - Текст). 

 
 
2 Выберите Diamond2 для 2-буквенных 

монограмм или Diamond3 для 3-буквенных 
монограмм. 
 

 
◄ Шрифт Diamond2 для двухбуквенных 

монограмм: 
Diamond2 является специальным алфавитом, 
включающим две версии каждой буквы для 
левой и правой позиции, плюс обрамление и 
росчерк для двухбуквенных проектов. 
Подробнее см. Diamond2. 

◄ Шрифт Diamond3 для трехбувенных 
монограмм:  
Diamond3 является специальным алфавитом, 
включающим три версии каждой буквы для 
левой, средней и правой позиции, плюс 
обрамление и росчерк для трехбуквенных 
проектов. Подробнее см. Diamond3. 

 
3 Щелкните по кнопке Select Character, 

чтобы выбрать буквы. 
 Откроется диалоговое окно Select Character 

(Выбор буквы). 
 
Совет: Выберите режим просмотра - вы сможете 
выбирать буквы по картинке, номеру или по  
обоим признакам. 
 

Выберите режим просмотра 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Совет:  Если вы щелкните по символу, то 
буква появится в поле Selection. 

.    Эта буква или цифра обозначает комбинацию 
клавиш, требуемую для набора этого 
символа непосредственно на экране. 
Например, ‘m’ означает, что нужно нажать 
клавишу m, в то время как ‘M’ означает 
нажатие клавиш Shift + M. 

4 Выберите левую букву, щелкнув по  
     изображению.

Выберите Diamond2  
или Diamond3 
 
 
 
 
 
Щелкните для выбора 
 орнаментых букв

Соответствующее 
сочетание клавиш 

Выберите 
символ
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 Совет: Прт выборе букв убедитесь в 

правильности ориентации буквы. Например, 
Diamond3 имеет 3 комплекта каждой буквы, 
одну для левой стороны, одну для середины 
и одну для правой стороны. 

5 Выберите среднюю букву, если используется 
шрифт Diamond3. 

6 Выберите правую букву.  
 

       
7 Выберите обрамление, если требуется. 
               

 
 
8 Нажмите кнопку ОК. 
 Выбранные символы отобразятся в панели 
ввода текста. 
9 Нажмите кнопку Apply. 
 

       
 Совет: Если вы хотите придать каждой букве 

монограммы различные стили, создавайте 
каждую букву отдельно. 

 

Применение различных типов 
стежков в текстовых объектах 
 
По умолчанию текстовые объекты заполняются 
стежками гладьевого валика. Вы можете также 
применять другие основные типы заполняющих  

 
стежков, такие как простегивающие или узорные, 
как и для остальных объектов вышивания. 
Подробнее см. в разделе Выбор 
оконтуривающих стежков. 
 

 
Настройка стежка гладьевого валика 
для текстового объекта 
По умолчанию текстовые объекты заполняются 
стежками гладьевого валика. При малой ширине 
буквы стежки располагаются плотно, поэтому 
требуется меньше стежков для покрытия ткани. 
Если колонка очень узкая, стежки должны быть 
менее плотными, поскольку слишком большое 
количество уколов иглой может повредить 
материал. 
Вы можете заполнять формы текста 
специальным гладьевым стежком (Special Satin), 
как и обычным стежком гладьевого валика. Этот 
стежок особенно подходит для заполнения 
крупных нерегулярных текстовых форм, которые 
слишком велики для гладьевого валика. См. 
также  Регулировка шага гладьевого 
заполняющего стежка 
 

 
 

Выбор 
обрамления 
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Как настроить стежок гладьевого валика 
для текстового объекта 
1 Дважды щелкните по выбранному текстовому 
объекту. 
 Откроется диалоговое окно Object Properties - 
Lettering (Свойства объекта - Текст). 
  
 
 
 
 
 
 
 
 
2 Выберите закладку Fill Stitch (Заполняющий 
стежок). 
3 Выберите режим установки шага стежка, 
который вы хотите применить к своему тексту. 
 См. также  Регулировка шага гладьевого 

заполняющего стежка и Применение 
автоматического интервала для 
оконтуривания гладьевым стежком.  

4 Если вы выбрали Manual настройте интервал 
сами. 
.5 Нажмите кнопку Apply. 

Автоматическая установка 
шага стежков 

 
 
 
 
 
 
 
 
 
 

Установка шага стежков 
 вручную. 

 
Примечание: Для длинных текстовых объектов 
существуют различные приемы управления 
длиной стежков. Подробнее см. в разделе 
Сохранение длинных стежков. См. также раздел 
Разбивка длинных стежков гладьевого 
заполнения. 

 
Настройка простегивающего стежка 
для текстового объекта 
Вы можете заполнять формы текстового объекта 
простегивающим стежком. Этот стежок особенно 
подходит для заполнения крупных объектов 
нерегулярной формы. 

      
Как настроить простегивающий стежок 
для текстового объекта 
1 Дважды щелкните по выбранному текстовому 

объекту. 
 Откроется диалоговое окно Object Properties - 

Lettering (Свойства объекта - Текст). 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
2 Выберите закладку Fill Stitch (Заполняющий 

стежок) и  Step (Простегивающий стежок) 
из списка Stitch Type (Тип стежка). 

 
3 Подгоните шаг стежков, чтобы увеличить или 

уменьшить их плотность. 
 Подробнее см. в разделе Регулировка шага 

простегивающего заполняющего стежка. 
 
4 Отрегулируйте длину стежка. 
 Подробнее см. в разделе Регулировка длины 

простегивающего заполняющего стежка. 
5  Выберите узор простегивающих стежков. 
 Подробнее см. в разделе Создание 

заполнения простегивающим стежком. 

Выберите закладку 
Fill Stitch 

Выберите режим 
установки шага 

стежков

Выберите закладку Fill 
Stitch 

Выберите Step

Настройка шага и 
длины стежков

Выберите узор
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6  Нажмите кнопку Apply.  

 

Настройка орнаментного стежка для 
текстового объекта 
Вы можете заполнять формы текста 
орнаментным стежком (Fancy), как и обычным 
стежком гладьевого валика. Этот стежок 
особенно подходит для заполнения крупных 
нерегулярных текстовых форм, которые 
слишком велики для гладьевого валика. 
Плотность заполнения определяется установкой 
интервала между стежками. См. также Создание 
заполнения орнаментным стежком. 

     
Как настроить орнаментный стежок для 
текстового объекта 
1 Дважды щелкните по выбранному текстовому 

объекту. 
 Откроется диалоговое окно Object Properties - 

Lettering (Свойства объекта - Текст). 
 
Выберите  

закладку Fill 
Stitch 

 
Выберите  

Fancy. 
 
 
 

Настройте  
узор  

 
 
2 Выберите закладку Fill Stitch (Заполняющий 

стежок) и выберите Fancy (Орнаментный  
стежок) из списка Stitch Type (Тип стежка). 

3 Выберите узор из списка Pattern и настройте 
узор.  

 См. также Выбор узоров заполнения 
орнаментными стежками. 
 

 
4  Нажмите кнопку Apply. 

 

Создание специальных 
эффектов функцией Elastic 
Lettering 
 
Применяйте функцию Elastic Lettering (Гибкий 
текстовый объект) к текстовым объектам, 
чтобы сделать текст выпуклым или 
дугообразным, растянутым или сжатым. Вы 
можете создавать текст с постепенно 
уменьшающимися или увеличивающими 
буквами инструментом "прямой гибкий текст" 
(straight elastic lettering). Вы можете создавать 
выпуклый и двусторонне вогнутый текст 
инструментом "изогнутый гибкий текст" (curved 
elastic lettering). Гибкий текст можно применять с 
любой базовой линией. 
 

 
 
 
 
Внимание: если на вышивальных машинах 
моделей A200 или A730 появляется 
сообщение об ошибке ‘Out of Memory’ (нет 
свободной памяти), возможны два способа 
обойти проблему: 
• Выберите буквенный объект и перед 

тем, как отправлять образец, откройте 
инструмент Break Apart. 
Он преобразует буквы в вышивальные 
ставки -  то есть, это уже не буквы. См. 
раздел Разбивка объектов на 
компоненты. 
Сохраните образец в формате EXP и 
отправьте в машину как EXP - файл. 

 
Изменение формы текстового 
объекта 
 

Используйте функцию Elastic Lettering (меню 
Edit) для создания букв со специальными 
эффектами. 
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В вашем распоряжении четыре типа гибкого 
текста – прямой (Straight), изогнутый (Curved), с 
эффектом перспективы (Perspective) и с 
ромбовидным очертанием (Diamond). 
 
 
Как изменять форму текстовых объектов 
1 Выберите текстовый объект, форму которого 

вы хотите изменить. 
2 Выберите Edit > Elastic Lettering. 
3 Выберите один из следующих типов гибкого 
текста:  
  

 
 В зависимости от выбранного типа функции 

Elastic Lettering вокруг контура объекта 
появятся различные маркеры. 

 
 
4 Перетащите один или несколько маркеров 

вверх или вниз, чтобы изменить форму 
объекта. 

 
◄ Чтобы переместить два маркера в 

противоположных направлениях, 
удерживайте клавишу Shift во время 
перетаскивания маркера.  

        

 
 

◄ Чтобы переместить два маркера в 
одном и том же направлении, 
удерживайте клавишу Ctrl во время 
перетаскивания маркера.  

      
 

 
5 Нажмите Enter для завершения. 
 
Редактирование текста в Elastic 
Lettering 

 
Используйте инструмент Lettering 
(панель Digitize) для редактирования 
текста в огибающем контуре на  

                 экране. 
 
Вы можете редактировать текст в Elastic Lettering 
на экране тем же способом, что и нормальный 
текст. Если вы щелкните внутри текста, то под 
контуром объекта появится дубликат текста. 
 
Как редактировать текст в Elastic 
Lettering 
1 Щелкните по кнопке Lettering, затем щелкните 

внутри текстового объекта.  
 Под выбранным объектом появится дубликат 

текста в оригинальной форме. Указатель 
мыши превратится в балочный (I-образный) 
курсор, появляющийся после последней 
буквы. 

2 Щелкните внутри текстового объекта и 
отредактируйте текст, как вам требуется.  

 
 
 
 
 
 
 
 
 
 

 
3 Нажмите Enter для завершения.  

 
Текст в Elastic Lettering исправлен. 

 

Маркеры изменения 
формы кривой 

Нажать Ctrl и перетащить

Нажать Shift и перетащить
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Удаление эффекта Elastic Lettering 
 
Используйте функцию Lettering (меню Edit), 
чтобы возвратить объект в оригинальный вид.  
 
Чтобы придать текстовому объекту 
оригинальный вид, удалите эффект Elastic 
Lettering. 
 
 
 
 

Как удалить эффект Elastic Lettering 
 

◄ Выберите текстовый объект. 
◄ Выберите Select Edit > Elastic Lettering > 

None.  
Эффект гибкого текста будет удален и 
буквы возвратятся к оригинальному 
виду. 
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ГЛАВА 28 

 

 
МОНОГРАММЫ 

------------------------------------------- 
 
 

 
Создание монограмм 
 
Монограмма состоит из одной или нескольких букв, 
обычно инициалов имени, и используется как 
идентификационная метка. Функция Monogramming 
(Создание монограмм) предоставляет простой 
способ создания персонализированных монограмм с 
выбором стандартных стилей монограмм, форм 
обрамления и орнаментов вместе с набором 
инструментов, помогающих творчески размещать эти 
элементы наиболее декоративным образом.  
В этой главе рассматриваются способы создания 
текстовых монограмм с инициалами или именем, с 
добавлением к монограммам орнамента, а также порядок компоновки элементов 
орнамента. Кроме того, поясняется, как добавлять и создавать собственные 
обрамления.  

 
Создание проектов монограмм 

 
Используйте кнопку Monogramming 
(панель Digitize) для создания 
монограмм с выбором заранее 
определенных стилей монограмм,  

                     форм обрамления и орнаментов. 
 
 
Функция Monogramming (Создание монограмм) 
предоставляет простой способ создания 
персонализированных монограмм с 
минимальным объемом ручного оцифровывания 
с использованием стандартных стилей 
монограмм, форм обрамления и орнаментов 
вместе с набором инструментов, помогающих 
размещать эти элементы.  Функция 
Monogramming создает простой "объект 
монограммы", содержащий некоторые или все из 
следующих элементов: 

 
◄ Lettering (Текст): единичный текстовый 

объект (инициалы или имя) 
 
◄ Ornaments (Орнаменты): до десяти 

комплектов орнамента (каждый из них может 
содержать многократные копии мотива или 
проекта вышивки). 
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◄ Borders (Обрамление): до десяти 

концентрических контуров. 
 

 
 
В предположении, что используются все 
элементы, монограмма вышивается в 
следующем порядке: обрамление (контуры 1, 2, 
3 и 4), комплект орнамента и текстовый 
объект(ы). 
 
Как создавать проект монограммы 
1  Щелкните по кнопке Monogramming. 
 Откроется диалоговое окно Monogramming с 

открытой закладкой Lettering.  
 

 
Эта закладка позволяет выбирать буквы для 
текстовой части монограммы. Имеются две 
опции: Initials (Инициалы) и Name (Имя). 

       
Диалоговое окно Monogramming является 
"модальным", это означает, что вы не 
можете выбирать объекты или оперировать 
кнопками управления за пределами 
открытого диалогового окна. Однако 
элементы, назначенные в диалоговом окне, 
немедленно появляются в окне проекта, а 
любые изменения настроек, выполненные в 
диалоговом окне становятся сразу же 
видимыми. В диалоговом окне имеются 
кнопки Undo (Отменить ввод), Redo 
(Повторить ввод) и Zoom (Изменить масштаб 
изображения). Команда Undo отменяет 
любое изменение, сделанное после 
открытия диалогового окна.  При открытом 
диалоговом окне могут быть использованы 
стандартные комбинации клавиш Ctrl+Z, 
Ctrl+Y, Z, Shift+Z.  
 

2  Выберите нужный вам тип текстового  
      объекта:

В первую очередь вышивают  
обрамление – контуры 1,2,3 и т.д 

Затем вышивают комплект  
орнамента 

В последнюю очередь 
вышивают текст

Кнопки Zoom,  

Redo и Undo   
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◄ Initials (Инициалы): Можно ввести до трех 

инициалов, включая специальные знаки и 
символы. 

 Подробнее см. в разделе Создание текста 
монограммы с инициалами. 

 

 
 
◄ Name (Имя): Эта опция позволяет вводить 

неограниченное количество строчек текста. 
Подробнее см. в разделе Создание текста 
монограммы с именами. 

 
 
3  Щелкните по корешку закладки Ornaments, 

выберите нужный вам тип орнамента и 
щелкните по кнопке Add. 

 Вы можете добавить вокруг монограммы до 
десяти комплектов орнамента. Подробнее см. 
в разделе Добавление орнаментов к 
монограммам. 

 
 
4  Щелкните по корешку закладки Borders , 

выберите нужный вам тип обрамления и 
щелкните по кнопке Add. 
 

 
 Вы можете добавить к проекту монограммы 

до четырех обрамлений одной и той же 
формы. Подробнее см. в разделе 
Добавление обрамлений к монограммам.  

 
5  Щелкните по OK, чтобы закрыть окно.. 
 
Совет: Вы можете вносить поправки в 
выбранные монограммы в любое время путем 
изменения настроек в диалоговом окне 
Monogramming. Диалоговое окно может быть 
открыто с единичной монограммой, но не с 
другим выбранным объектом. Любые поправки к 
настройками применяются непосредственно к 
выделенной монограмме. 
 
Примечание: Команда Ungroup 
(Разгруппировать) не действует, если выбран 
объект монограммы. Если вы хотите получить 
доступ к компонентам объектов, используйте 
инструмент Break Apart. Подробнее см. в 
разделе Разбивка объектов на компоненты. 
 
Создание текста монограммы 
 
Инструмент Monogramming позволяет 
создавать персонализованные монограммы с не 
более чем тремя инициалами, включая 
специальные знаки и символы, или с 
неограниченным количеством строчек текста. 
 
Создание текста монограммы с 
инициалами 
 

Используйте кнопку Monogramming 
(панель Digitize) для создания 
монограмм с выбором заранее 
определенных стилей монограмм, 
форм обрамления и орнаментов. 

 
В проект монограммы можно ввести до трех 
инициалов, включая специальные знаки и 
символы. Изменение настроек для каждой буквы 
в отдельности или для всех вместе или же 
применение стандартных стилей компоновки. 
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Как создать текст монограммы с инициалами 
1  Щелкните по кнопке Monogramming. 
 Откроется диалоговое окно Monogramming с 

открытой закладкой Lettering. Опция Initials 
(Инициалы) открывается по умолчанию.  

 

 
 
Примечание: Опция All Letters (Все буквы) 
открывается по умолчанию. Это означает, что 
любое изменение свойств буквы воздействует на 
все буквы монограммы. Если вы хотите 
применить разные настройки для каждой  
буквы, выберите вначале кнопку, 
соответствующую букве,  
которую вы хотите изменить. Этот шаг 
повторяется для каждой буквы. 

 
2  Введите первую букву в поле Letter 1. 
 Буква сразу же появится в окне проекта. 
 
Примечание: Если используется одиночная 
буква, она должна быть введена в поле Letter 1. 
 
3  Перейдите к следующим полям и введите, 

если нужно, вторую и третью буквы. 
 Эти буквы  появятся в окне проекта. 
 

 
 
4  Как вариант, щелкните по кнопке Style и 

выберите нужный вам стиль из 
всплывающего  
меню – прокрутите до желаемого пункта и  
отпустите кнопку мыши. 

 Текущая высота первой буквы используется 
как "базовая установка" для стиля. 

 

 
Примечание: Кнопка Style применима только 
для инициалов. (Style 1 применяется по 
умолчанию.) Если выбрана опция Name, эта 
кнопка не действует. См. также Создание 
текста монограммы с именами. 

Введите инициалы 
в каждое поле 
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5  Выберите цвет ниток из цветовой палитры 
(Color). 
 
 
 
 
 
 
 
 
 
6  Используйте выпадающий список Alphabet 

для выбора алфавита. 
 
Примечание: Монограммные буквы с 
установленными по умолчанию настройками 
(Alphabet и Height) отличаются от обычных 
букв. Все настройки могут быть проверены в 
закладке Lettering диалогового окна Object 
Properties.  
 
7 Настройте параметры имеющихся букв как вам 
нужно: 
• Настройте высоту букв (Letter Height) и цвет 

(Color). Новое значение высоты буквы будет 
записано на место того, что было в 
свойствах объекта (закладка Object 
Properties > Lettering). 

 
 
 

• С помощью управляющих элементов Rotate 
By и Rotate Baseline выберите правильный 
поворот букв. Эти функции позволяют 
поворачивать отдельные буквы вдоль всей 
базовой линии. 

 
8  Щелкните по View Properties (Показать 

свойства), чтобы выполнить дальнейшую 
подгонку свойств стежков текстового объекта.  
Подробнее см. в разделе Применение 
различных типов стежков и эффектов в 
текстах. 

 

9  Определите желаемые вами орнаменты 
и/или обрамления: 
◄ Щелкните по закладке Ornaments, чтобы 

выбрать орнамент для монограммы. 
Подробнее см. в разделе Добавление 
орнаментов к монограммам. 

◄ Щелкните по закладке Borders, чтобы 
выбрать обрамление для монограммы. 
Подробнее см. в разделе Добавление 
обрамлений к монограммам. 

 
10  Нажмите OK для завершения. 
 
Примечание: Степень увеличения 
автоматически меняется так, чтобы отобразить 
всю монограмму. 

Выбор алфавита

Настройка высоты буквы

Выбор цвета нитки

Кнопка View Properties
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Создание текста монограммы с 
именами 
 

Используйте кнопку Monogramming 
(панель Digitize) для создания 
монограмм с выбором заранее 
определенных стилей монограмм, 
форм обрамления и орнаментов. 

 
Опция Name позволяет вводить неограниченное 
количество строчек текста.  
 

 
 
 
 
 

Как создать текст монограммы с именем 
 
Щелкните по кнопке Monogramming. 
 Откроется диалоговое окно Monogramming с 

открытой закладкой Lettering. Опция Initials 
(Инициалы) открывается по умолчанию. 

 
2  Щелкните по опции Name. 
 Опция Initials будет деактивирована.  

 
3  Введите свой текст в поле Name. 
 Нажмите Enter, чтобы начать новую строку. 

Если создается больше одной строки, то 
используется стандартная базовая линия. 

4  Щелкните по кнопке Select Character, если 
вы хотите добавить специальные знаки или 
символы. Подробнее см. в разделе 
Добавление специальных символов. 
 

 
5  Выберите цвет ниток из цветовой палитры 
(Color). 
 
 
 
 
 
 
 
 
 
 
 
 
 
Совет: Вы можете внести правку в имя, 
используя клавишу Backspace или Delete, 
клавиши со стрелками влево и вправо или 
клавиши Home и End, чтобы перейти к точке 
ввода. 
 
6  Используйте при необходимости 

выпадающий список Alphabet для выбора 
алфавита и настройки высоты букв (Letter 
Height). 
Примечание: Монограммные буквы с 
установленными по умолчанию настройками 
(Alphabet и Height) отличаются от обычных 
букв. Все настройки могут быть проверены в 
закладке Lettering диалогового окна Object 
Properties. 

 
7 Щелкните по View Properties (Показать 

свойства), чтобы выполнить 
дальнейшую подгонку свойств стежков 
текстового объекта.  Подробнее см. в 
разделе Применение различных 
типов стежков и эффектов в 
текстах. 

 
 
 
 

Щелкните для 
создания текста

Щелкните для добавления 
специального знака

Выберите алфавит

Щелкните для 
подгонки текста

Шрифт Childs Play       Курсив -35% 
со стандартными 
настройками

Базовая линия по дуге     Шрифт Tiffany 
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8  Щелкните по Create Lettering (Создать 
текст). 
 Текстовый объект монограммы добавляется 

в окно проекта, заменяя любой текст, 
который мог бы там находиться. 

 
9  Определите желаемые вами орнаменты 

и/или обрамления: 
◄ Щелкните по закладке Ornaments, чтобы 

выбрать орнамент для монограммы. 
Подробнее см. в разделе Добавление 
орнаментов к монограммам. 

◄ Щелкните по закладке Borders, чтобы 
выбрать обрамление для монограммы. 
Подробнее см. в разделе Добавление 
обрамлений к монограммам. 

 
10  Щелкните по OK для завершения. 
 
Добавление орнаментов к 
монограммам 
Орнаменты могут быть добавлены к монограмме 
или из стандартных узоров, или из любого 
файла проекта. 
 

 
 
 
 
 

Добавление орнаментных узоров 
или проектов 
 
Вы можете добавить до десяти наборов 
орнаментов  
к проекту монограммы и заменять их в любое 
время. Имеются специальные узоры орнамента 
для монограмм, хотя можно использовать любые 
имеющиеся узоры. Имеется также комплект 
проектов орнамента. 
 

Они сохраняются в папке Ornaments. 

 
Совет: Вы можете создавать собственные узоры 
орнамента, используя инструмент Create Pattern 
(Создание узоров). Подробнее см. в разделе 
Создание собственных комплектов узоров. 
 
Как добавлять орнаментные узоры или 
проекты 
 
1  Создайте текстовый объект, который вы 

хотите использовать в монограмме: 
◄ Initials (Инициалы): Можно ввести до трех 

инициалов, включая специальные знаки и 
символы. 

 Подробнее см. в разделе Создание текста 
монограммы с инициалами. 

◄ Name (Имя): Эта опция позволяет вводить 
неограниченное количество строчек текста. 
Подробнее см. в разделе Создание текста 
монограммы с именами. 

 
2  Щелкните по закладке Ornaments.  

 
3  Щелкните по кнопке Add (Добавить). 
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 Откроется диалоговое окно Select Source 

(Выбрать источник). 
 

 
 
Примечание: К списку выбора можно добавить 
до десяти орнаментов. Можно использовать 
любую комбинацию положений узоров. 
 
4  Выберите источник орнамента. 
◄ Если вы выбрали Patterns, Blackwork, 

Lacework или Candlewicking, откроется 
диалоговое окно Select Pattern, 
предлагающее на библиотеку стандартных 
узоров орнаментов. 

 

 
Примечание: Все комплекты узоров применимы 
для выбора  
в качестве орнаментов. Вы даже можете сами 
создавать собственные узоры и сохранять их в 
коллекции орнаментов.  
Подробнее см. в разделе Создание 
собственных комплектов узоров. 

 
◄ Если вы выберете опцию From Design 

откроется, диалоговое окно Open (Открыть) с 
открытой папкой Ornaments. Проекты этой 
папки специально предназначены для 
использования в качестве орнаментов. 

 

 
5  Выберите узор или проект и щелкните по OK. 
 Новый комплект орнамента создан с 

использованием выбранных узоров и 
введенных в список настроек. 

 
6  Выберите из списка комплект орнамента. 

 
 
Примечание: Если вы выбрали узор для набора 
орнамента, в полях Pattern Set и Pattern будут 
показаны идентификационные имя и номер. 
Если вы выбрали в качестве орнамента проект, 
то появится поле Design Name. 
 
7  Используйте контрольные поля Positions для 

добавления до восьми элементов 
выбранного орнамента. 

Добавление 
стандартных узоров 
 
 
 
 
Добавление проекта 
орнамента  
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 Контрольные поля расположены в том 

порядке, в котором будут находиться 
элементы орнамента относительно текста. За 
исключением позиции №5 может быть 
использована любая комбинация. 

 
Примечание: Первая позиция служит в качестве 
"анкера" – центра вращения (выделена 
полужирным). Все настройки в диалоговом окне 
относятся к этому элементу орнамента, и все 
остальные элементы  
изменяются по размеру, поворачиваются и  
переворачиваются по отношению к нему.  
См. также разделы Компоновка элементов 
простого  
орнамента и Компоновка элементов 
сложного орнамента. 
 
8  Используйте поля Width (Ширина) и Height 

(Высота) для изменения размеров элемента 
орнамента. 

 
Совет: Контрольное поле Resize Proportionally 
(Сохранить пропорции) активировано по 
умолчанию. 
 
9  Используйте поле Rotate By: (Повернуть на: ) 
для установки угла поворота для первого 
объекта орнамента. 

Все остальные элементы орнамента изменяются 
по размеру, поворачиваются и 
переворачиваются по отношению к этому 
объекту. См. также раздел Компоновка 
элементов сложного орнамента. 
 

 
 
10  Используйте цветовую палитру Color Blocks 

для изменения цветов орнамента. 
 Цвета блоков палитры показаны в 

последовательности, имеющей место в 
элементах орнамента.  Для изменения 
цветов выберите квадрат панели Color 
Blocks и выберите цвет в поле Color. 

 

 
 
Примечание: Контрольное поле Sequence this 
Set by Color (Последовательность по цвету) 
доступно, если вы включили два или более 
повторов выбранного орнамента. При 
использовании этой опции, орнамент, 
содержащий два или более цветов, 
преобразуется таким образом, что все 
цвета обрабатываются вместе. Если это поле не 
активировано, каждый элемент орнамента 
вышивается полностью отдельно.  

Положение 
анкера 
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Это приводит к значительному увеличению 
количества замен цветных ниток. 

 
11  Щелкните по закладке Borders, если вы 

хотите назначить обрамление или 
обрамления для монограмм. Подробнее см. в 
разделе Добавление обрамлений к 
монограммам. 

 
12  Щелкните по OK для завершения. 
 
Компоновка простого орнамента 
Вы можете вставить орнамент как 
самостоятельный элемент в пределах комплекта 
элементов орнамента. Такой простой орнамент 
может быть использован как самостоятельно так 
и в комбинации с другими узорами. См. также 
раздел Компоновка  
элементов сложного орнамента 

 
Как скомпоновать простой орнамент 
 
1  Создайте текстовый объект, который вы 

хотите использовать в монограмме: 
Подробнее см. в разделах Создание 
текста монограммы с инициалами и 
Создание текста монограммы с 
именами. 

 
2  Добавьте орнамент, который вы хотите 

использовать. 
 
Совет: Обычно для расположения простого 
орнамента вы захотите использовать один из 
проектов орнамента, находящихся в папке 
Ornaments.  
 

Она доступна через опцию From Design. 
Подробнее см. в разделе Добавление 
орнаментов к монограммам. 

 
3  Выберите позицию 5, чтобы вставить 

орнамент как самостоятельный элемент. Все 
остальные контрольные поля автоматически 
деактивируются. Остаются доступными поля 
Width, Height, и Rotate By, появляется 
панель Offset (Смещение). 

 
4  При необходимости измените размеры и 

поверните орнамент. Подробнее см. в 
разделе Добавление орнаментов к 
монограммам. 

 
5  Используйте поля X и Y панели Offset для 

позиционирования орнамента по горизонтали 
или вертикали. Этими настройками 
определяется положение центра орнамента 
по отношению к центру текстового объекта.  
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6  Щелкните по закладке Borders, если вы 

хотите назначить обрамление или 
обрамления для моннограммы. Подробнее 
см. в разделе Добавление обрамлений к 
монограммам. 

 
7  Щелкните по OK для завершения. 
 
Компоновка элементов сложного 
орнамента 
Вы можете добавить к монограмме до восьми 
элементов выбранного орнамента. Можно 
использовать любую комбинацию орнаментов и 
положений орнамента. 
 

 
 

Выберите нужное из комплекта стандартных 
стилей компоновки, включая Mirrors, Duplicates 
и Cycle. Вы можете также использовать опцию 
переворачивания анкера орнамента по 
горизонтали и вертикали. 
 
Как скомпоновать сложный орнамент 
 1  Создайте текстовый объект, который вы 

хотите  
использовать в монограмме: Подробнее см. в  
разделах Создание текста монограммы с 
инициалами  
и Создание текста монограммы с 
именами. 

 
2  Выберите орнаменты, которые вы хотите 

использовать.  
Подробнее см. в разделе Добавление 
орнаментов к монограммам. 

 
3  Используйте контрольные поля Positions для 

добавления  
до восьми элементов выбранного орнамента. 

Контрольные поля расположены в том порядке, 
в котором будут находиться элементы 
орнамента относительно текста. За исключением 
позиции №5 может быть использована любая 
комбинация. 

 
Примечание: Первая позиция служит в качестве 
"анкера" – центра вращения (выделена 
полужирным). Все настройки в диалоговом окне 
относятся к этому элементу орнамента, и все 
остальные элементы изменяются по размеру, 
поворачиваются и переворачиваются по 
отношению к нему. 
 
4  При необходимости измените размеры и 

поверните орнамент. Подробнее см. в 
разделе Добавление орнаментов к 
монограммам. 

 
5  Используйте поле Distance From Lettering 

(Расстояние от текста), чтобы назначить 
расстояние смещения элементов орнамента 
от текстового объекта. 

 
Совет: Программное обеспечение позволяет 
назначать отрицательное смещение. 
 
6  Используйте выпадающий список Layout 

Style для выбора стиля расположение 
элементов орнамента – Mirrors, Duplicates 
или Cycle. 
Позиции располагаются в каждом стиле 
компоновки по отношению к анкерному 
объекту, независимо от любой позиции, 
пропущенной в комплекте. 

 

Положение 
анкера
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◄ Mirrors: Зеркальное отображение элементов 

орнамента   

 
◄ Duplicates: Дублирование элементов 

орнамента 

 
◄ Cycle: Ориентирование элементов орнамента 

по окружности 

 

7  Перевернуть всю конфигурацию по 
горизонтали и/или вертикали 

 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 

Перевернуть по 
горизонтали или 

вертикали

◄ Horizontal (Горизонтальный) 

◄ Vertical (Вертикальный)  
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◄ по горизонтали и вертикали 
 

 
 
8  Щелкните по закладке Borders, если вы 

хотите назначить обрамление или 
обрамления для монограмм. Подробнее см. в 
разделе Добавление обрамлений к 
монограммам. 

 
9  Щелкните по OK для завершения. 
 
 
Добавление обрамлений к 
монограммам 
Вы можете добавить к проекту монограммы до 
четырех обрамлений одной и той же формы. 
 
Создание сложных обрамлений 
Диалоговое окно Select Border (Выбор 
обрамления) предлагает список стандартных 
форм обрамления. Вы можете также создавать 
собственные обрамления и добавлять их во 
встроенную коллекцию. Подробнее см. в 
разделе Создание пользовательских 
обрамлений. 
 

 

 
Как создавать сложные обрамления 
 
1  Создайте текстовый объект, который вы 

хотите использовать в монограмме: 
 
◄ Initials (Инициалы): Можно ввести до трех 

инициалов, включая специальные знаки и 
символы. Подробнее см. в разделе Создание 
текста монограммы с инициалами. 

 
◄ Name (Имя): Эта опция позволяет вводить 

неограниченное количество строчек текста. 
Подробнее см. в разделе Создание текста 
монограммы с именами. 

 
2  Добавьте желаемый орнамент. Подробнее 

см. в разделе Добавление орнаментов к 
монограммам. 

 
3  Щелкните по закладке Borders.  
 

 
 
 
4  Щелкните по кнопке Add (Добавить).  
 Диалоговое окно Select Border (Выбор 

обрамления) предлагает библиотеку 
стандартных форм обрамления. 
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Совет: Вы можете создать собственные формы 
обрамления, используя инструмент Closed 
Object (Замкнутый объект), и сохранять их в 
коллекции обрамлений. Подробнее см. в 
разделе Создание пользовательских 
обрамлений.. 
 
5  Выберите обрамление из диалогового окна и 

щелкните по OK. 
 Новый ввод добавляется к списку 

обрамлений, и выбранное обрамление 
появляется в окне проекта. 

 
6  Используйте поле Offset для настройки 

зазора между текстом и обрамлением.  

 
Совет: Программное обеспечение позволяет 
назначать отрицательное смещение. Благодаря 
этому можно создавать сложные 
перекрывающиеся обрамления. 
 
7  Щелкайте снова по кнопке Add, чтобы 

добавить до четырех обрамлений. 
 

 
С каждым щелчком к списку добавляется новый 
ввод и еще одно обрамление той же формы 
добавляется к проекту. 
 
 
 
 
Совет: Если вы хотите изменить форму 
обрамления, щелкните по кнопке Change и 
выберите другую форму обрамления из 
диалогового окна Select Border. Любое 
изменение воздействует на все обрамления 
проекта. 
 
 
 
 
 
 
 
 
 
 
 
 
 
8  Используйте поле Offset для настройки 

зазора между обрамлениями. 

 

Настройка 
смещения 
обрамления 
 
 
 

Смещение от 
текста 

Щелкните для 
добавления 
обрамления

Щелкните для 
изменения формы 

обрамления
Настройка смещения

Смещение 2-го обрамления  
4 мм 

Смещение 2-го обрамления 
4 мм 

Смещение 3-го обрамления  
2 мм 

Смещение 3-го обрамления 
6 мм 
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9  Используйте цветовую палитру для 
настройки цвета выбранных обрамлений. 
 
 
 
 
 
 
 
 
 
 
 
 
10  Используйте кнопки инструментов Outline и 

Fill для изменения оконтуривающих или 
заполняющих стежков для выбранных 
обрамлений. 

 По умолчанию для заполнения используется 
гладьевый стежок. Если выбрано Fill, по 
умолчанию применяется простегивающий 
стежок. Для обрамления могут быть 
использованы все типы оконтуривающих и 
заполняющих стежков, предлагаемых 
программным обеспечением.  

 
 
 
 
11  Используйте поле Aspect Ratio для 

изменения соотношения высоты к ширине 
для всех обрамлений. 
 

 
При настройке этого показателя вы 
устанавливаете соотношение между высотой и 
шириной обрамления. По умолчанию этот 
показатель равен 1,00, это означает, что ширина 
и высота обрамления такие, как в оригинале.  

 
12  Щелкните по View Properties (Показать 

свойства), чтобы выполнить дальнейшую 
подгонку свойств стежков обрамления.  
Подробнее см. в разделе Оконтуривающие 
и заполняющие стежки. 

 
13  Щелкните по OK для завершения. 
 
Создание пользовательских 
обрамлений 
 
Диалоговое окно Select Border (Выбор 
обрамления) предлагает список стандартных 
форм обрамления. Вы можете также создавать 
собственные обрамления и добавлять их во 
встроенную коллекцию. Они могут быть 
сохранены по умолчанию в комплекте ‘Borders’ 
или в вашей собственной папке. Папка Borders 
должна быть закрыта и, по умолчанию, 
гладьевый стежок всегда используется как 
стандартный тип стежка для обрамления. Это 
можно сделать, если обрамление выбрано в 
диалоговом окне Monogramming. 
 
Совет: Как и обрамления, вы можете создавать 
собственные узоры обрамления для 
использования в монограммах, используя 
инструмент Create Pattern. Подробнее см. в 
разделе Создание собственных комплектов 
узоров. 

Изменение типа 
оконтуривающего или 
заполняющего стежка

Выбор цвета

Четвертый бордюр:                Первый бордюр:  
стежок Pattern Run                    стежок Pattern Fill 
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Как создавать собственное обрамление 
 
1  Выберите замкнутый вышивальный объект, 

который вы хотите сохранить в качестве 
обрамления. 

 
 
 
 
 
 
 
 
 
2  Выберите Settings (Настройки) > Settings > 
Create Border (Создать обрамление). 
 Откроется диалоговое окно Create Border. 
 
 
 
 
 
 
 
 
 
 
3  Выберите комплект обрамления из списка. 
 Как вариант, щелкните по New Set для нового 

комплекта обрамления. Введите имя и 
щелкните по OK. 

 
4  Введите имя для вашего нового обрамления 

и нажмите OK. 
 Вам будет предложено оцифровать 

начальную и конечную  
точки обрамления. 

 
5  Щелкните, чтобы наметить две базисные 

точки обрамления. 

Базисные точки устанавливают стандартную 
ориентацию обрамления. 
 

 
 
6  Щелкните по ОК. 
 Новое обрамление сохраняется в наборе 

обрамлений, появится сообщение, 
требующее подтверждения. 

 

 
Выбор комплекта 

обрамления

Ввод имени нового 
обрамления

Наметьте  
базисные точки 
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ЧАСТЬ VII 
 

ВЫВОД, СЧИТЫВАНИЕ И 

ЗАПИСЬ ПРОЕКТОВ 
------------------------------------------ 

 
 
 
 
 
 
Вывод проектов 
 
В этой главе показывается, как распечатывать рабочие документы, выкройки 
аппликаций, цветные слайды и таблицы ниток. Кроме того, объясняется, как 
вышивать простые проекты и проекты, не помещающиеся в пяльцах. 
Подробнее см. в главе Вывод проектов. 
 

Считывание и запись файлов проектов 
 
В этом разделе описывается, как выбирать опции конвертирования и 
сохранения проектов в различных форматах. Кроме того, показывается, как 
сохранять проекты на картах памяти. А также, как сохранять проекты с 
устройством Magic Box. 

Подробнее см. в главе Считывание и запись файлов проектов 
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ГЛАВА 29 
 

 
ВЫВОД ПРОЕКТОВ 

------------------------------------------- 
 

 
Вы можете выводить проекты вышивок 
различными способами – распечаткой 
в виде рабочих документов, в виде 
выкроек аппликаций, цветных слайдов 
или таблиц ниток. BERNINA Embroidery 
Software позволяет также сохранять 
проекты как изображения с тканью и 
деталями одежды. Вы можете также 
непосредственно направить проект в 
машину. При работе с проектами, 
размер которых больше размеров 
пялец вы можете расчленить проект на 
несколько частей с одним или 
несколькими объектами.  Программное 
обеспечение автоматически рассчитает, какие файлы должны быть направлены в 
машины и покажет как они будут выглядеть. В этой главе показывается, как 
распечатывать рабочие документы, выкройки аппликаций, цветные слайды и 
таблицы ниток. Кроме того, объясняется, как вышивать простые проекты и проекты, 
не помещающиеся в пяльцах. 

 

Распечатка проектов 
 
Вы можете создать бумажную копию ваших 
проектов, используя стандартные или 
пользовательские настройки принтера. Вы 
можете также просмотреть проекты перед 
печатью. Настройте опции принтера для 
отображения информации по вашему желанию. 
Если вы пользуетесь цветным принтером, вы 
можете печатать в режиме Artistic View 
(Художественный Просмотр). А также печатать 
таблицы ниток в виде справки для приобретения 
требуемых ниток. См. также раздел Распечатка 
и публикация проектов программой 
BERNINA Portfolio. 

 
Предварительный просмотр и 
распечатка проектов 

 
Используйте инструмент Print Preview 
(панель General) для просмотра проекта 
перед печатью. 
 
Используйте инструмент Print (панель 
General) для печати проекта. 
 

Используйте функцию Print Preview для 
просмотра информации о вышивании. 
Проверьте последовательность вышивания 
перед вышиванием проекта, так как вам нужно 
знать последовательность цветных фрагментов. 
Вы можете создать бумажную копию ваших 
проектов, используя стандартные или 
пользовательские настройки принтера. 
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Предварительный просмотр и 
распечатка проектов 
 
1 Нажмите кнопку Print Preview 

(Предварительный просмотр).  
Ваш проект откроется в том виде, в котором 
он будет отпечатан. Большие проекты могут 
изображаться на нескольких страницах в 
случае их распечатки в фактическом 
размере.  

 
2 Используйте команды для  
предварительного просмотра при 
необходимости: 
◄ Next Page = Следующая страница) 
◄ Previous Page = Предыдущая страница 
◄ Two Pages = Две страницы - для просмотра 

нескольких страниц. 
◄ Portrait/Landscape = Переключение между 

портретной и альбомной ориентацией 
страницы. 

◄ Zoom In, = Щелкните по значку Zoom In, 
чтобы проверить детали проекта или 
прочитать рабочую информацию. 

 
3 Нажмите кнопку Options, чтобы выбрать 

опцию печати. 
 Подробнее см. в разделе Настройка опций 

печати. 
4 Нажмите кнопку Print Now для печати. 
 
Откроется диалоговое окно Print операционной 
системы MS Windows®, позволяющее выбрать 
принтер и желаемые настройки печати.  См. 
также Настройка опций печати 
вышивальных файлов. 
 
5  Нажмите Close, чтобы вернуться к окну 
Design  

Настройка опций печати для 
вышивания 
Настройки печати позволяют детально выбрать 
вид распечатанного проекта. Вы можете 
распечатать копию вашего проекта с 
информацией относительно размеров проекта, 
последовательности вышивания цветных 
фрагментов, количества стежков вместе с 
изображением проекта. Предусмотрены опции, 
позволяющие включить или исключить из 
распечатки в режиме просмотра Artistic View 
крестики, отмечающие начальную и конечную 
точки, соединительные точки, цвет/ткань фона и 
текущие пяльцы. Информация о проекте 
включает данные об авторе, расчетную длину 
верхней нитки для каждого цвета и общую длину 
нижней нитки. 
 
Примечание: Вы можете распечатать весь 
проект или только отдельные его объекты. В 
последнем случае вам следует выделить 
объекты перед открытием диалогового окна 
Print Options. 
 
Как настраивать опции печати для 
вышивания 
◄ 1 Откройте диалоговое окно Print (Печать).   
 Откроется диалоговое окно Print. 

 
2 Выберите принтер из списка Name. 
3 Укажите количество копий, которые 

необходимо распечатать и остальную 
информацию о печати. 

4 Выберите Options (Опции), если нужно 
изменить размер изображения, тип 
просмотра или включаемые в распечатку 
детали. 
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 Откроется диалоговое окно Print Options 
(Опции печати). 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
5  Выберите, будете ли вы печатать весь проект 

или только выделенные объекты. 

 
Примечание: Опция Selected Objects доступна 
только в том случае, если вы уже выделили 
подлежащие распечатке объекты. 
6  Выберите опцию Embroidery на панели 

Elements, если она еще не активирована. 
 Все вышивальные стежки показываются по 

умолчанию в нормальном режиме просмотра 
(Stitch View). 

7  Выберите Artistic View, чтобы распечатать 
проект в режиме Художественного 
Просмотра. 

8 Включите другие опции, если необходимо: 

Hoop (Пяльцы): В распечатку включаются 
пяльцы.  
 

 
 
◄ Picture: проект будет распечатан вместе с 

рисунком за ним. 
◄ Connectors: Все соединительные стежки 

проекта отображаются, даже если текущая 
опция Selection (Выбор) установлена на 
Selected Objects (Выбранные объекты). 

 
 
Совет: Соединительные стежки могут быть 
использованы как направляющие, когда вы 
сохраняете проект формата ART в нескольких 
файлах для их вывода при позиционирования 
проектов, не помещающихся в одних пяльцах. 
Примечание: В режиме просмотра Artistic View 
опция Connectors (Соединительные стежки) 
не действует, т.е. вы не сможете увидеть их в 
этом режиме. 

Печать всего 
проекта или 
выбранных 
объектов

Выбор 
элементов 

вышивки для 
печати
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◄ Start/End Crosshair (Крестики в 
начале/конце): В распечатку включаются 
начальная и конечная позиции иглы. 

 
◄ Background Color/Fabric (Фон Цвет/Ткань): 

Фон страницы заполняется цветом в 
соответствии с настройкой фона 
(Background). Подробнее см. в разделе 
Изменение фона. 

 
 
9  Выберите опцию размера на панели Size: 
 
◄ Actual Size: проект будет распечатан в том 

же размере, в котором он будет вышит. 
 
◄ Fit to Page: крупный проект будет уменьшен 

до размера печатной страницы, а небольшой 
проект – соответственно увеличен.  

 
◄ % of Actual: Размеры изображения проекта 

изменяются в соответствии с этой 
настройкой. 

 
10  Щелкните по ОК.  
 
 
Распечатка выкроек аппликации 
Распечатайте копию узора аппликация для 
использования в качестве шаблона для 
вырезания мотива аппликации из материала. 
Каждый узор аппликации нумеруется в 
соответствии с последовательностью 
вышивания. 
 
Как распечатать узор аппликации 
1  Выберите File > Print Preview. 
2  Щелкните по значку Options. 
 Откроется диалоговое окно Print Options. 
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3  Выберите опцию Applique Pattern. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
4  Щелкните по ОК.  
Каждый узор аппликации нумеруется в 
соответствии с последовательностью 
вышивания. 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
Примечание: Если выбрана опция Actual Size 
(Фактический размер), то как скомпонованная 
аппликация, так и индивидуальные выкройки 
создаются на отдельных страницах. Если 
выбрана опция Fit to Page или % of Actual, то 
скомпонованная аппликация создается в 
выбранном размере, но индивидуальные 
выкройки печатаются в фактическом размере на 
отдельных страницах. 

 
5  Щелкните по кнопке Print. 
 
 
Распечатка таблицы Color Film 
Опция Color Film позволяет вам включить 
список цветных слоев текущего проекта вместе с 
информацией о цвете и стежках для каждого 
слоя. 
 
Как распечатать таблицу Color Film 
1  Выберите File > Print Preview. 
2  Щелкните по значку Options. 
 Откроется диалоговое окно Print Options 

(Опции печати). 
3  Выберите опцию Color Film. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Выбрать для 
распечатки 
элементов 
аппликации 

Страница 
скомпонованной  
аппликации  

Страница 
элементов  
аппликации  

Выберите для 
распечатки 

таблицы 
Color Film
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4  Щелкните по ОК. 

 
Будет включена следующая информация: 
◄ #: номер в последовательности 

вышивания   
◄ Color (Цвет):  Название цвета в соответствии 

с таблицей ниток. 
◄ Код нитки для заказа. 
◄ Brand: Марка нитки, например Isacord 40. 
◄ Stiches: Общее количество стежков для 

индивидуального цветного слоя. 
◄ Thread Used: Общая длина стежков в 

индивидуальном цветном слое в 
соответствующих принятых в системе 
единицах измерения, например в метрах. 

 
 
Примечание: Отображаемая здесь информация 
является той же информацией, которая 
отображена в диалоговом окне Thread Colors 
(Цвета ниток).  Подробнее см. в разделе 
Назначение цвета ниток. 
 
 
 
 
 
 
 
 
5  Щелкните по кнопке Print. 

Печать крупных проектов 
 
Если ваш проект не помещается в одних 
пяльцах, есть возможность распечатать вид 
пялец в много-пяльцевом режиме с 
сохранением правильной 
последовательности цветов. Функция 
Hooping Sequence позволяет получить 
распечатку типа Color Film, показывающую 
объекты в каждых пяльцах. См. также 
раздел Создание проектов, не 
помещающихся в одних пяльцах. 
 

 
 
Чтобы распечатать образец, 
занимающий несколько пялец: 
1 Выберите пункт меню File > Print Preview. 
2 Нажмите кнопку Options. 
Откроется диалог возможностей печати 
Print Options. 
 

Характеристики 
цветных ниток
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3 Выберите опцию Hooping Sequence 
(последовательность пялец). 
 

 
Выберите опцию Hooping Sequence 
4  Щелкните по ОК. 
 

 

Объекты показаны для каждых пялец и 
следующая информация отображается.  
 

 
 
Примечание: отображается та же самая 
информация, что и в диалоге 
Hooping Sequence. См. раздел 
Сохранение проектов, не 
помещающихся в пяльцах. 
 

 
 
5  Щелкните по кнопке Print. 
 
Распечатка таблиц ниток 
 
Для распечатки таблицы ниток выберите Thread 
Colors (меню Settings).  
 
Опция Thread Chart > Print (Таблица ниток > 
Печать) позволяет распечатать список ниток в 
таблице ниток как справка для приобретения 
ниток. 
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Как распечатать таблицу ниток 
1  Выберите Settings (Настройки) > Thread 

Colors (Цвета ниток). 
 Откроется диалоговое окно Design 

Properties (Свойства проекта > Thread 
Colors (Цвета ниток). 

 

 
2  Выберите таблицу из списка Thread Chart 

(Таблица ниток). 
 
3  Щелкните по кнопке Print (Печать).  
 Откроется страница Print Preview 

(Предварительный просмотр), отображающая 
распечатываемую форму выбранной 
таблицы ниток в текущей рассортированной 
последовательности. Распечатываемая 
таблица ниток включает название таблицы 
ниток, коды, марки и описание ниток. 

 
 
4  Щелкните по кнопке Print Now, чтобы 

приступить к процессу печати. 
 Откроется диалоговое окно Print 

операционной системы MS Windows®, 
позволяющее выбрать принтер и выбрать 
желаемые настройки печати.  

 
5  Используйте черные прямоугольники в 

распечатываемом документе, чтобы отметить 
нитки, которые требуется купить. 

 В таблице имеется также графа Memo для 
примечаний. 

 
7  Щелкните по кнопке Print. 
 
Сохранение проектов как 
изображений 
 
Команда Save Design as Image (Сохранить 
проект как изображение) позволяет сохранить 
проект в виде изображений для использования с 
вашей тканью и деталями одежды. 
Результирующее изображение точно такое же, 
как на экране, включая соединительные стежки, 
сетку, а также оригинальный рисунок. Однако 
пяльцы не появятся в файле изображения, даже 
если они пересекают объекты в пределах 
проекта.  
 
Как сохранить проект в виде изображения 
1  Переключитесь в режим Embroidery Canvas. 
2  Если проект все еще открыт в окне Design, 

выберите File > Save Design as Image. 
 Откроется диалоговое окно Save Design as 

Image (Сохранить проект как изображение). 
По умолчанию проект сохраняется в файле 
формата PNG. См. также Использование 
оригиналов проекта. 

 
3 Если потребуется, отмените опцию  

Make Background Transparent. 
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 Эта опция доступна только, если принят 

формат файла PNG. Если эта опция активна 
(по умолчанию), сетка и оригинал 
исключаются из сохраняемого изображения и 
появляются только объекты проекта. 

 
4  Щелкните по кнопке Save (Сохранить).  
Текущий проект сохранится как графический 
файл.  

 
Примечание: Если окно Design Window 
увеличено во время сохранения, сохраненный 
файл включает в себя полный проект, даже если 
он больше окна Design Window. 
 
Вышивание проектов 

 
Используйте инструмент Write to Machine 
(панель General), чтобы передать проект в 
машину.  

 
 
Используйте функцию Write to Machine 
(Передать в машину) для непосредственной 
передачи проекта в готовую для работы 
вышивальную машину BERNINA.  См. также 
Передача проектов в машину. 

 
Совет: Проверьте последовательность 
вышивания перед вышиванием проекта, так как 
вам нужно знать последовательность цветных 
фрагментов. Используйте функцию Print 
Preview для просмотра информации о 
вышивании. Подробнее см. раздел  
Предварительный просмотр и распечатка 
проектов. 
 

 
Как вышивать проект 
 
1  Откройте проект и выберите Embroidery 
Canvas. Подробнее см. в разделе 
Открытие проектов. 

 
 
 
 
 
 
 
 
 
 
 
 
 

2  Проверьте, подходит ли проект к пяльцам. 
Используйте наименьшие пяльцы из 
возможных. Подробнее см. в разделе 
Изменение пялец. 

 

Вид проекта с сеткой            Художественный  
                                                просмотр с тканью 
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3  Щелкните по значку Write to Machine 
(Передать в машину).  

 Если вы загружаете проект в первый раз 
после включения машины или модуля 
считывания карт, то появится диалоговое 
окно Bernina Device Selection (Выбор 
устройства Bernina). 

 
4  Если появится запрос, выберите 

вышивальную машину и COM-порт.  
 
5  Щелкните по ОК. 
 
Если подсоединение выполнено правильно, 
откроется диалоговое окно Write to Embroidery 
System (Передать в вышивальную систему). На 
экране появится имя и пиктограмма вашего 
проекта.  

 
 
 
6  Нажмите кнопку Stitch out Selected Design 

(Вышивание выбранного проекта). 
 Появится окно Writing file(s) to device 

(Передача файла(ов) в устройство), за 
которым последует сообщение о 
подтверждении.  Проект будет передан в 
вышивальную машину, готовый в 
вышиванию. 

 
Примечание: Если вы отправили проекты 
непосредственно в машину, они могут быть 
потеряны после отключения машины. Помимо 
сохранения на жестком диске, на дискете или 
компакт-диске, вы можете также сохранять 
проекты в различных запоминающих 
устройствах. Сохраненные проекты могут быть 
извлечены для редактирования. См. также 
раздел Считывание и запись файлов 
проектов. 
 
Вывод проектов, не 
помещающихся в пяльцах 
При работе с проектами, размер которых больше 
размеров пялец вы можете расчленить проект 
на несколько частей в режиме Hoop Layout с 
одним или несколькими объектами. Если 
вышивается "проект, не помещающийся в 
пяльцах", каждая часть вышивается отдельно 
после перезаправки ткани в пяльцах. 
Подробнее см. в разделе Закрепление в 

пяльцах крупных проектов. 
 
В режиме Hoop Layout доступны 
следующие команды: 

• Save As – Сохранить как.. 
• Write to Machine – записать на 

машину 
• Card/Machine Write – запись на 

карту/машину 
• Write to Magic Box – запись в Magic 

Box 
При использовании любой из этих команд, 
применяется разбиение на несколько 
пялец. Включается режим Hooping 
Sequence, в котором отображаются части 
проекта, соответствующие разным пяльцам. 
При использовании команды Save As 
(сохранить как), режим Hooping Sequence 
включается только тогда, когда вы 
выбираете опцию экспорта разделенных 
файлов. См. также раздел Печать 
крупных проектов. 
 

Выберите тип 
вышивальной 
машины 

Щелкните, чтобы вышить выбранный проект
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Передача не помещающихся в 
пяльцах проектов в машину 

 
Используйте инструмент Write to Machine 
(панель General),  
чтобы передать проект в машину.  

 
Вы можете передать в машину или на карту 
памяти один или несколько вышивальных 
файлов крупного, не помещающегося в пяльцах 
проекта. Программное обеспечение 
автоматически рассчитает, какие файлы должны 
быть направлены в машину и покажет, как они 
будут выглядеть. См. также  
Закрепление в пяльцах крупных проектов.  
 
Как передать не помещающийся в пяльцах 
проект в машину 
1  Выберите режим Hoop Layout и создайте 

проект, не помещающийся в пяльцах. 
Подробнее см. в разделе Закрепление в 
пяльцах крупных проектов. 

 
2  Убедитесь в правильном подключении 

вышивальной машины или модуль 
считывания карт.  

 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
3  Щелкните по кнопке Write to Machine 

(Передать в машину). 
 Система проверит, имеются ли только одни 

пяльцы в проекте и охватываются ли все 
объекты. 

 
◄ Если некоторые объекты не помещаются 

в пяльцах, появится запрос - хотите ли вы 
продолжать или поступите иным образом. 

 
◄ Если предусмотрено несколько пялец, 

система проверит, помещаются ли все 
объекты. Все перезаправки пялец, 
требуемые для вышивания проекта, 
отображаются в режиме Hooping 
Sequence.  
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В режиме Hooping Sequence все панель 
инструментов скрыты, остается только 
диалоговое окно Hooping Sequence 
(Последовательность перезаправки пялец). Там 
отображается список всех перезаправок, 
требуемых для вышивания проекта. 
 
Примечание: Ткань аппликации скрывается, 
остаются только вышиваемые формы. 
 
4  Выберите любую позицию заправки пялец в 

списке. 
 Выбранная позиция заправки показывается 

пунктирной линией, оконтуренной сплошной 
линией, тогда как остальные позиции 
показываются только пунктирными линиями. 
Объекты внутри выделенной позиции 
перезаправки показываются с фактическим 
цветом стежков. Объекты, которые должны 
быть вышиты вначале или позже 
показываются соответственно серыми или 
светло-серыми контурами. 

 
5  Щелкните по кнопке Send Now (Переслать 

сейчас). 
 Система выдаст файл, содержащий все, что 

должно быть вышито в текущей позиции 
заправки пялец. 

 
 
6  Повторяйте эту операцию столько раз, 
сколько требуется для передачи всех позиций 
заправки пялец. 
 
7  Щелкните мышью по Close для окончания. 
 
Примечание: Метки совмещения являются 
красными для первого файла и зелеными для 
любого дополнительного файла. 

Список 
заправок пялец 

текущего 
проекта

 
 
Цвета позиции
заправки пялец 
соответствуют 

цветам 
отображения 

пялец

Объекты, 
подлежащие 
вышиванию после 
этой перезаправки 
пялец, отображаются 
светло-серыми 
линиями 
 
Объекты, уже 
вышитые перед этой 
перезаправкой пялец, 
отображены темно-
серыми линиями 
 
Объекты, 
вышиваемые в 
текущей позиции 
заправки пялец, 
отображаются в 
фактическом цвете 
стежков 
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Сохранение проектов, не 
помещающихся в пяльцах 
 
Если для вашего проекта требуется больше 
одних пялец, вы можете разделить проект на 
несколько файлов для каждой позиции заправки 
пялец. См. также Закрепление в пяльцах 
крупных проектов.  

 
Как сохранить проект, не помещающийся 
в одних пяльцах  
 
1  Создайте крупный проект, не помещающийся 

в пяльцах.  
Подробнее см. в разделе Закрепление в 
пяльцах крупных проектов. 

 
2  Выберите File (Файл)> Save As (Сохранить 
как…). 
 

 
Появится стандартное диалоговое окно MS 
Windows® Save As (Сохранить как…), 
позволяющее перейти к любой папке, выбрать 
любое имя для экспортируемого файла и 
выбрать формат файла из выпадающего списка. 
 

 
 
3  Измените имя файла, если требуется, 

выберите папку и/или формат файла и 
щелкните по OK. 

 
◄ Если система обнаружит, что не все объекты 

в проекте охватываются позициями пялец, 
появится вопрос: хотите ли вы продолжать. 
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◄ Если имеется больше одной позиции пялец, 

вам будет предложено расчленить проект на 
несколько файлов или экспортировать все в 
виде единственного файла. 

 

 
 
 
4 Если вы решите экспортировать файл для 
каждой позиции заправки пялец, щелкните по 
Yes. Система проверит, охватываются ли все 
вышивальные объекты. Вы будете 
предупреждены, если не все объекты 
помещаются в пяльцах. В другом случае все 
перезаправки пялец, требуемые для вышивания 
проекта, пересчитываются и отображаются в 
диалоговом окне Hooping Sequence 
(Последовательность заправки пялец). Позиции 
перезаправки именуются как файлы с 
выбранным расширением. 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
5  Выберите позицию заправки пялец и 

щелкните по Save. 

 
Все вышивальные объекты, ассоциированные с 
выбранной  позицией заправки пялец, 
сохраняются в файле с указанным  в списке 
именем. Как вариант, щелкните по Save All 
(Сохранить все).  
Все файлы в списке сохраняются со своими 
именами. 
 

 
Вывод проектов с 
разделительными линиями 
 
Инструмент Splitting Guide позволяет 
оцифровать одну или более 
разделительных линий для крупных 
проектов, не помещающихся в одни пяльцы, 
перед тем, как вывести проект в файл, на 
машину или на карту памяти. Хотя 
разделительные линии отображаются 
только в режиме Hoop Layout, в других 
режимах они тоже учитываются. До вывода 
проекта, разделительные линии не 
оказывают какого-либо необратимого 
влияния на объекты. См. также раздел 
Разбиение объектов по разным 
позициям пялец. 
 
Для вывода проектов с 
разделительными линиями 
1 Выберите команды Save As, Write to 
Machine, или Write to Magic Box. 
При выборе команды Save As 
отображается диалог Multiple Hoopings. 
 

 
 
2 Нажмите «да» (Yes), чтобы 
экспортировать проект в несколько 
отдельных файлов по одному для каждых 
пялец, или «нет» (No), чтобы 
экспортировать все в один файл. 
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Программа BERNINA Embroidery Software 
применяет разделительные линии и 
запускает диалог Hooping Sequence,  где 
объекты отображаются раздельно в 
соответствующих пяльцах. 
 

 
 

3 При выборе команды Save As (сохранить 
как)) можно сохранить каждую часть 
проекта в отдельный файл, а можно и 
сохранить все сразу (опция Save All). 
Программа BERNINA Embroidery Software 
выводит каждую часть проекта в отдельный 
файл. 
 
4 Нажмите «закрыть» (Close). 
Программа BERNINA Embroidery Software 
выходит из режимаHooping Sequence и 
отображает проект в окне редактирования 
(Design Window) в исходном виде – с 
разделительными линиями, но объекты при 
этом не разделены. 
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ГЛАВА 30 
 

 
СЧИТЫВАНИЕ И ЗАПИСЬ ФАЙЛОВ 

ПРОЕКТОВ 
------------------------------------------- 

 
По умолчанию BERNINA Embroidery Software сохраняет 
проекты в собственном ["родном"] формате файла, ART. 
Этот формат содержит всю информацию, требуемую как 
для вышивания проекта, так и для последующих 
изменений. Однако BERNINA Embroidery Software может 
также открывать проекты в других форматах. В таких 
случаях BERNINA Embroidery Software преобразует 
данные проекта таким образом, что их можно 
обрабатывать, используя весь диапазон функций 
программного обеспечения. 
Если вы отправили проекты непосредственно в машину, 
они могут быть потеряны после отключения машины. 
Помимо сохранения на жестком диске, на дискете или 
компакт-диске, вы можете также сохранять проекты в 
памяти вышивальной машины, карте памяти или на USB memory stick. Если у вас 
имеется прибор Magic Box, вы можете считать и записать проект также и на другие 
карты памяти. 
 
Примечание: Если вы намереваетесь сразу же приступить к вышиванию, перешлите 
проект непосредственно в машину. Подробнее см. в разделе Вышивание проектов. 
 
В этом разделе описывается, как выбирать опции конвертирования и сохранения 
проектов в различных форматах. Кроме того, показывается, как сохранять проекты на 
картах памяти. А также, как сохранять проекты с устройством Magic Box. 

 
 
Форматы проектов вышивки 
 
Проекты BERNINA Embroidery Software 
открываются и сохраняются в чистом ART-
формате, а также в ряде других "неродных" 
форматов. Проекты других форматов, которые 
могут быть переданы в BERNINA Embroidery 
Software, являются в общем случае проектами, 
основанными на "стежковом" формате.  
 

 
 
 
 
 
Это означает, что они создавались не методом 
"объект за объектом", а скорее методом "стежок за 
стежком". Если вы открываете в системе BERNINA 
Embroidery Software другие форматы, программа 
считывает данные и, в зависимости от ваших 
настроек, попытается определить контуры объекта 
и его свойства, так что вы сможете изменять 
проекты, как проекты "родного" формата. 
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ART-файлы  
Проекты в "родном" ART-формате, называемом ‘ART 
Grade A’, содержат полный комплект информации о 
проекте в едином файле – очертания объекта и его 
свойства, фактические стежки, цвета ниток, пиктограмма 
и комментарии.  
Имеется четыре степени файлов формата ART, в 
зависимости от того, как был создан ART-файл, Grade А 
является наилучшим форматом, Grade В более надежен, 
чем Grade С, но не так хорош, как формат Grade А, а 
Grade D является наименее надежным форматом. 
Таким образом разумеется, что  только проекты в  
формате ART Grade A содержат полный набор 
информации, требуемой для 100%-ного совершенства 
изменения размеров и трансформации. 
 
Источник 
файла 

Описание 

Art Grade A  

 

Файл чистого формата ART, 
созданный программным 
обеспечением BERNINA Embroidery 
Software. Такие файлы содержат 
"чистые" ART объекты, контуры и 
стежки. 

Art Grade B  

 

Проекты, считанные с контурного 
формата, такого как GNC, и 
сохраненные как ART-файлы. 
Такие проекты не считываются 
напрямую в BERNINA Embroidery 
Software, но если проект 
конвертирован в ART в другом 
программном обеспечении, 
BERNINA Embroidery Software 
считывает его как проект формата 
Grade B. 

Art Grade C  Проекты, считанные со стежковых 
файлов -- SEW, PCS, PES, и др., - в 
которых стежки конвертированы в 
объекты. Подробнее см. в разделе 
Открытие стежковых файлов с 
конвертированием объекта. 

Art Grade D  Проекты, считанные со стежковых 
файлов -- SEW, PCS, PES, и др., - в 
которых стежки НЕ конвертированы 
в контуры. Подробнее см. в 
разделе Открытие стежковых 
файлов без конвертирования 
объекта. 

 
Все файлы, сохраняемые в формате ART, автоматически 
архивируются (сжимаются) при сохранении и 
разархивируются при повторном открытии. Благодаря 
этому сокращается требуемый объем памяти и 
обеспечивается возможность сохранять большие файлы 
на дискетах или пересылать их по электронной почте. 

 
Совет: Для информации об источниках файла 
проекта обратитесь к Информации о проекте 
(Design information) в диалоговом окне Open 
(Открыть) или Design Properties (Свойства 
проекта). Подробнее см. в разделе Просмотр 
информации о проекте. См. также раздел 
Открытие проектов. 
 
 
Стежковые файлы 
 
Различные вышивальные машины понимают 
различные языки программирования. Каждый из 
них имеют собственные команды управления для 
разных функций машины. Прежде чем вы сможете 
вышить проект, он должен быть переведен в 
формат, который может быть интерпретирован 
машиной. 
Стежковые, или "расширенные" проекты являются 
форматами низшего уровня для 
непосредственного использования вышивальной 
машиной. Они содержат только координаты 
стежков и функции машины. Они обычно 
создаются "налету" при отправке проектов в 
машину. Их можно также вывести на вышивальный 
диск или на карту памяти. 
Когда такие файлы считываются в BERNINA 
Embroidery Software, них не содержится 
информации об объектах, такой как контуры или 
типы стежков, представляя проект как набор 
блоков стежков. Блоки стежков создаются, когда в 
проекте отмечается изменение цвета или 
обрезание ниток. Стежковые проекты в общем 
случае не подлежат изменениям, так как стежки не 
регенерируются. На экране может появится 
предупреждение, если открытый вами проект не 
может быть изменение по размеру. 
 
Совет: Вы можете назначить вывод на экран этого 
предупреждения, выбрав опцию Help (Справка) > 
Show Design Warning (Показывать 
предупреждение о проекте). 
 

Сравнение контурных и 
стежковых форматов файлов. 
BERNINA Embroidery Software использует "родной" 
формат ART вышивальных файлов, в которых 
комбинируются достоинства как контурных, так и 
рассчитанных стежков. В таблице, внизу, 
сопоставлены данные, сохраняемые в стежковом и 
ART-формате. 
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Включено в файл Стежковые 
файлы ART-файлы

Свойства объекта нет да 
Данные о стежках нет да 
Типы стежков нет да 
Координаты стежков да да 
Цвет ниток некоторые да 
Комментарии нет да 
Настройки 
компенсации 
стягивания 

нет да 

Настройки функции 
Auto spacing  

нет да 

 

Открытие стежковых файлов с 
конвертированием объекта 
Когда вы изменяете размеры проекта в "родном" 
ART-формате, то вы изменяете число стежков, 
необходимых для заполнения формы. BERNINA 
Embroidery Software автоматически пересчитывает 
и перерисовывает все стежки. Эта операция 
называется (автоматической) обработкой стежков 
(stitch processing), после ее выполнения проект 
появляется на экране в том виде, в котором он 
будет вышит. Хотя стежковые проекты в общем 
случае не подходят для изменения, BERNINA 
Embroidery Software может с определенным 
успехом интерпретировать контуры объекта, типы 
стежков и их шаг из данных о стежках. Когда вы 
открываете стежковые файлы с конвертированием 
объекта, проект конвертируется в файл формата 
Grade C ART. 
Можно изменять размеры конвертированных 
проектов с пересчетом стежков. 
 
Открытие стежковых файлов без 
конвертирования 
Вы можете выбрать опцию открытия стежковых 
файлов без конвертирования. Проекты, открытые 
таким образом, могут быть выведены на 
вышивание в других форматах. Или вы сможете 
редактировать стежки и добавлять новые 
элементы. Вам ничто не помешает изменять 
размеры проектов стежкового формата, открытые 
без конвертирования объект. Однако, поскольку 
количество стежков не изменяется, плотность 
стежков увеличивается или уменьшается с 
изменением размеров проекта. Поэтому вы не 
должны изменять размеры проектов больше чем 
на ±5 %, в противном случае некоторые зоны 
вышивки будут иметь слишком плотное или 
слишком редкое покрытие.  

 
 
Примечание: С конвертированием объекта или 
без конвертирования стежковые файлы могут быть 
сохранены в формате ART, если они были 
открыты в BERNINA Embroidery Software.  
 
Пересчет конвертированных 
стежковых файлов 
Когда ART-проект создается путем открытия 
стежкового файла с обработкой стежков, 
оригинальные стежки сохраняются до их 
изменения. Вы можете быть уверенными, что 
проект будет вышит в оригинальном виде. Однако, 
если вы изменяете размеры проекта или что-либо 
делаете, приводящее к пересчету стежков новых 
контуров, то стежки, рассчитанные по 
предполагаемым контурам, могут значительно 
отличаться от оригинальных стежков. 
 
Grade 
(степень) 

Источник Метод 
открытия 

Содержание

A ART нормальное 
открытие 

контуры и 
стежки 

B не родной 
контурный 
файл, 
сохраненный 
как ART 

нормальное 
открытие 

Конвертиро-
ванные 
контуры и 
стежки 
 

C EXP- или DST-
файлы, 
сохраненные 
как ART 

открытие с 
конвертиро-
ванием 
объектов 

Предполага-
емые 
контуры и 
конвертиро-
ванные 
стежки 
 

D  
 

EXP- или DST-
файлы, 
сохраненные 
как ART 

открытие без 
конвертиро-
вания 
объектов 

отсутствие 
контуров и 
индивиду-
альных 
стежков 
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Поддерживаемые форматы вышивальных проектов  
 
BERNINA Embroidery Software поддерживает следующие форматы: 
 
Формат Расширение Степень 

(Grade) Считывание Запись 

V 6.0 BERNINA 
Embroidery Software 
версия 6.0 

ART60 А ● ● 

V 5.0 BERNINA 
Embroidery Software 
версия 5.0 

ART50 А ● ● 

BERNINA  
A730/A200 designs 

ART А ● ● 

BERNINA USB Stick EXP   ● 
V1.x Explorations ART42 A ● ● 
artista V4.0 designs ART A ●   ● ^ 
artista Cross Stitch  ARX D ● ●‡ 
Deco,  Brother, 
Babylock 

PES C ● ● 

Deco, Brother, 
Babylock 

PEC C ● ● 

Elna Xpressive EMD C ● ● 
Husqvarna/Viking HUS C ● ● 
Husqvarna/Viking SHV C ● ●* 
Husqvarna/Viking/ 
PFAFF 

VP3 C ● ● 

Husqvarna/Viking/ 
PFAFF 

VIP C ● ● 

Janome / Elna / 
Kenmore 

SEW C ● ● 

Melco EXP C ● ● 
Pfaff PCS C ● ● 
Pfaff PCD C ● ● 
Pfaff PCM C ● ● 
Pfaff PCQ C ● ● 
Poem, Huskygram, 
Singer EU 

CSD C ● ● 

Singer XXX C ● ● 
Tajima DST C ● ● 
V 6.0 BERNINA 
Embroidery Software 
шаблоны 

AMT60 А ● ● 

Artista Quilter ARQ D ●† ●† 
     
     
^  V1, V2 и V3 ART больше не поддерживается  

‡ Только программа Cross Stitch  

† Только программа Quilter  

* Сохраняется только как SHV, но не ковертируется 
в формат SHV  

 

 
Примечание: Программный продукт BERNINA Embroidery Software способен конвертировать проекты в другие 
"не родные" вышивальные форматы, которые в настоящее время находятся в стадии разработки.   
Последующие выпуски других фирменных программных продуктов могут не создавать совместимые форматы 
тех же типов файлов. 
 
 
Открытие файлов проектов 
BERNINA Embroidery Software может открывать 
поддерживаемые файлы проектов, сохраненные в 
вашем ПК из различных источников – жесткого 
диска, дискеты, USB memory stick или компакт-
диска. После открытия проекты могут быть 
проверены или выправлены перед сохранением на 
жестком диске или передачей в машину для 
вышивания или сохранения. См. также 

Поддерживаемые форматы вышивальных 
файлов. 
 
Открытие стежковых файлов с 
конвертированием объекта 

 
Нажмите кнопку Open (панель General), 
чтобы открыть существующий проект.
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Стековые файлы при открытии конвертируются по 
умолчанию в контуры и объекты. Однако BERNINA 
Embroidery Software интерпретирует с 
определенным успехом контуры объекта, типы 
стежков и интервалы из данных о стежках. Когда 
вы открываете стежковые файлы с 
конвертированием объекта, проект конвертируется 
в файл формата Grade C ART. Конвертированные 
проекты можно изменять по размерам с 
пересчетом стежков. Хотя обработка является 
достаточно эффективной для большинства 
стежковых проектов, но она не может обеспечить 
тот же уровень качества, как оригинальные 
контурные файлы, и не может иметь дело с 
некоторыми орнаментными стежками. 
 
Совет: Чтобы гарантировать правильность 
контуров объекта, типов и плотности стежков и 
выбора цвета, всегда рекомендуется проверять и 
править проекты после конвертирования. 
 
Как открывать стежковые файлы с 
конвертированием объекта 
1 Откройте файл с жесткого диска компьютера 
или считайте его с дискеты или карты памяти. 
 Откроется диалоговое окно Open. 

 
                     Выберите формат 
2 Выберите папку из списка «Look In“. 
3 Выберите стежковый формат из списка Files of 
Type (Тип файла) и открываемый файл. 
      Подробнее см. в разделе Поддерживаемые 
форматы вышивальных файлов.  
4 Щелкните по кнопке Options. 
 

 
 Откроется диалоговое окно Open Options 
(Опции открытия). 
 
 
Выберите  
Convert Stitches  
Into Object Shapes 
 
 
 
 
5 Выберите Convert Stitches Into Object Shapes 

(Конвертирование стежков в формы 
объекта). 

6 Нажмите кнопку ОК и затем нажмите кнопку 
Open (Открыть). 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
  
Выбранный проект будет обработан и конвертирован в 
объекты со свойствами заполняющих или 
оконтуривающих стежков, а также с общими свойствами. 
Если объект не распознан, то он - объект с только 
общими свойствами. 
 
Открытие стежковых файлов без 
конвертирования объекта 

 
Нажмите кнопку Open (панель General), 
чтобы открыть существующий проект. 
 

В некоторых случаях вам может потребоваться 
отказаться от функции обработки стежков. 
Например, вам нужно использовать специальные 
эффекты или редактировать проект вышивки 
вручную (эти функции недоступны, если стежки 
были обработаны автоматически после изменения 
размеров проекта). Вы можете отключить функцию 
обработки стежков для любого проекта при его 
открытии. 

стежки обработаны (ART Grade C) 
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При открытии стежкового файла без 
конвертирования объекта, вы можете вывести 
проект без изменения, редактировать 
индивидуальные стежки и провести 
незначительные изменения размеров и формы без 
потери оригинальной информации о стежках. 
Когда вы открываете стежковые файлы без 
конвертированием объекта, проект конвертируется 
в файл формата Grade D ART. 
 
Как открывать стежковые файлы без 
конвертирования объекта 
1 Откройте файл с жесткого диска компьютера 

или считайте его с дискеты или карты памяти. 
 Откроется диалоговое окно Open. 
2 Выберите папку из списка Look In. 
3 Выберите стежковый формат из списка Files of 

Type (Тип файла) и открываемый файл. 
 Подробнее см. в разделе Поддерживаемые 

форматы вышивальных файлов.   
4 Щелкните по кнопке Options. 
 Откроется диалоговое окно Open Options 
(Опции открытия). 
 
 
 
Выберите Leave 

Stitches As  
Individual 

 
 
5 Выберите Leave Stitches As Individual Stitches  

(Оставить стежки как индивидуальные)  
для отмены автоматической обработки 
стежков. 

6 Нажмите кнопку ОК и затем на  Open 
(Открыть). 

           
  стежки импортированы (ART Grade D) 
    

 
Считывание проектов из 
машины 
Вы можете загружать проекты в вышивальное 
программное обеспечение BERNINA Embroidery 
Software из различных источников как в 
компьютер, так и в вышивальную машину. После 
открытия проекты могут быть проверены или 
выправлены перед сохранением на жестком диске 
или передачей в машину для вышивания или 
сохранения. При считывании проектов из машины 
имеются три возможности: 
 
o Embroidery machine (Вышивальная машина): 

Большинство машин позволяет сохранять 
проекты с возможностью последующего 
извлечения из памяти машины. Такое 
устройство подобно встроенной карте памяти. 
 

o Design card (Карта памяти): Проекты можно 
также сохранять на карте памяти вставленную 
в вышивальную машину. 
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• Устройство USB Memory Stick:  Проекты 

можно также загружать с устройства USB 
memory stick, вставленного в машину.   
См. также Запись проектов в машину. 

 
 
 
 
 
 
 
 
 
 
 
Примечание: Устройство USB memory stick может 
быть вставлено непосредственно в ваш компьютер 
для загрузки в вышивальное программное 
обеспечение BERNINA.  
Подробнее см. в разделе Открытие проектов. 
 
Как считывать проекты из машины 
1  Откройте новый, пустой файл. 

 
2  Если вы намерены считать проекты с карты или  
     USB stick, вставьте запоминающее устройство в  
     машину (или модуль считывания и записи карт  
     памяти).  
 

 
Примечание: Подробнее о подсоединении см. в 
инструкции, прилагаемой к устройству считывания 
и записи вышивальных карт памяти. 
 
3  Выберите File > Card/Machine Read.   
 Если вы загружаете проект в первый раз после 

включения машины или модуля считывания 
карт, то появится диалоговое окно Bernina 
Device Selection (Выбор устройства Bernina). 

 
4  Выберите вышивальную машину или 

устройство считывания карт,  
 
а также COM-порт, если появится запрос. 

5  Щелкните по ОК. 
 Если подсоединение выполнено правильно, 

откроется диалоговое 
 окно Write to Embroidery System (Передать в 
вышивальную систему).  
Отобразится имя и пиктограмма.  
Появится диалоговое окно Read from 
Embroidery System and Design Manager 
(Считывание с вышивальной системы и 
диспетчер проектов). 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Выбор запо-
минающего 
устройства

 
Выбор  проекта

 
 
 
Выбор жесткого 

диска
 

Щелкните для 
загрузки
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6  Выберите требуемое запоминающее 

устройство,  
щелкнув по соответствующей кнопке – 
вышиваль- 
ной машины, карте памяти или USB memory 
stick. 

 Как только вы выберите кнопку, отобразятся 
все  
папки и проекты, сохраняемые в 
соответствующем  
устройстве памяти. 

 
 
 
 
 
 
 
 
 
 
Совет: Щелкните правой кнопкой по значку 
проекта для вызова всплывающего меню, 
используемого для переименования, удаления или 
просмотра свойств проекта. 
 
7  Щелкните по закладке папки (если имеется 

больше одной закладки) и/или по папке, чтобы 
локализовать проект. 

 Совет: Используйте значки в правой части 
панели для создания новых папок или 
навигации по структуре папок. 

 
8  Выберите проект. 
 В панели Selected Design (Выбранный проект)  

отобразится изображение проекта. 
 
 
 
 
 
 
 
 
 

 

 

9 Используйте кнопки панели, если потребуется:  
• отрыть проект для редактирования 

непосредственно в вышивальном 
программном обеспечении BERNINA; 

• переименовать проект; 
• удалить проект; 

 

 
• получить доступ к свойствам проекта  

 
 
 
 
 
 
 
 
 
 
10  Выберите папку на жестком диске, в которой 

требуется сохранить проект.      
 
 
 
 
 
 
 
 
 
 
 
11   Щелкните по кнопке Download (Скачать), 
чтобы считать проект и сохранить его на жестком 
диске.  
 
Примечание: Вы можете записывать проекты  
в соответствующем формате с жесткого диска в  
запоминающее устройство, используя кнопку с 
зеленой стрелкой Upload (Загрузить). 
 
 
 
 
 
 

 
 
 
 
 

 
 

Выбор закладки
 

Щелчок правой 
кнопкой для 

доступа к 
выпадающему 

меню
Создание новой 

папки 

Щелкните для открытия проекта в 
вышивальном ПО BERNINA 
 
 
Щелкните для доступа к свойствам 
проекта 

Выберите 
требуемую 

папку Используйте эти кнопки 
для навигации и 

создания новой папки
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Запись проектов в память 
вышивальной машины    

 
Используйте инструмент Write to Machine 
(панель General), чтобы записать проект 
в память вышивальной машины, на 
карты памяти или на USB-Stick.  
 
Для включения/отключения отображения 
стежка используется кнопка Show 
Stitches (главная панель инструментов). 
 

 
Если вы намерены только вышить проект, когда 
машина подключена к компьютеру, то следует 
сохранить проект на жестком диске компьютера. 
Однако вы можете также использовать команду 
Write to Machine (Передать в машину), чтобы 
сохранить проект для последующего 
использования независимо от ПК. Проекты из 
любого запоминающего устройства – 
вышивальной машины, карты памяти или USB 
memory stick – могут быть затем вышиты в любое 
время. Таким образом, нет необходимости 
подсоединять компьютер к машине при вышивании 
проекта. Подробнее см. в документации к вашей 
вышивальной машине BERNINA. 
 
 
 
Как записывать проекты в память 
вышивальной машины 
1 Откройте свой проект и выберите режим 

просмотра Stitch View. 
 
 

Примечание: Машина (или внешнее устройство 
считывания/записи карт памяти) должна быть 
включена перед тем, как будет вставлена карта 
памяти, в противном случае проекты не откроются 
или не будут загружены в машину. 

 
2  Если вы намерены сохранить проект на карте 

памяти или в USB stick, вставьте 
запоминающее устройство в машину (или 
модуль считывания и записи карт памяти). 

 Подробнее о подсоединении см. в инструкции, 
прилагаемой к  
устройству считывания и записи вышивальных 
карт памяти. 

 
3  Щелкните по значку Write to Machine  
  (Передать в машину). 
 

Если вы загружаете проект в первый раз после 
включения машины, то появится диалоговое 
окно Device Selection (Выбор устройства). 
 

 
 

4 Выберите тип вышивальной машины и при  
необходимости последовательный порт. 
 

5    Нажмите кнопку ОК. 
 

Если связь с последовательным портом 
установлена правильно, то появится 
диалоговое окно Write to Embroidery System 
(Передать в вышивальную систему)  и имя и 
картинка вашего проекта.  
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Запись в память машины     

  Запись на карте Запись на USB-Stick 
Выберите 
папку,  
в которой 
будет  
сохранен 
проект 
Проект, 
который 
будет 
записан в 
память машины       Кнопка Download  для записи 

        выбранного проекта  
  
6  Выберите требуемое запоминающее 

устройство, щелкнув по соответствующей 
кнопке – вышивальной машины, карте памяти 
или USB memory stick. 
Как только вы выберите кнопку, отобразятся 
все папки и проекты, сохраняемые в 
соответствующем устройстве  
памяти. 

 
 
 
 
 
 
 
 
 
 
 
 
7 Щелкните по закладке папки, в которой должен 

быть сохранен проект. 
 
Совет: Используйте кнопки в правой части панели 
для создания новых папок или навигации по 
структуре папок. 
 

 
Щелкните правой кнопкой по значку проекта для 
вызова всплывающего меню, используемого для 
переименования, удаления или просмотра свойств 
проекта. 

 
 

Примечание: Убедитесь в том, что во время 
загрузки проекта в машину стержень игловодителя 
находится в верхнем положении. 
 
8 Щелкните по кнопке Download, чтобы  

загрузить проект.  
Сенсорный дисплей машины во время загрузки 
проекта остается пустым. Проект теперь 
сохранен в памяти машины. Вы можете вышить 
проект в любое время, не подсоединяя 
компьютер к вашей машине. 

 
 
Запись проектов 
непосредственно на USB-Stick 
 

 
Используйте инструмент Write to 
Machine (панель General), чтобы 
записать проект непосредственно на 
USB-Stick.  
 
Для включения/отключения отображения 
стежка используется кнопка Show 
Stitches (главная панель инструментов). 

 
Проекты можно сохранять на специализированных 
устройствах BERNINA USB memory stick или OESD 
USB memory stick, подключенных к ПК. Вы можете 
копировать проекты непосредственно с жесткого 
диска на USB memory stick через MS Windows® 
Explorer, но для этого нужно пользоваться 
программой BERNINA Embroidery Software. При 
сохранении проекта ПО  BERNINA автоматически 
конвертирует его в правильный формат для 
вышивки. 

Выбор закладки 
для папок 

 

Выбор папки 

Щелчок правой кнопкой 
для вызова 

всплывающего меню 
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Примечание: Другие типы устройств USB stick 
также могут быть использованы, но они 
автоматически не распознаются программным 
обеспечением. 
 
Как записать проект непосредственно на 
USB stick 
 
1  Откройте проект и выберите Stitch View. 

Подробнее см. в разделе Открытие 
проектов. 
  
 

 
 
 
 
 
 
 
 
2  Вставьте BERNINA или OESD USB memory stick 

непосредственно в USB-порт компьютера. 
3  Щелкните по значку Write to Machine 

(Передать в машину). 
 
Если вы загружаете проект в первый раз после  
включения машины или модуля считывания карт, 
то  появится диалоговое окно Bernina Device 
Selection (Выбор устройства Bernina). 
 

 
Совет: Если вы уже подключили вышивальную  
систему, щелкните по кнопке Connected Device 
(Подключенное устройство) в диалоговом окне 
Write  to Embroidery System (Передать в 
вышивальную  систему), чтобы получить доступ 
к диалоговому окну  Bernina Device Selection 
(Выбор устройства Bernina).  

 
См. также Передача проектов в машину. 
 

 
4  Выберите опцию BERNINA USB Stick и 
щелкните по OK. 
Если вы вставили устройство USB memory stick, 
полученное не от BERNINA  
или OESD, откроется диалоговое окно Enter Drive 
Letter and Path  
(Ввод буквы привода и пути), предлагающее 
определить место устройства.  
 

 
 
 
5 Найдите, по какому адресу находится 
устройство на вашем компьютере. 
 
Если подсоединение выполнено правильно, откроется 
диалоговое окно Write to Embroidery System (Передать 
в вышивальную систему). На экране появится имя и 
изображение вашего проекта. Будут отображ ены также 
папки и проекты, подлежащие сохранению в устройстве. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
6  Выберите место устройства для сохранения. 

е 
пок 

Выберите 
BERNINA 
USB Stick 

Щелкните, чтобы перейти к 
диалоговому окну Bernina 
Device Selection 

Щелкните, чтобы 
выбрать путь к  
устройству USB 

Выберите папку

Щелкните для загрузки 
выбранного проекта

Проект, 
подлежащий 
сохранению
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Совет: Используйте значки в правой части панели 
для создания новых папок или перехода по 
структуре папок. Щелкните правой кнопкой по 
файлам уже сохраненненного проекта для вызова 
всплывающего меню, используемого для 
переименования, удаления или просмотра свойств 
проекта. 
 
6  Щелкните по кнопке со стрелкой, чтобы 

записать проект на USB memory stick. 
 При сохранении проекта ПО  BERNINA 

автоматически конвертирует его в правильный 
формат для вышивки.  
См. соответствующую документацию по ПО  
BERNINA для более подробной информации о 
вышивании с USB memory stick. 

 
Запись проектов в MAGIC BOX  
 
Прибор Magic Box ("Волшебная шкатулка") 
позволяет конвертировать файлы, сохраненные в 
различных "не родных" форматах. Вы можете 
передать проект с карты памяти в ПО BERNINA, 
отредактировать и передать затем на карту Magic 
Card. Вы сможете сохранить проекты с Magic карт 
в компьютере или передать на карту памяти, 
отличную от Magic Card. 
 
Программное обеспечение Magic Box 
устанавливается автоматически при инсталляции 
программного пакета BERNINA и работает только 
с BERNINA.  
 
На передней стороне прибора Magic Box имеется 
четыре прорези для различных карт памяти. 
(Прибор mini Magic Box имеет только прорези 1 и 
2.) Цвет прорези соответствует цвету карты Magic 
Card, используемой в этой прорези. 
 

 
 

Внимание: Попытка вставить карту с усилием в не 
соответствующую ей прорезь может привести к 
серьезному повреждению.  
 

 
Используйте прибор Magic Box совместно с 
BERNINA Embroidery Software для того, чтобы: 
◄ Считать ART-файл с компакт-диска, жесткого 

диска или дискеты, выполнить требуемые 
изменения и передать файл на карту Magic 
Card. 

◄ Считать стежковый файл одного из 
поддерживаемых форматов карт памяти 
(включая Magic Card), выполнить требуемые 
изменения и передать обратно на карту Magic 
Card. 

◄ Считать стежковый файл с карты Magic Card, 
выполнить требуемые изменения и сохранить 
его в запоминающем устройстве по Вашему 
выбору. 
 
Если проект в формате ПО  BERNINA 
Embroidery Software, вы можете добавить 
надпись, вставить другие проекты, 
сохраняемые на вашем компьютере, компакт-
диске или дискете, используя все функции 
редактирования ПО  BERNINA.  

 
Приводимые здесь указания применимы только к 
работе прибора Magic Box с BERNINA Embroidery 
Software. Обратитесь к руководству пользователя 
прибором Magic Box за указаниями по установке, 
настройке и работе с прибором. 
 
Считывание проектов с карт памяти 
 

Используйте инструмент Read from Magic 
Box (панель General) для считывания 
других форматов прибором Magic Box. 

 
 
Вы можете считать проект с любой 
поддерживаемой карты памяти, отредактировать 
его и затем записать на одну из карт Magic Card – 
красную, синюю, желтую или зеленую. Вы можете 
выбрать несколько проектов для записи на карту 
Magic Card. Однако вы можете передать в ПО 
BERNINA и редактировать за раз только один 
проект. 
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Как считывать проекты с карты 
памяти 
1 Вставьте карту памяти в Magic Box. Выбранная 

вами прорезь зависит от формата карты.  
2 Щелкните по значку Read from Magic Box  
     (Считать с Magic Box). 
      Откроется диалоговое окно Magic Box About 
      (О программе Magic Box).  

 
 
 
 
 
 
 
 
 

 
3 Нажмите на ОК, чтобы запустить программу. 

См. также инструкцию по эксплуатации Magic 
Box.   

 
Примечание: Вы можете передать проекты, 
считанные с Magic Box на дискету или жесткий 
диск компьютера. Вы можете также передать 
проект на карту памяти, отличную от Magic Card. 
 
Запись проектов на карту Magic 
Card 
 

Используйте инструмент Write to Magic 
Box (панель General) для передачи 
проектов на карты Magic Card прибором 
Magic Box. 

 
Из ПО BERNINA вы можете передавать проекты в 
Magic Box, используя карты Magic Card в любом из 
четырех форматов. Используйте карту Magic Card, 
которая поддерживает нужный вам формат. 
Подробнее см. инструкцию по эксплуатации Magic 
Box. 

 
Как записывать проекты на карту 
Magic Card 
1 Загрузите существующий проект с карты 
памяти в компьютер. 

См. разделы Считывание проектов с карт 
памяти и Считывание проектов с 
компьютера. 
Открывается окно  «Magic Box About“. 
 

 
      

2 Нажмите на ОК, чтобы запустить программу. 
Далее см. инструкцию по эксплуатации Magic 
Box.   
 

Сохранение проектов в формате 
PES  
 
Если у вас имеется проект, использующий 
стандарт PES или Brother hoop, вы можете 
сохранить его в формате PES вместе с 
соответствующей информацией о пяльцах. 
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Как сохранить проект в формате PES  
1 Выберите File (Файл)> Save As (Сохранить 
как) и выберите PES из списка Files of Type (Тип 
файла). 

 
 
 
2 Нажмите кнопку Options (Опции). 
  
Откроется диалоговое окно PES Save Options. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
Совет: Если активирована опция Remember hoop 
(Запомнить пяльцы), в следующий раз 
автоматически будут выбраны последние из 
использовавшихся пяльцев. 
4  Из открывшегося списка Hoop выберите 

требуемые пяльцы. 
 Поля Height (Высота) и Width (Ширина) 

обновляются автоматически в зависимости от 
выбранного типа пялец. 

 Как вариант, выберите из списка Hoop опцию 
User Defined (Определяемые пользователем). 
Поля Height и Width становятся активными, и 
вы можете установить требуемые значения. 

Примечание: Может появиться предупреждение, 
что проект не подходит к пяльцам. 
 
 
Примечание: Может появиться предупреждение, 
что проект не подходит к выбранным пяльцам. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
3 Выберите нужную вам версию PES из выпадающего  
списка. 
Список пяльцев обновится в соответствии с выбранной  
версией – в различных версиях PES доступны  
различные пяльцы. 
 

Установите высоту  
и ширину для  
определяемых  
пользователем  
пялец 

выберите PES  
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ЧАСТЬ VIII 
 

УПРАВЛЕНИЕ ПРОЕКТОМ 
------------------------------------------ 

 
 
 
 
 
Программа BERNINA Portfolio обеспечивает эффективный способ просмотра и 
управления проектами вышивки. Этот инструмент управления проектами может 
обеспечить доступ к файлам, сохраняемым на жестом диске компьютера, 
компакт-диске или дискете. Программа Portfolio позволяет даже архивировать и 
просматривать файлы в папках, которые были архивированы с помощью 
популярного архиватора WinZip. Она распознает все форматы файлов 
проектов, используемые в ПО BERNINA.  
 

Основные сведения о программе Portfolio  
 
В этом разделе описывается полный порядок работы с BERNINA Portfolio, 
начиная с запуска и кончая просмотром, сортировкой и конвертированием 
проектов.  

Подробнее см. в главе Основные сведения о программе Portfolio. 
 

Программа Portfolio для опытных пользователей 
 
В этом разделе описывается более "продвинутая" технология работы с 
Portfolio, начиная с сортировки файлов для вышивания и кончая 
конвертированием проектов. Также объясняется, как печатать и публиковать 
каталоги проектов и как архивировать неиспользуемые проекты. 

Подробнее см. в главе Программа Portfolio для опытных пользователей. 
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ГЛАВА 31 
 

 
ОСНОВНЫЕ СВЕДЕНИЯ О 
ПРОГРАММЕ PORTFOLIO 

------------------------------------------- 
 
 

Программа BERNINA Portfolio 
обеспечивает эффективный способ 
просмотра и управления проектами 
вышивки. Этот инструмент управления 
проектами может обеспечить доступ к 
файлам, сохраняемым на жестом 
диске компьютера, компакт-диске или 
дискете. Программа Portfolio позволяет 
даже архивировать и просматривать 
файлы в папках, которые были 
архивированы с помощью популярного 
архиватора WinZip. Она распознает 
все форматы файлов проектов, 
используемые в ПО BERNINA.  
В этом разделе описывается полный 
порядок работы с BERNINA Portfolio, начиная с запуска и кончая просмотром, 
сортировкой и конвертированием проектов.  

 

Открытие программы Portfolio  
 
Программа BERNINA Portfolio не требует 
отдельной установки. Она работает как 
составная часть программного обеспечения 
BERNINA и легко настраивается и запускается. 
 
Программа BERNINA Portfolio отображает 
пиктограммы и ограниченную информацию о 
проекте каждый раз, когда открывается папка с 
проектами. Вы можете отфильтровать 
содержимого панели отображения, чтобы 
показывались лишь файлы определенного типа. 
Вы можете также переименовывать папки и 
папки нижнего уровня и удалять папки без 
выхода из BERNINA Portfolio. 

 
 
Открытие программы Portfolio 
Выберите Portfolio (меню File), чтобы открыть 
BERNINA Portfolio. 
 
Программу BERNINA Portfolio можно открыть 
только в ПО BERNINA Embroidery Software. 
 
Как открыть программу Portfolio 
◄ Выберите Portfolio из меню File, чтобы 

открыть программу BERNINA Portfolio. 
◄ Используйте древо папок BERNINA Portfolio, 

чтобы непосредственно перейти к папке My 
Designs – Embroidery Software 6. 
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Все ваши проекты формата ART отображаются в 
виде пиктограмм. 

 

 
Изменениережима просмотра 

 
 

 
Строка  меню 

Панель  
инструментов 

 
 
 
 

Папки 
 
 
 

Пиктограммы  
проектов 

 
 
 

Разделительная  
линейка 

 
 
 
 
 

Строка состояния 
 
 
Совет: Если окно BERNINA Embroidery Software 
перекрывает окно Portfolio, воспользуйтесь для 
переключения функцией  Alt + Tab системы 
Windows. 
 
Просмотр проектов в панели 
просмотра 

Щелкните по кнопке Change Design View, 
чтобы выбрать отображение только 
пиктограмм, пиктограмм с данными  

о вышивании или только суммарной информации. 
 
В окне BERNINA Portfolio проекты могут быть 
представлены как одни только пиктограммы (по 
умолчанию), как пиктограммы с суммарной 
информацией или только в виде таблицы.  

Совет: Проекты могут быть представлены на 
развернутом экране BERNINA. Подробнее см. в 
разделе Открытие проектов  
в BERNINA Embroidery Software. 
 
Как просматривать проекты в панели 
просмотра 
 
1  Откройте программу BERNINA Portfolio и 

выберите парку.  
Подробнее см. в разделе Обзор проектов в 
папках. 

 Панель просмотра программы BERNINA 
Portfolio обновляется  
для показа содержания выбранной папки. 

 См. также Обновление экрана. 
 
2  Используйте опции просмотра, чтобы увидеть  

проекты в базе данных в требуемом вам 
формате. 
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◄ Для отображения проектов только в виде 
пиктограмм, щелкните по кнопке Change 
Design View и выберите Thumbnails из 
выпадающего меню. Или выберите View > 
Design Thumbnails. 

 
 
 
 
 
 
 
 

 
◄ Для отображения проектов в виде 

пиктограмм с данными о стежках, щелкните 
по кнопке Change Design View и выберите 
Summary из выпадающего меню. Или 
выберите View > Design Thumbnails and 
Summary. 

 
 
 
 
 
 
 
 
 

◄ Для отображения проектов в виде таблицы с 
данными о файлах, щелкните по кнопке 
Change Design View и выберите List из 
выпадающего меню. Или выберите View > 
Design List. По умолчанию в таблице 
показывается имя проекта, размер  
и тип файла, версия программы и др. 

 

Примечание: Количество выбранных проектов 
отображается  
в строке состояния в нижней части окна 
BERNINA Portfolio. 
 
Просмотр проектов в развернутом 
окне 

Щелкайте по кнопке Hide/Show Folders, 
чтобы показывать или скрывать дерево 
папок. 

 
Нередко бывает более удобно просматривать 
проекты в папках базах данных в развернутом 
окне. 
В этом случае вы можете всегда просматривать 
проекты, используя список Look In или опцию 
Browse Location. 
 
 
Как просматривать проекты в развернутом 
окне 
1  Щелкните по значку Hide/Show folders. 
 Проекты теперь будут показаны в 

развернутом окне. 
 

 
 
2  Выберите View > Browse Location, чтобы 

просмотреть проекты в другой папке. 
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 Откроется диалоговое окно Browse for 

Folder. 
 

 
3  Найдите дерево папок для нужной вам папки 

или базы данных и щелкните по OK. 
 Зона отображения соответственно 

обновится. 
 
Совет: Как вариант, выберите из выпадающего 
списка Look in. 
 
Просмотр архивированных проектов 
в папках 
Программа Portfolio позволяет архивировать и 
просматривать файлы в папках, которые были 
архивированы с помощью популярного 
архиватора WinZip. Эта программа связывает 
файлы в единый сжатый файл с расширением 
*.ZIP. Это может быть удобным для пересылки 
или получения файлов по электронной почте. 
См. также Архивирование файлов проектов. 
 
Как просматривать архивированные 
проекты в папках 
1 Откройте программу Portfolio и перейдите к 

папке, содержащейся архивированные 
файлы. 
 

Если папка содержит индивидуальные 
архивированные проекты, они появляются 
непосредственно в окне отображения. Имя 
файла появится в курсивном начертании. 
 

 

◄ Если папка содержит архивированные 
файлы с несколькими проектами, они 
появляются в окне отображения. Имя 
файла появится в курсивном 
начертании. 

 

2 Выберите архивированный файл для 
просмотра его содержания. 

 

Архивированный проект – имя 
в курсивном начертании 

Архивированный файл в 
дереве папок 

Архивированный проект 
– имя в курсивном 

начертании

Папки с архивированными 
файлами 
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Местоположение отсутствующих 
файлов 
Если пользователи неправильно перемещают 
файлы, нормальная пиктограмма обычно 
заменяется пиктограммой "отсутствующего 
проекта", когда в следующий раз открываете 
Portfolio. Каждый цвет обозначает определенную 
причину:  
 
 
Значок Описание 

 

Это означает, что Portfolio не 
может найти файл проекта. 
Замените отсутствующие файлы 
резервными или файлами из 
других источников. Если это 
невозможно, то удалите запись или 
обновите каталог. См. также 
Обновление экрана. 
 

 

Это означает, что программа 
Portfolio нашла соответствующую 
пиктограмму, но не может 
распознать формат. Используйте 
функцию Validate and Refresh, 
чтобы обновить экран. Программа 
Portfolio попытается выполнить 
замену в следующий раз при 
открытии или обновлении. См. 
также Обновление экрана. 
 

 

Программа Portfolio распознает 
заранее определенный набор 
типов файлов согласно списку 
типов файлов. Она ищет проект, 
который имеет требуемое 
расширение файла – ART, BMP и 
т.д., – но не в состоянии считать 
файл, отображенный с зеленым 
знаком вопроса. Определите 
местоположение такого файла и 
удалите его. 

 
Настройка функции просмотра 
проектов 
 
Программа BERNINA Portfolio позволяет 
изменять по своему выбору настройки окна. 
Можно настраивать панели инструментов. Вы 
можете в любое время переключать 
региональные настройки – английский, немецкий 
языки и др. 
При случае вам может потребоваться обновить 
отображение на экране. Вы можете также 
изменять способ выбора и выделения проектов. 
Программа BERNINA Portfolio позволяет даже 
настраивать по своему выбору таблицу 
проектов, чтобы отображать только те поля, 
которые вам нужны, в предпочитаемом вами 
порядке. 
 
Изменение региональных установок 
 
Выберите Select Change Locale (меню View), чтобы 
открыть BERNINA Portfolio. 

 
Во время установки программы Portfolio могут 
быть выбраны опции рабочего языка для 
диалоговых окон и сообщений, например, 
немецкого. Вы можете изменять эти настройки в 
любое время. 
 
Внимание: Если выбранный по умолчанию язык 
не соответствует рабочему языку операционной 
системы, то эта опция может работать 
неправильно. См. также "Региональные 
настройки" ("locale") в Справке системы Windows 
для более подробной информации о 
региональных настройках. 
 
Как изменять региональные настройки 
1 Откройте программу Portfolio 
 Подробнее см. в разделе Открытие 
программы Portfolio.  
2 Выберите View > Change Locale, чтобы  

открыть диалоговое окно. 
 Откроется диалоговое окно Choose Locale 

(Изменить региональные настройки. . 
    
 
 
 
 
 
 

Примечание: В списке будут указаны только 
те настройки, которые были выбраны при 
установке Portfolio. 

 
3 Выберите нужные вам настройки и нажмите  
      OK для подтверждения изменений.  
 

Совет: См. также "Региональные настройки" 
("locale") в Справке системы Windows для 
более подробной информации об изменениях 
раскладки клавиатуры, шрифтов и др. 

 
Обновление экрана 
Время от времени ваш экран может не 
отображать выполненные вами изменения до 
тех пор, пока вы не обновите экран. Изменения в 
папках могут не отображаться до тех пор, пока 
вы не обновите дерево каталогов. Если графика 
и пиктограммы все еще не появляются в 
правильном виде или вы обновили ПО BERNINA 
Embroidery Software, то вам потребуется 
обновить экран. 
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Как обновлять экран 
◄ Для обновления окна экрана выберите 

View (Вид) > Refresh (Обновить) или 
нажмите F5. 

◄ Для обновления папок в дереве каталогов 
выберите View (Вид) > Refresh Folder 
(Обновить папку). Альтернативно 
выберите требуемый для обновления 
узел или папку, щелкните правой кнопкой 
мыши и выберите Refresh из 
раскрывающегося меню. 

◄ Для проверки и обновления папок 
щелкните по парке, содержащей файлы и 
выберите View > Validate and Refresh 
(Подтверждение правильности и 
обновление). 

 
Совет: Время от времени программа Portfolio 
выводит на экран красные, синие или 
зеленые вопросительные знаки и краткое 
описание вместо графической пиктограммы. 
Подробнее см. в разделе Местоположение 
отсутствующих файлов. 

 
Изменения пользовательских 
предпочтений 
 
Выберите команду User Preferences (меню View), 
чтобы установить пользовательские предпочтения 
просмотра проектов. 
 
Вы можете изменять различные стандартные 
установки в окне BERNINA Portfolio, включая 
размер пиктограмм проектов. Вы можете также 
изменять способ выделения выбранных 
проектов. 
 
Как изменять пользовательские 
предпочтения 
 
1  Откройте программу BERNINA Portfolio. 

Подробнее см. в разделе Открытие 
программы Portfolio. 

 
2  Выберите View > User Preferences. 

 

 
 Откроется диалоговое окно User Preferences 

(Предпочтения пользователя).  

 
3  Выберите Highlight in Full (Полное 

выделение), чтобы полностью выделять 
пиктограмму, как только она быдет выбрана.  

 
Если вы хотите, чтобы выделение относилось 
только к обрамлению пиктограммы, уберите 
флажок из окошка Highlight in Full. 
Совет: Цвет и интенсивность выделения могут 
быть изменены в Панели управления (Control 
Panel) системы Windows по желанию 
пользователя. Подробнее см. в "Справке" 
системы Windows, в разделе "Настройки экрана". 
 
4  Выберите опцию Open Design в панели 

Double-click Options для открытия 
выбранного проекта двойным щелчком 
мыши. 

 
5  Выберите опцию Show Properties в панели 

Double-click Options для открытия 
диалогового окна Design Properties при 
двойном щелчке мыши по выбранному 
проекту. 

 
6  Щелкните по OK, чтобы сохранить настройки. 
 
Совет: Если вам требуется больше места в 
панели просмотра для просмотра пиктограмм, 
щелкните по кнопке Hide/Show Folder Tree 
(Скрыть/Показать дерево папок).  
 
Пользовательская настройка 
таблицы проектов 
 
Выберите Customize Columns (меню View) для 
настройки таблицы проектов. 
 
Программа BERNINA Portfolio позволяет даже 
настраивать по своему выбору таблицу 
проектов, чтобы отображать только те поля, 
которые вам нужны, в предпочитаемом вами 
порядке. 
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Как настраивать таблицу проектов 
 
1  Для отображения проектов в виде таблицы с 

данными о файлах, щелкните по кнопке 
Change Design View и выберите List из 
выпадающего меню. Или выберите View > 
Design List. 

 По умолчанию в таблице показывается имя 
проекта, размер и тип файла, версия 
программы и др. 

 
 
2  Щелкните правой кнопкой мыши по файлу и 

выберите Customize Column из 
всплывающего меню. 

 Как вариант, выберите View > Customize 
Columns > Design List. 

 Откроется диалоговое окно Design List 
Columns. 

 
 
 
 
 
 
 
 
 
 
 

 
 

 
3  Исключите поле из перечисления путем 
удаления галочки из соответствующего 
контрольного поля. 
 Как вариант, выделите поле и выберите Hide 

(Скрыть). 
 
4  Настройте последовательность выделенных 

колонок кнопками Move Up и Move Down. 
 

 
 Как вариант, выберите шапку колонки и 

перетащите ее мышью на новое место. 
 

 

Обзор проектов в папках 
 
Проекты в папках могут быть просмотрены с 
помощью кнопок прокрутки и скользящего показа 
в диалоговом окне Properties. Вы можете делать 
это как по всей папке, так и по отношению к 
проектам, выделенным инструментом Search 
или Sort. Вы можете также отфильтровать 
содержимое любой папки с проектами, чтобы 
просматривать только определенные типы 
файлов, например только файлы ART. 
Подробнее см. в разделах Сортировка файлов 
и Ограничение типов отображаемых 
файлов. 
 
Просмотр информации о проекте 

 
Щелкните по кнопке Design Properties, 
чтобы просмотреть информацию о  

           выбранных проектах. 
 
Информацию о проектах в папке можно увидеть 
в диалоговом окне Properties (Свойства). Эти 
данные извлекаются непосредственно из 
файлов проектов, созданных в BERNINA 
Embroidery Software. Вы не можете добавлять, 
удалять и редактировать эти поля. 
 
Совет: Проекты в папках могут быть 
просмотрены с помощью кнопок и ползунка 
прокрутки в диалоговом окне Properties. 
Подробнее см. в разделе Обзор проектов в 
папках. 
 
Как просматривать информацию о 
проекте 
1 Откройте программу Portfolio и выберите 

папку с проектами. 
 Подробнее см. в разделе Просмотр 

проектов в папках. 

Выберите Customize Column 

Щелкните для 
перемещения 
выбранной 
колонки вверх  
или вниз 
 
Щелкните, 
чтобы скрыть 
выделенную 
колонку 

Поставьте/удалите галочку, 
чтобы включить/исключить 
колонку таблицы 

Перетащите шапку колонки на новое место
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2 Щелкните правой кнопкой мыши по проекту и 

выберите Properties (Свойства) из 
всплывающего меню. 

 Откроется диалоговое окно Properties 
(Свойства). 

   
Информация о стежках из файла проекта 
отображается серым цветом и не может быть 
изменена. 
Поля Design, Description и Selected 
располагаются в в верхней части диалогового 
окна. Используйте поле Selected для выделения 
или отмены выделения проектов в главном окне 
при переходе от одного проекта к другому. 
Подробнее см. в разделе Сортировка файлов 
в папках. 
 
 

Совет: Если не весь текст виден в поле, 
выберите поле и используйте клавиши со 
стрелками и клавиши Home, End для 
прокручивания текста. Альтернативно 
измените размеры диалогового окна. 
 

3 Нажмите OK, чтобы закрыть окно.. 
 
Обзор проектов в папках 
Кнопки прокрутки в диалоговом окне Properties 
позволяют перемещаться вперед и назад, а 
также к первому и последнему проекту 
выбранной папки. Подобным же образом можно 
перемещаться вперед и назад по выбранным 
проектам. Во время просмотра в диалоговом 
окне Properties отображаются пиктограммы 
вместе с основной информацией о проекте. 

 
Как просматривать проекты в папке 
1 Откройте программу Portfolio и выберите 

папку с проектами. 
См. также Открытие программы Portfolio 
и установка стандартных настроек. 

2 Выберите или отсортируйте проекты, как вам 
требуется. 
См. также Сортировка файлов. 

3 Откройте диалоговое окно Properties. 
См. также Просмотр информации о 
проекте. 

 
 

 
4 Прокрутите содержимое всей папки или 

выбранных проектов, как вам требуется. 
  
 прокрутка всех папок        прокрутка выбранных 
папок 

 
      начало    конец       начало         конец 
 

◄ Если вы хотите прокрутить все 
содержание папки, используйте красные 
кнопки прокрутки. 
Эти кнопки позволяют перемещаться к 
первому проекту, последнему проекту, к 
предыдущему и следующему проекту в 
папке. 

◄ Если вы хотите прокрутить выделенные 
проекты, используйте синие кнопки 
прокрутки. Эти кнопки также позволяют 
перемещаться к первому проекту, 
последнему проекту, к предыдущему и 
следующему проекту в папке. 

5 Нажмите кнопку ОК. 

 кнопки прокрутки 
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Просмотр проектов с 
использованием кнопок скользящего 
показа 
Все проекты в папке могут быть просмотрены в 
режиме скользящего показа, с плавным 
переходом от одного проекта к другому. 
Скользящий показ запускают их диалогового 
окна Properties, в котором отображается 
пиктограмма проекта вместе с основной 
информацией.  Вы можете управлять скоростью 
и направлением скользящего показа. 
 
Как просматривать проекты с 
использованием кнопок скользящего 
показа 
1 Откройте программу Portfolio и выберите 

папку с проектами. 
 См. также Открытие программы Portfolio 

и просмотр проектов. 
2 Выберите или отсортируйте проекты, как вам 

требуется. 
 См. также Сортировка файлов. 
3 Откройте диалоговое окно Properties. 
 См. также Просмотр информации о  
     проекте. 
                     кнопки скользящего показа 

 
         стоп               быстро/медленно 
   назад           вперед 
 
4 Щелкните по кнопке Forwards (Вперед) или 

Backwards (Назад), чтобы запустить 
скользящий показ. 

 В этом режиме происходит автоматическая 
плавная прокрутка проектов с быстрым 
возвращением к началу после достижения 
конца. 

5 Нажимайте кнопки "+" или "-", чтобы 
увеличить или уменьшить скорость 
прокрутки. 

6 Для остановки нажмите кнопку Stop. 
7 Нажмите кнопку ОК. 
 

Обращение к проектам в папках 
Portfolio позволяет выбирать проекты, 
находящиеся в папках. С выбранными 
проектами можно манипулировать различными 
способами, например, вырезать, копировать и 
вставлять объекты, редактировать тексты и 
конвертировать в другие форматы. Вы можете 
также открывать для просмотра или 
редактирования проекты в BERNINA Embroidery 
Software непосредственно из Portfolio. 

 
Совет: Щелкните правой кнопкой мыши по 
выбранному файлу для открытия всплывающего 
меню с наиболее часто применяемыми 
командами. 
 
Выбор проектов в папках 
Проекты должны быть выбраны перед тем, как с 
ними могут быть проведены любые действия, 
например, просмотр, открытие или копирование. 
Можно выбрать группу проектов, несколько 
идущих подряд проектов или все проекты.   
 
Как выбирать проекты в папке 
1 Откройте программу Portfolio и выберите 

парку с проектами. 
 Подробнее см. в разделе Открытие 

BERNINA Portfolio и просмотр проектов. 
2 Выберите отображение проектов в виде 

пиктограмм или в виде таблицы.  
 Подробнее см. в разделе  Настройка 

функций просмотра. 
 

Совет: Процесс образования свернутых в 
пиктограмму изображений может занять 
много времени на старых компьютерах или 
если в базе данных содержится очень много 
проектов. Удерживайте нажатой клавишу Alt, 
чтобы прервать процесс перерисовывания. 
Пиктограмма может быть изображена с 
желтым восклицательным знаком. 

3 Отсортируйте проекты по нужной вам  
      категории. 

Подробнее см. в разделе Сортировка 
файлов. 

4 Выберите проект или проекты. 
◄ Для выбора нескольких идущих подряд 

проектов удерживайте нажатой клавишу 
Shift. 

◄ Для выбора нескольких проектов 
удерживайте нажатой клавишу Ctrl. 

◄ Для выбора нескольких проектов в 
текущей папке выберите Edit > Select Al 
или щелкните на Ctrl+А. 
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5 Чтобы отменить выделение всех выбранных 

проектов, выберите Edit > Deselect All или 
щелкните по любому невыделенному 
объекту. 
Совет: Чтобы отменить выделение одного из 
проектов в выбранной группе, щелкните по 
нему, удерживая клавишу Ctrl. 

 
 
Открытие проектов в BERNINA 
Embroidery Software 
 

 Щелкните по кнопке Open Design, чтобы 
открыть выбранный проект или проекты в 
BERNINA Embroidery Software. 

 
Любые проекты, выбранные в окне Portfolio, 
могут быть открыты в BERNINA Embroidery 
Software для просмотра или редактирования. 
Подобным же образом любой графический файл 
в другой графической программе для просмотра 
или редактирования. 
 
Внимание: Иногда между программой BERNINA 
Portfolio и BERNINA Embroidery Software 
отсутствует связь. Подробнее см. в разделе 
Восстановление соединения BERNINA 
Portfolio с BERNINA Embroidery Software. 
 
 
Как открывать проекты в BERNINA 
Embroidery Software 
1 Откройте программу Portfolio и выберите 

папку с проектами. 
Подробнее см. в разделе Открытие 
BERNINA Portfolio и просмотр проектов в 
папках. 

2 Выберите проект или проекты. 
 

Совет: Если вы хотите открыть несколько 
проектов одной командой, выберите 
просмотр в виде таблицы. Подробнее см. в 
разделе  Настройка функций просмотра. 

 
3 Выберите File (Файл) > Open with BERNINA 

Embroidery Software (Открыть с BERNINA 
Embroidery Software) . 

 
Примечание: Если вы хотите открыть 
графический файл в другой графической 
программе для просмотра или 
редактирования, выберите File > Open. 

 
 Альтернативно, если проекты отображены 

как пиктограммы, дважды щелкните по 
отдельной пиктограмме проекта. 

 Убедитесь в том, что в диалоговом окне User 
Preferences выбрана опция Double Click 
Opens Designs.  Подробнее см. в разделе 
Изменения пользовательских 
предпочтений. 

 Выбранный проект или проекты будут 
отображены готовые для редактирования в 
окне BERNINA Embroidery Software. 
 

4 Для переключения между окнами BERNINA 
Embroidery Software и Portfolio: 

           
 

◄ Удерживая нажатой клавишу Alt, 
нажимайте клавишу Tab, пока не 
появится значок BERNINA Embroidery 
Software. Отпустите клавишу Alt. 
 

◄ Альтернативно щелкните дважды мышью 
по значку BERNINA Embroidery Software 
на панели задач Windows. 

 
Создание новых проектов с 
шаблонами пользователя 
Вы можете открыть новый шаблон проекта в 
BERNINA Embroidery Software из окна Portfolio. 
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Как создать новый проект с шаблоном 
пользователя 
1 Выберите File > New. 

Откроется BERNINA Embroidery Software и 
появится диалоговое окно New. 

     
Примечание: Если шаблонов пользователя не  
имеется, диалоговое окно New может не 
появиться. 
2 Выберите шаблон из списка. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

3 Щелкните по кнопке ОК. 
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ГЛАВА 32 
 

 
ПРОГРАММА PORTFOLIO ДЛЯ 
ОПЫТНЫХ ПОЛЬЗОВАТЕЛЕЙ 

------------------------------------------- 
 
 
 
 
 

Проекты в папках BERNINA 
Portfolio можно сортировать 
разными способами. Это удобно 
для тех случаев, когда вы хотите 
выбирать проекты для 
вышивания, распечатки, 
архивирования и т.п. Проект, 
выбранный в папке Portfolio, 
может быть непосредственно 
передан в вышивальную машину. 
Вы можете также 
непосредственно из окна Portfolio 
конвертировать ваши ART-
файлы и файлы других 
форматов. 
Каталоги проектов в папке содержат пиктограммы и/или краткое описание. Они 
могут быть направлены в принтер и распечатаны в различных форматах. 
Программа Portfolio позволяет архивировать и просматривать файлы в папках, 
которые были архивированы с помощью популярного архиватора WinZip. Это 
может быть удобным для пересылки или получения файлов по электронной почте. 
В этом разделе описывается более "продвинутая" технология работы с Portfolio, 
начиная с сортировки файлов для вышивания и кончая конвертированием 
проектов. Также объясняется, как печатать и публиковать каталоги проектов и как 
архивировать неиспользуемые проекты. 

 
 
 
Сортировка файлов 
 
Проекты в папках программе Portfolio можно 
сортировать тремя основными способами: 
 
◄ Простая сортировка выполняется командой 

View > Sort by (Name, Type, Size, or Date). 
Проекты располагаются в соответствии с 
выбранным критерием сортировки. Проекты 
могут быть отсортированы независимо от 
того, отображаются ли они в виде 
пиктограмм или таблицы с параметрами. 

 
 
 
 
◄ Простой сортировкой является 

использование названий заголовка таблицы:  
File Name, Size, File Type, Version, Date, 
Stitches или Description. Проекты 
располагаются в соответствии с выбранным 
заголовком таблицы, а повторение команды 
реверсирует порядок сортировки. Проекты 
должны быть отображены в виде таблицы. 
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◄ Сложная одно- или двухуровневая 

сортировка по возрастанию или по убыванию 
по критериям:  Colors (Цвет), Date Designed 
(Дата создания), Design Name (Имя 
проекта), File Type (Тип файлв), Height 
(Высота), Stitches (Стежки), Version 
(Версия), Width (Ширина) или None (Ни 
один). Проекты могут быть отображены в 
виде пиктограмм, пиктограмм с 
информацией или таблицы. 

 
Ограничение типов отображаемых 
файлов 
Программа BERNINA Portfolio позволяет 
фильтровать содержимое любой папки с 
проектами, чтобы просматривать только 
определенные типы файлов, например 
вышивальные файлы. 
Как ограничивать типы отображаемых 
файлов 
1  Откройте программу BERNINA Portfolio и 

выберите папку с проектами. Подробнее см. в 
разделе Открытие программы BERNINA 
Portfolio и просмотр проектов. 

2  Щелкните по кнопке Files с раскрывающимся 
списком на панели инструментов. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
3  Выберите: 
◄ All Files для просмотра файлов любого типа. 
◄ All Artwork Files для всех поддерживаемых 

графических файлов. Подробнее см. в 
разделе Оцифровывание с оригиналом. 

◄ Любую другую опцию для просмотра только 
файлов определенного типа, например 
шаблонов (AMT). Подробнее см. в разделе 
Поддерживаемые форматы 
вышивальных файлов. 

 
 

 
Выполнение простой сортировки с 
использованием меню View  
Вы можете сортировать пиктограммы или 
параметры таблицы по любому из четырех 
критериев из меню View.  
 
Как выполнить простую сортировку с 
использованием меню View  
1 Откройте программу Portfolio и выберите 

папку с проектами. 
 Подробнее см. в разделе Открытие 

программы Portfolio. 
2 Выберите отображение проектов в виде 

пиктограмм или в виде таблицы.  
 Подробнее см. в разделе Отображение 

пиктограмм проектов и обзорной 
информации. 

3 Выберите View (Вид) > Sort by Design Name 
(Сортировать по имени), Sort by File Type 
(Сортировать по типу), Sort by File Size 
(Сортировать по размеру), or Sort by Last 
Changed (Сортировать по дате последнего 
изменения). 

 Проекты будут рассортированы согласно 
выбранной опции. 

 
Выполнение простой сортировки с 
использованием заголовков 
таблицы 
Вы можете сортировать данные таблицы, 
нажимая заголовки таблицы.  
 
Как выполнять простую сортировку с 
использованием заголовков таблицы 
1 Откройте программу Portfolio и выберите 

папку с проектами. 
 Подробнее см. в разделе Открытие 

программы Portfolio. 
2 Выберите отображение проектов в виде 

таблицы. 
 Подробнее см. в разделе Отображение 

пиктограмм проектов и обзорной 
информации. 

 
    Для сортировки щелкните по заголовку колонки 

 
3 Щелкните по заголовку колонки, по которой 

будет проведена сортировка, например 
Name.
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 Проекты будут рассортированы в порядке 

выбранного критерия.  
4 Щелкните по заголовку опять, чтобы 

реверсировать расположение проектов. 
 
Выполнение сложной сортировки 
командой Sort 

 
Используйте команду Sort, чтобы 
провести сложную сортировку в 
диалоговом окне Sort. 

 
Вы можете рассортировать проекты по 
различным критериям, таким как Colors (Цвет), 
Date Designed (Дата создания), Design Name 
(Имя проекта), File Type (Тип файла) и т.д. 
Программа Portfolio позволяет сортировать их на 
одном или двух уровнях, по возрастанию или по 
убыванию.  
 
 
Как выполнить сложную сортировку 
командой Sort 
1 Откройте программу Portfolio и выберите 

папку с проектами. 
 Подробнее см. в разделе Открытие 

программы Portfolio. 
2 Выберите отображение проектов в виде 

таблицы. 
 Подробнее см. в разделе Отображение 

пиктограмм проектов и обзорной 
информации. 

3 Выберите иконку Sort или View > Sort. 
 Откроется диалоговое окно Sort 

(Сортировать). 
 

 
 
 
Выбор 
критерия 
уровня 1 
 
 
 
Выбор 
критерия 
уровня 2 
 
 

4 Выберите первый критерий сортировки: 
◄ Выберите нужную вам основную 

категорию из списка Sort By 
(Сортировать по), например First 
designed (Дата). 

◄ Выберите Ascending (По возрастанию), 
чтобы сортировать буквы от A до Z, а 
числа от меньшего к большему, или 
Descending (По убыванию), чтобы 
сортировать в обратном порядке.  

 
5 Выберите критерий сортировки второго 
уровня: 

◄ Выберите один из критериев из 
открывшегося списка And Then By (И 
потом по), например Stitches (Стежки). 

◄ Выберите Ascending или Descending. 
6 Нажмите кнопку ОК. 
 В приведенном выше примере проекты в 

таблице будут расположены по датам и 
типам стежка. 

 

Распечатка и публикация 
проектов 
 
Каталоги проектов в папке содержат 
пиктограммы и/или краткое описание. Они могут 
быть направлены в принтер, опубликованы на 
вашем сайте в интернете или интранете и 
экспортированы в форматах, совместимыми с 
программами электронных таблиц или баз 
данных. 
 
Совет: Перед распечаткой публикацией или 
экспортированием рассортируйте проекты по 
удобным для вас группам. Подробнее см. в 
разделе Сортировка файлов. 
 
Распечатка проектов 

 
Используйте команду Print Seletced 
Design для распечатки выбранного 

проекта или проектов. 
 
Вы можете напечатать копию проектов для 
выбранной группы в папках и включить 
пиктограммы каждого проекта. 
 
Примечание: В отличие от Print Designs эта 
опция обеспечивает распечатку всех проектов и 
имеющейся информации, но она потребует 
больше бумаги.  См. также Печать каталогов 
проектов. 
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Как распечатать проект 
1 Откройте программу Portfolio и выберите 

папку с проектами. 
 Подробнее см. в разделе Открытие 

программы Portfolio. 
2 Если требуется, отфильтруйте типы файлов 

для отображения. Подробнее см. в разделе  
Ограничение типов отображаемых 
файлов. 

 
3 Выберите и рассортируйте распечатываемые 

проекты, используя опцию Sort. 
 Подробнее см. в разделе Сортировка 

файлов. 
4 Выберите проект и нажмите кнопку Print 

Selected designs-  
 Откроется диалоговое окно Print. 
 

 
 
 
 
 
 
 
 

 
5  Выберите опцию размера:  

◄ Actual Size: проект будет распечатан в 
том же размере, в котором он будет 
вышит. 

◄ Fit to Page: крупный проект будет 
уменьшен до размера печатной страницы, 
а небольшой проект – соответственно 
увеличен.  

6 Выберите Artistic View, чтобы распечатать 
проект в режиме Художественного Просмотра. 
 

 
7 Включите другие опции, если необходимо: 

◄ Hoop (Пяльцы): В распечатку 
включаются пяльцы. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

◄ Picture: проект будет распечатан вместе с 
рисунком за ним. 

 
8  Щелкните по OK, 

 
 Откроется диалоговое окно Print Setup. 

 

 
 
Примечание: Диалоговое окно и доступные 
установки для разных принтеров могут быть 
разными. Подробнее см. руководстве по 
применению вашего принтера.  

 
9  Убедитесь в том, что установки принтера 

выбраны правильно в диалоговом окне Print 
Setup системы Windows и нажмите OK, 
чтобы распечатать. 

 
 
Распечатка каталогов проекта 
Распечатанные каталоги ваших проектов 
содержат пиктограммы программ и 
ограниченную текстовую информацию. Вы 
можете подготовить каталоги всех ваших и 
других проектов по своим потребностям.  
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Как распечатать каталог проектов 
1 Откройте программу Portfolio и выберите 

папку с проектами. 
 Подробнее см. в разделе Открытие 

программы Portfolio. 
2 Если требуется, отфильтруйте типы файлов 
для отображения. Подробнее см. в разделе  
      Ограничение типов отображаемых  
     файлов. 
3 Выберите и рассортируйте проекты, которые 

должны быть включены в каталог, используя 
опцию Sort. 

 Подробнее см. в разделе Сортировка 
файлов. 

4 Выберите File > Print Designs. 
 Откроется диалоговое окно Print Designs 

Options (Опции печати проектов). 
    

 
 
5 Выберите масштаб – Scale (%), - если вы 

хотите увеличить или уменьшить 
пиктограммы. 

 
6 Выберите Summary, если вы хотите, чтобы 

была распечатана краткая информация.  
 
7 Нажмите Preview, если требуется 

предварительный просмотр. 

      
 
8  Нажмите Printer, чтобы выбрать принтер, 

размер бумаги и другие опции в диалоговом 
окне Print системы Windows для 
подключенного к вашему компьютеру 
принтера. 

 

 
 
9  Нажмите OK, чтобы распечатать каталог. 
 

Совет: Если для каталога требуется больше 
одной страницы, в диалоговом окне Print 
системы Windows вы можете выбрать, какая 
страница должна быть отпечатана. 

 
Публикация каталогов проектов для 
просмотра в браузере 
Вы можете конвертировать свои проекты в 
HTML- PNG-форматах, пригодны для просмотра 
в браузерах, таких как Microsoft Internet Explorer. 
Это даст вам возможность публиковать проекты 
в Интернете.  
 
Как публиковать каталоги проектов для 
просмотра в броузере 
1 Откройте программу Portfolio и выберите 

папку с проектами. 
 Подробнее см. в разделе Открытие 

программы Portfolio. 
2 Если требуется, отфильтруйте типы файлов 
для отображения. Подробнее см. в разделе  
      Ограничение типов отображаемых  
     файлов. 
 
3 Выберите и рассортируйте проекты, которые 

должны быть опубликованы, используя 
опцию Sort. 

 Подробнее см. в разделе Сортировка 
файлов. 
 

4 Выберите File > HTML Catalog. 
 



Глава 32: Программа Portfolio для опытных пользователей 

BERNINA® Вышивальное ПО  Версия 6 391

 
 Откроется диалоговое окно HTML Catalog  
Options (Опции каталога). 
 

 
 
 
 
 
 
 
 
 

 
 

    

5 Выберите масштаб – Scale (%), - если вы 
хотите увеличить или уменьшить 
пиктограммы. 
 

6 Выберите количество строк (Rows) и 
количество столбцов (Columns) для 
окончательного вывода, которые появятся в 
таблице. 
 

7 Удалите флажок из окошка Summary, если вы 
не хотите, чтобы появилась краткая 
информация о проектах.  

8  Введите имя файла и его местоположение в 
поле File Name, например 
C:\Designs\Catalogs\Crests.htm, или примите 
установки по умолчанию.  

 
Совет: Создайте отдельную папку для 
каждого каталога – конвертирование каталога 
создаст PNG-файл для пиктограммы или 
каждого проекта, другой PNG-файл для 
художественного просмотра каждого проекта 
и файл HTML для каждой странице. 
 

9  Щелкните по кнопке OK, чтобы начать 
конвертирование проектов. 

 Ваш браузер, например Windows Internet 
Explorer, откроется автоматически на первой 
странице проектов после завершения 
конвертирования. 

    

 
 

Если ваш браузер автоматически не 
открывается: 
◄ Откройте ваш браузер, например Windows 

Internet Explorer, через меню кнопки Start 
(Пуск) системы Windows. 

◄ Щелкните по полю Address, перейдите к 
выбранной папке и дважды щелкните по 
первому HTM-файлу, содержащему 
пиктограммы, например Crests1.htm. 
Может быть по меньшей мере два HTM-
файла с одним и тем же названием, 
например Crests.htm, Crests1.htm и т.д. 
Имя файла без цифры является индексом 
для всех HTM-файлов. 

Ваш браузер отобразит в окне один или 
несколько пиктограмм проектов. 

10  Проверьте содержание страницы. 
 Нажмите Next Page, чтобы увидеть 

следующий экран с пиктограммами. 
 
 Совет: Дважды щелкните по пиктограмме, 

чтобы увидеть изображение в режиме 
Художественного просмотра. 

11 Повторяйте эту процедуру, чтобы подогнать 
размер пиктограммы и расположение 
таблицы, если это потребуется. 
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Экспорт каталогов проектов 
Информация о проекте может быть 
конвертирована в форматы Tab и CSV (Comma 
Separated Value), подходящие для 
использования в большинстве крупноформатных 
электронных таблиц. Подробности можно узнать 
в инструкции по пользованию программой 
электронных таблиц. 
 
Как экспортировать каталог проектов 
1 Откройте программу Portfolio и выберите 

папку с проектами. 
 Подробнее см. в разделе Открытие 

программы Portfolio. 
2 Если требуется, отфильтруйте типы файлов 
для отображения. Подробнее см. в разделе  
     Ограничение типов отображаемых 
файлов. 
 
3 Выберите и рассортируйте проекты, которые 

должны быть опубликованы, используя 
опцию Sort. 

 Подробнее см. в разделе Сортировка 
файлов. 

4 Выберите File > Export Designs List. 
 Откроется диалоговое окно Export to File 

Options. 

   
5 Выберите Comma Separated Value File 

или TAB Delimited Text File в зависимости 
от требуемого вашей программой 
электронных таблиц формата. 

 Откроется диалоговое окно Save As. 

  
6 Выберите папку и имя файла для сохранения 

CSV- или TXT-файла. 
7 Нажмите кнопку Save (Сохранить). 

Проекты будут преобразованы и сохранены в 
выбранном формате. 

Вышивание проектов 
 
Если проект выбран в папке, вы можете 
непосредственно переслать в вышивальную 
машину, подсоединенную к системе BERNINA.  
 
Совет: Если файл выбран, щелкните по нему 
правой кнопкой мыши, чтобы открыть 
всплывающее меню с командами Open, Print, 
Convert, Write to Card/Machine, Rename и Delete. 
 
Вышивание непосредственно из 
Portfolio 

 
Используйте команду Stitch Selected 
Designs, чтобы передать проект 
непосредственно в машину. 

 
Выберите один или несколько проектов в папке, 
используя программу Portfolio. Вы можете затем 
передать их в любую вышивальную машину, 
подсоединенную к системе BERNINA. 
 
Как вышивать непосредственно из 
Portfolio 
1 Откройте программу Portfolio и выберите 

папку с проектами. 
 Подробнее см. в разделе Открытие 

программы Portfolio. 
2 Выберите и отсортируйте подлежащие 

вышиванию проекты, используя команды Sort 
(Сортировать) или Search (Найти). 

 Подробнее см. в разделах Сортировка 
файлов и Выбор проектов в папках. 

3 Щелкните по значку Stitch Selected Designs 
(Вышить выбранные проекты). 
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 Откроется диалоговое окно Stitch Options 

(Опции вышивания). 
 
 
 
 

Выберите тип машины и формат 
 
4 Выберите тип машины и формат из списка. 
5 Нажмите OK. Откроется диалоговое окно 

BERNINA Device Selection.  
 

Конвертирование файлов 
проектов  

 
Используйте команду Convert Selected 
Designs, чтобы конвертировать один тип 
файла проекта в другой. 

 
Вы можете непосредственно из окна Portfolio 
конвертировать ваши ART-файлы и файлы 
других форматов. 
 
Примечание: Вы не можете конвертировать в 
окне Portfolio файлы в формат PES, так как PES-
файлы требуют установки размера пялец. 
 
Как конвертировать файлы проектов  
1 Откройте программу Portfolio и выберите 

папку с проектами. 
 Подробнее см. в разделе Открытие 

программы Portfolio. 
2 Выберите файл(ы) для конвертирования. 
 Подробнее см. в разделе Выбор проектов 

в папках. 
3 Нажмите кнопку Convert Selected Design 

(Конвертировать выбранный файл). 
 Откроется диалоговое окно Convert Options 

(Опции конвертирования). 

 
 
 
 
 
 
 
 
 
 
 
 
 

 
4 Выберите типы файлов, в которые вы хотите 

конвертировать проекты. 
 
5 Перейдите к папке, в которой вы хотите 

сохранить конвертированные проекты, 
используя кнопку Browse и диалоговое окно 
Browse for Folder. 

    

 
6 Щелкните по кнопке OK, чтобы начать 

конвертирование. 
 Конвертированные проекты будут сохранены 

в  назначенной папке. Вам будет предложено 
ввести запись результатов в log-файл. 

 

7 Щелкните по OK. 

Архивирование файлов 
проектов 
 
Программа Portfolio позволяет архивировать и 
просматривать файлы в папках, которые были 
архивированы с помощью популярного 
архиватора WinZip. Эта программа связывает 
файлы в единый сжатый файл с расширением 
*.ZIP. Это может быть удобным для пересылки 
или получения файлов по электронной почте. 
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Сохранение файлов проектов в 
одном сжатом файле 

 
Используйте программу WinZip для 
архивирования выбранных проектов в 

одном сжатом файле. 
 
Программа Portfolio обеспечивает прямой доступ 
к WinZip через панель инструментов. 
 
Как сохранить файлы проектов в одном 
сжатом файле 
1 Откройте программу Portfolio 
 Подробнее см. в разделе Открытие 

программы Portfolio. 
2 Выберите папку и выберите проект или 

проекты,  
которые вы хотите архивировать. 

3 Щелкните по значку WinZip. 
4 Если вы выбрали один файл проекта, 

система создаст ZIP-файл. Введите имя 
файла и выберите место сохранения.  

 
5 Если вы выбрали больше одного файла 
проекта, выберите, нужно ли архивировать 
выбранные файлы индивидуально или в одном 
ZIP-файле . 
 

 
 

 
◄ Создание одного архивированного файла, 

содержащего несколько проектов: 
создается ZIP-файл для всех проектов. 
Введите имя файла и выберите место 
сохранения. 

 
 
 
 

◄ Создание индивидуальных 
архивированных файлов для каждого 
проекта: откроется диалоговое окно Browse 
for Folder. Выберите местоположение и 
нажмите OK.  

ZIP-файлам автоматически назначаются  
имена проектов. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Совет: Вы можете просматривать  
архивированные файлы в выделенной папке.  
Подробнее см. в разделе Просмотр  
архивированных проектов. 
 
 
Извлечение файлов проектов из ZIP-
архива 
Программа Portfolio позволяет извлекать файлы 
проектов из ZIP-архива непосредственно в базу 
данных. Это удобно, например, если вы 
получили архивированные проекты по 
электронной почте. 
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Как извлекать файлы проектов из ZIP-
архива 
1 Откройте программу Portfolio 
 Подробнее см. в разделе Открытие 

программы Portfolio. 
 

2 Выберите папку и выберите проект или 
проекты, которые вы хотите извлечь из 
архива. 

Папка с архивированными      Архивированный 
файлами                                 проект – имя написано 
                                                 курсивом 

 

3 Выберите индивидуальный проект для 
извлечения в окне отображения или ZIP-
файл в дереве каталогов. 
 

4 В ZIP-файле выберите нужный вам проект 
или проекты.  

Архивированный проект          Архивированный 
в дереве        проект –папок  
              имя написано курсивом 
 

◄ Для выбора нескольких проектов 
удерживайте нажатой клавишу Ctrl. 

◄ Для выбора нескольких идущих подряд 
проектов удерживайте нажатой клавишу 
Shift. 

 
Совет: Если вы оставите проекты не 
выделенными, все архивированные файлы 
будут разархивированы. 
 

 
5 Выберите File > Extract Zip Archive. 

Откроется диалоговое окно Browse for Folder, 
в котором требуется определить место 
сохранения извлеченного файла.  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
6 Выберите местоположение и нажмите OK. 
 Проект будет извлечен в выбранное 

местоположение.  
 
 
Систематизация проектов в 
папках 
Вы можете переименовывать, копировать и 
вставлять проекты в папках. Вы можете также 
переименовывать папки, удалять папки их или 
удалять без выхода из BERNINA Portfolio. 
 
Переименование, добавление или 
удаление папок 
Вы можете переименовывать папки и папки 
нижнего уровня и удалять папки без выхода из 
Portfolio. 
 
Как переименовывать, добавлять или 
удалять папки 
1 Откройте программу Portfolio 

Подробнее см. в разделе Открытие 
программы Portfolio. 
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2 Найдите папки, которые вы хотите 

переименовать, удалить или к которым нужно 
добавить папки нижнего уровня. 
Подробнее см. в разделе Просмотр 
проектов в папках. 

3 Добавьте, переименуйте или удалите папки, 
как вам требуется: 

◄ Чтобы добавить папку нижнего уровня к 
другой, выберите папку и щелкните по 
ней правой кнопкой мыши. Выберите Add 
Sub-directory и введите имя, когда 
появится новая папка нижнего уровня. 

◄ Для переименования папки выберите ее 
и щелкните правой кнопкой мыши. 
Выберите Rename из всплывающего 
меню и введите новое имя папки. 

◄ Для удаления папки выберите ее и 
щелкните правой кнопкой мыши. 
Выберите команду Delete из 
всплывающего меню. Появится 
требование подтвердить удаление. 

 
Копирование и вставка проектов 
Если выбранный проект скопирован, то он может 
быть вставлен в другое место, используя 
команду Paste. Скопированный проект может 
быть вставлен любое число раз. 
 
Как копировать и вставлять проекты 
1 Откройте программу Portfolio 

Подробнее см. в разделе Открытие 
программы Portfolio. 

2 Выберите любое число проектов. 
 

Подробнее см. в разделе Выбор проектов 
в папках. 

3 Выберите Edit > Copy. 
4 Перейдите к другой папке, выбрав нужный 
каталог. 

Проект может быть вставлен в ту же папку 
как оригинальный проект. 

5 Выберите Edit > Paste. 
Если выбранный проект, например Bear.ART, 
вставлен в текущую папку, а текущая папка 
содержит оригинальный проект или файл с 
тем же именем, новый проект автоматически 
получает имя Copy of Bear.ART. Вы можете 
потом переименовать новый файл, щелкнув 
правой кнопкой мыши по его имени, выбрав 
команду Rename и введя новое имя. Нажмите 
Enter, чтобы завершить переименование. 

 
Примечание: При переименовании файла 
обратите внимание на то, чтобы последние 
три буквы расширения, например ART, не 
были изменены. 

 

 
Вырезание и вставка проектов 
Если выбранный проект вырезан, то он 
удаляется из текущей папки. Проект может быть 
затем вставлен в другое место с 
использованием команды Paste. 
 
Как вырезать и вставлять проекты 
1 Откройте программу Portfolio 

Подробнее см. в разделе Открытие 
программы Portfolio. 

2 Выберите любое число проектов. 
Подробнее см. в разделе Выбор проектов 
в папках. 

3 Выберите Edit > Cut. 
Откроется диалоговое окно с 
подтверждением.  

4 Нажмите Yes, чтобы вырезать проект. 
5 Перейдите к папке, в которую вы хотите  
     вставить файл или файлы. 
6 Выберите Edit > Paste, чтобы вставить  
     выбранный проект в новую папку. 

Если проект с таким же именем уже 
существует, каждая вставленная копия 
переименовывается. 

 
 
 
Переименование проектов в папках 
 
Дублированные проекты, проекты с 
неправильными или ошибочными именами могут 
быть быстро переименованы без открытия 
файлов. 
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Как переименовать проект в базе данных 
или папке 
1  Откройте программу BERNINA Portfolio. 

Подробнее см. в разделе Открытие 
программы BERNINA Portfolio и просмотр 
проектов. 

2  Убедитесь в том, что выбранный вами проект 
не открыт в BERNINA Embroidery Software.  

 
3  Щелкните правой кнопкой мыши по проекту и 

выберите Rename (Переименовать) из 
всплывающего меню. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
4  Откроется диалоговое окно Rename Design 

(Переименовать проект). 

 
5  Введите имя и щелкните по OK. 
 Оригинальное имя проекта будет 

перезаписано.    
 
 
 
Удаление проектов из программы 
Portfolio 
При удалении проекты окончательно удаляются 
из компьютера. 
 
Как удалять проекты из программы 
Portfolio 
1 Откройте программу Portfolio 

Подробнее см. в разделе Открытие 
программы Portfolio. 

2 Выберите любое число проектов. 
Подробнее см. в разделе Выбор проектов 
в папках. 

3 Выберите Edit > Delete. 
Откроется диалоговое окно с 
подтверждением.  

4 Нажмите Yes, чтобы удалить проект. 
 

Внимание: Файл удаляется из папки 
окончательно. 

 
 

Введите новое имя 
проекта 

Переименовать 
выделенный  
проект  




